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APRSmap Release notes

Versionsgeschichte interaktiv durchsuchen
VisuellWikitext

Aktuelle Version vom 9. August 2020, 18:
10 Uhr (Quelltext anzeigen)
OE2WAO (Diskussion | Beitrage)

Version vom 2. Dezember 2018, 17:26
Uhr (Quelltext anzeigen)
OE2WAO (Diskussion | Beitrage)

. . . K
< Zum vorherigen Versionsunterschied
(Eine dazwischenliegende Version desselben Benutzers wird nicht angezeigt)
Zeile 1.147: Zeile 1.147:
* Auswahlmenue "C" oder "Tools/Select * Auswahlmenue "C" oder "Tools/Select
Data/Show POI" zum Zeichen von Data/Show POI" zum Zeichen von
einstellbaren Symbolen eines oder einstellbaren Symbolen eines oder
mehrere Poi Files. "I" (= kleines "L") mehrere Poi Files. "I" (= kleines "L")
schaltet Labels ein/aus. Dazu Text-Filter im schaltet Labels ein/aus. Dazu Text-Filter im
Namen oder Infofeld zum eingrenzen der Namen oder Infofeld zum eingrenzen der
Auswahl mit "*" und "?" Auswahl mit "*" und "?"
* Marker setzen mit Fangen der Position * Marker setzen mit Fangen der Position
des nahen Poi mit "X" und "Y", ohne des nahen Poi mit "X" und "Y", ohne
Fangen IIXII Ilyll' Fangen IIXII Ilyll.
+
+

+ 24.7.2019 (Ver 0.77)

* Tagaed srtm (wasser/wald/urban)
+ und damit Gelaendeschnitt mit/ohne
wald

* Messadge mit ziel "RAW" zum
erzeuaen einer handaekloepnelten

+
nicht-standard Bake oder "general
queryll

+

+

+ 2.1.2020 (Ver 0.78)
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* wetter grafik, gamma(Sievert) +
+ PM10 PM2.5 PM1 PMO.1 (ug/m3)
feinstaub

* senden gamma + feinstaub aus csv-
zeile mit baken-macro

Aktuelle Version vom 9. August 2020, 18:10 Uhr

libpng und libz statisch dazu gelinkt
font symbol und OSM karten nun im png Format

4 Kursortasten zum Karteverschieben und Backspace fur letzte Position(en) (sofern die bei
allen x11 gleichen hexcode haben)

® (OSM Karten in Unterverzeichnissen nach Zoom Faktor 1..16 vorhandene maps léschen oder
einsortieren
wenn Files fehlen wird sofern vorhanden die mit dem nachste Zoomfaktor gedehnt eingesetzt
./Jgm.sh starten bzw anpassen nach Bedarf zum Kartenholen
linke Maus auf Karte klicken oder auf Track oder Symbol 6ffnet Menu, viele Funktionen mit
Klick erreichbar aber noch nicht alle MenUs, noch chaotisch aber mal zum Testen

® Wettergrafik + statistik auf x11 abrufbar

® ESC taste zum Menisschliessen

® Funktion der Klicks auf symbol/text/map/track getrennt konfigurierbar

® 5 watch calls (ohne wildcard) statt "follow car"

® Wwettersymbol etwas besser anklickbar (symbols.png) (alpha Kanal nach heller verschoben,
sollte mal nach 255 wenn alle Symbole daflr adaptiert)

® rechte Maustaste = BACKSPACE (back in zoom/pan-history) (bei www Version lokal back am
Browser)

® map move steps teil der Fenstergrosse

6.1.2013

® Marker auf "Next click to Map": ohne Einrasten auf Symbole "Next click to Symbol oder Text":
mit Einrasten auf genaue Position wenn vorhanden

® Marker l6schen und keycode "@"

® zoom to markers wieder da "Y"

® kmh Histogramm und Animation entsprechend der eingestellten Sichtbarkeitszeit des Tracks

® blaue popup Mendls sortiert nach der GroBe angereiht von links oben

® ‘"Expandes Tiles" geht auch weg wenn alle tiles 1:1

°

call in die watchlist mit click
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7.1.2013

Taste "@" umgewidmet auf "on click" Reset

Taste ":" 16scht beide Marker

30s langer Retry Mechanismus zum Tiles Laden, sobald "gettiles" geldscht, je Sekunde 1
Ladeversuch aller benétigten oder expandierter Tiles und was fehlt oder "png error" hat wird
erneut im "gettiles" angefordert.

7.1.2013

® Tasten "<" und ">" entsprechend "Debug Track" raw+decoded Text der Waypoints oder
Baken durchsteppen und setzt Marker 1

® Backspace history size 20 statt 10

10. 1. 2013

Tasten < > getauscht und Textinfo bleibt sichtbar

Click to WxSymbol neu und dort dann entweder 1 nicht-Wetter Messwert oder beliebig viele
Wetterwerte zugleich ein/aus schaltbar (Menu bleibt offen)

14. 1. 2013

Letzter Wettermesswert in der Kopfzeile der Wettergrafik
Wettergrafik passt sich der Fensterbreite an (ab 320 Breite)
Raw+Decoded Fenster bleibt trotz "Marker to Klick" Messdaten Fenster offen

16. 1. 2013

® Decodiert positionless WX Daten

® Decodiert negative NN im "/A="-Format

® Zoom to Markers geht auch bei Zoomlevel>14

® Fractional Map Zoom rechnet etwa 2x so schnell und richtiger

® Shift-Taste bei Map Move macht 1/10 Schrittweite

® Shift-Taste bei Zoom (derzeit nur mit Maus) macht 1/10 Zoom Schritte

20. 1. 2013

® Klick auf Track mit Raw+Decoded fir den Geklickten Wegpunkt

® Raw+Decoded mit Wegpunkt Nummer / Gesamtpunkte zur Orientierung wo man ist

® Cut + Paste Puffer wird mit angeklicktem Call gefullt

® Ppaste in Texteingabefelder

® |eider geht beides nicht nach aussen weil die Fenster heute mit "selections" miteinander
telefonieren und das ist etwa so aufwendig wie das gesamte Interface zum X11 bis jetzt

® (derzeit noch nicht ein/fausschaltbares) Textfenster mit Scrollbalken fur lange Texte. Zum
Test mit Rawdaten von tcp connect.
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® nach 4 Tagen Suche noch nicht gefunden wie man Kill des Fensters abfangen kann ohne dass
dabei alles abschmiert. Da auch die ganzen Xlib Aufrufe zum Text reinzeichnen keiner auf
Windoof/sontswas portieren wird, wirds wieder abgeschafft.

26.1. 2013

Textfenster mal wieder weg
rawlog File wird nun auch nach dem Einlesen geschlossen und wie bisher beim Schreiben fur
jede Zeile neu gedffnet

® Marker 1 zu klick misst, wenn genau 1 Objekt mit klick erfasst wird mit Einrasten auf dieses,
wenn "on next click set marker 2" immer ohne Einrasten

3.2.2013

(minimierbare) fixe Toolbar (die minimierte verdeckt noch manchmal Text Messages)
Popup Menls ausgemistet, z.B "Show All" nur wenns nicht schon ist

Von den neuen Kommandos aus der Toolbar gehen erst ein paar wirklich (WV Q S)
Messages, Listen, Config noch nicht

6.2.2013

® Fahrtrichtungspfeil + Windfahne bei Wx Symbol, 20kmh pro Strich beides als Teil vom
Symbol anklickbar und abschaltbar

10. 2. 2013

® Auswahl ob Toolbar oder Popup Fenster, damit beim Start normale Toolbar da ist. Muss noch
optimiert werden was in welchem Menu sein soll und was offen bleibt oder verschwindet.
Histogramme verdecken die Pulldown MenuUs aus der Toolbar

® Hohenangabe bei den Symbolen, noch nicht abschaltbar weil alle Symbol-Attribute ab einem
einstellbaren Wert (mindest meter, km/h) konfigurierbar erscheinen sollten.

13. 2. 2013

® Text Editor mit Scrollen fir Config und (wenn fertig) Messages, Parameter werden erst
einzelne ausgewertet
Screenshot mit Filename
rawlog einlesen mit Filenamen (Datum Eingabe noch nicht ausgewertet)

16. 2. 2013

® Watch Calls per Click suchen freien Platz in der Liste weil jetzt tastaturlos auch wieder
abschaltbar
Watch Calls mit * als Wildcard
Setzen der Start Map Position auf Bildmitte per Lokator, Long/Lat, oder mit "?" im Config und
dann Marker 1 setzen auf der Map

® cigene Position im Config auch mit "?" mit Marker 1 Gbertragbar.
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Config File Speichern/Laden beim Start verwenden und automatisch bei Quit Speichern
fehlt noch Auswerten einiger Config Parameter zb Helligkeiten und "next click to Wx"

15. 2. 2013

® Ausser Igate/Network und LogDatum Configs sollten alle gehen und gekoppelt sein mit den
Schiebereglern. Manche Werte, die beim teilweise eingegeben sein Unfug machen, werden
erst bei "Save" "Reload" oder Start ausgewertet

28.2.2013

+ Bei Click auf Pixel das zu mehr als 1 Objekt gehoert, werden die gefundenen Objekte

bei jedem weiteren Click der Reihe nach an die 1. Stelle cykliert

+ Logfile Import mit Datum + ganze Stunde

+ Netbeacon aus Configparametern damit per Modem empfangenes ein Symbol fuer MH hat

(noch nicht per tcp gesendet)

3.3.2013
+ Objekte Loeschen

+ Filtern von Call, Igate, Objekt/Iltem-Absender (erst mal ohne Wildcards)

7.3.2013

+ transparente Menues oder schwarzer oder grauer Hintergrund

(Config Transparency 2..100, 1, 0)

+ Config Baken Symbol mit Auswahimenu ("My Symbol" clicken)

+ Objekt loeschen mit DEL-Taste

17.4.2013

+ Nach wochenlangem Kampf mit den Windoof Compilern ist nun etwa Gleichstand bei der

Win32 Version und es kann wieder am gemeinsamen Teil weiter gebaut werden.
Die innere Struktur ist etwas umgekrempelt zwecks minimiertem
systemabhaengigen

Teil. Leider hat sich die "Tile" Filestruktur (mit schnell mal 3500 Files in
einem

Verzeichnis) am Win als Bremse erwiesen und daher ist noch eine
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Unterverzeichnis-

Ebene dazu gekommen und die Struktur nun gleich wie auf den Servern und
"Marble".

Zum Konvertieren der vorhandenen Maps ist das "rentile" script dabei das man

noch anpassen muss und mit der Kommandozeile, die drin angegeben ist,
Aufrufen.

Es wird nix geloescht nur kopiert. "gm.sh" ist auch darauf angepasst.

+ Neu sind nur ein paar Filter im Config und fuer Besitzer eines Mausrades damit Zoomen

und Pull der Map mit der mittleren Maustaste. Fuer Touchpad-geschaedigte
muss man sich

noch eine Alternative mit Shift/Alt oder Klick auf die leere Map ausdenken.
Screenshot geht nun auch als "bmp" wenns File .bmp heisst.

17.4.2013
+ Pull Map auch mit linker Maustaste auf leere Map (configurierbar ?)
+ Shift + Click to Map: Set Marker 1 (configurierbare andere kommandos ?)

+ On next Click to Wxsymbol: Raw+Decoded zu den Wettergrafiken dazu einschaltbar

20. 4. 2013

+ tcp Connect zum Server mit neuer Syntax, -g <ip>:<port>[#<filter>] -g 44.143.100.1:
14580#m/300

MYCALL und PASSWORT jetzt schon aus dem Config statt -s -p

+ Netzbake: "File" > "Config" -> Mycall, MyPos, Net Beacontext, My Symbol,

Netbeacontime mit Enable, PassCode mit Enable
My Symbol Anklicken fuer Auswahl
My Position "?" an 1. Stelle und dann Marker 1 Setzen

29. 4. 2013

+ tcp Connect nun probisorisch im File>Config, wenn man editiert gruen ausschalten und wenn

fertig wieder ein.

+ auf Wunsch Massstab auf der Karte (noch nicht schaltbar) und auch problematisch wegen

nicht entfernungstreuer Merkator Karten bei kleinem Zoom

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice Seite 7 von 197



B I ue S p|Ce 4 APRSmap Release notes

4.5.2013

+ Vorschlag von dI8rdl eingebaut, Maps Download im Hintergrund komplett fuer das sichtbare

Fenster von Zoom 1 bis einstellbarem maximalen Zoom mit Vorkalkulation der
Datenmenge,
abbrechen, weitertun, und Fortschrittsanzeige.

+ Messages empfangen (derzeit erst von tcp)

6.5.2013

+ "DAO"-Erweiterung in Frame-Decoder eingebaut zum Position auf etwa 20cm genau
uebertragen

und auch genauere Auswertung vom GPS-raw-Format und Anpassung der Rundung
auf Feldmitte
(leider ist die fliesskomma Genauigkeit nur etwa 1-2m)

8.5.2013
+ Mehr Status Meldungen von "on/off" Schaltern und (Shortcut) Funktionen

+ <Make Video> legt "map.y4m" auch auf Linux neu an wenn nicht (zB. als named-pipe)
vorhanden,

meldet Schreibvorgang, refresht alle 1s den Bildschirm und ist abbrechbar.

+ Buttons mit noch nicht implementierter Funktion melden das.

+ Im Screenshot Filenamen wird "%t" durch Datum-Uhrzeit und %n durch "000" bis "999"

ersetzt bis der Filename neu ist.

+ Shortcut Tasten Liste im <Help>

10. 5. 2013

+ 4 direkt waehlbare Map Positionen + Zooms im Zoom-Menue oder per "1..4" Tasten.

Dabei kann entweder der Zoomlevel oder die Position oder beides abgerufen
werden.

Der Eintrag dieser "Views" kann manuell im File>Config>View durch
"Zoomfaktor Position"

(wobei Position auch ein QTH-Lokator sein kann), oder eines von beiden, oder
viel

schneller durch "Shift" + Click auf einen der 3 "Views" im Zoom Menue
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erfolgen.
Dabei wird die aktuelle Karten-Position mit Zoom gespeichert.
Shortcuts anders: "1" (one user) nun "."
II2II +rf nun II=II
"On next click" neu einstellen erforderlich

12.5. 2013

+ Tooltipps mit Text aus externem File "hints.txt" und schon etlichen Texten drin.

Darf natuerlich verbessert oder uebersetzt werden wobei das Ergebnis der
Arbeit

sofort aktiv ist sobald das hints.txt gespeichert ist.

|Buttonnummer Text

die fehlenden Texte werden als "<Buttonnummer> hint text" gezeigt

die Struktur des File>Config wird noch umgebaut daher mit den hints dafuer
abwarten

15. 5. 2013

+ "Zitter"-Toleranz fuer Mausposition innerhalb der die Hints sichtbar bleiben + Zeigt aktuelle
"Mbytes written" des Video Files + List>Internals zeigt System Zustand + "L" Shortcut nun
"toggle Labels on/off" Labels=Text bei den Symbolen + Fine Zoom Steps im Config

17.5.2013

+ "L" und "O" bzw "Labels off" "Objects off" wird nun nimmer in Form von 0% Helligkeit

im Config verewigt

+ In Vorbereitung auf ein Text-Fenster kommt nun mal List>Messages und List>Bulletins

auf das Start Terminal Fenster raus, wobei die Bulletins noch nach
Absender/Eintreffzeit sortiert sind und nicht nach der BLN<nummer>

+ Angeklickte Objekte kann man in Infos>List Raw oder Infos>+Decoded auf das Textfenster

auflisten lassen (ohne farbige Fehlermeldungen)

18. 5. 2013

+ Config>Show Incoming "n" Zeigt TCP-Frames auf dem Textfenster, "n+" Dekodiert

fuer die Radio Ports entsprechend 1 2 3 ... und 1+ 2+ ... Dekodiert
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21.5.2013

+ Raw+Decoded Sprechblase aktualisiert sich mit ankommenden Daten falls sie den letzten

Wegpunkt anzeigt

+ Delete Waypoint, wenn mit Debug oder Raw+Decoded markiert. Mit DEL-Taste zum entfernen

von (falschen) Wegpunkten. Marker 1 springt dann zum naechsten
(vermutlichen) Fehler weiter.
(Wann alles loeschen oder nur Waypoint muss noch besser definiertbar sein)

+ Hoehe wird auch bei Symbolen ohne km/h Daten angezeigt falls Hoehendaten vorhanden und

eingeschaltet.

23.5.2013

+ UDP-Port im Config (erst mal 1 Stueck) + Fenstergroesse veraendern schneller + Trackfilter
Fehlererkennung verbessert + Bei Debug Funktionen Verzoegerungszeit von doppelten
Waypoints in Sekunden sichtbar

29.5. 2013

+ Zwecks schnellem Tracks Debuggen mit "E" oder File>Infos>Waypoints-Button toggelt

alle, oder nur die als verdaechtig markierte Waypoints anzeigen mit den "<""
>" Tasten
oder den Buttons daneben.

+ rawlog mit lesbarem Datum/Zeitstempel, das alte Format wird lesend auch akzeptiert.

+ axudp-kiss (usb)seriell Interface (udpflex) erweitert, sodass nebst an/abstecken von

usb-Seriellen auch ein resetteter TNC2 an empfangenen (nun nicht mehr kiss)
Daten

erkannt und wieder auf kiss geschaltet wird. Geht mit init File auch fuer
andere TNC

wie in THD7x oder TMD7x.

udpflex (linux), udpflex.exe (win32)

8.6.2013
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+ Configurierbare default Speed fuer Animation + Parkplatzzittern-Erkennung fuer Animation
Startzeit verbessert + Source Code Entruempelung zum einfacheren Compilieren fuer
verschiedene Prozessoren

15. 6. 2013

+ km/h und/oder Hoehe in Animation und Video wobei Lesbarkeit bei schneller Aenderung

noch verbessert werden kann.

+ Uhrzeit beim Log schreiben laeuft nun auch waehrend Animation in Echtzeit. + +-24h
Zeitversatz Systemzeit/angezeigte Zeit einstellbar

5.7.2013

+ Objekte mit extra "keep in memory time" zB um den schon nach 5 bis 6h recycelten

Blitz-0Object-Namen keinen Track erzeugen zu lassen.

+ Logfile browsen geht gleichzeitig mit online Betrieb. Dazu wurde eine zweite

Uhrzeit geschaffen die den Logdaten folgt und die Echtzeit Daten werden
unabhaengig

von den Logdaten (wie sonst auch) im RAM und writelog gepspeichert.

Es kann jederzeit zwischen Log und Echtzeit gschalten werden und in den
Logdaten

an Anfang, Ende, und in "Fullbright" Zeitspruengen vor und zurueck gegangen
werden

womit immer alle Daten einmal sichtbar sind.

+ Status Bar zeigt Betriebszustand, erst mal experimentell zum sehen was man braucht

mit Buchstaben bis Symbole entworfen sind. Bei TCP (Internet) und und UDP
(Funk)

wandert die Farbe von gruen nach rot binnen 1 Min. solang keine Daten
ankommen.

Message soll mal anstatt dem Popup Fenster vorhandene Messages anzeigen und
erst bei

draufklicken Inhalt zeigen.

16. 7. 2013

+ Hoehen Diagramm ueber Wegstrecke, mit Trackfiler on "F" wird versucht die manchmal

ungenaue Hoehenmessung etwas glatt zu buegeln.
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+ Beim Track anklicken wird der Wegpunkt ausgewaehlt der der Klickpunkt am naechten

liegt.

+ Popup Meldungen, die Befehle bestaetigen, werden nach ein paar Sekunden wieder

entfernt. Da, um CPU Zeit zu sparen, der Bildschirm nur aktualisiert wird
wenn neue
Daten kommn, geschieht das Loeschen nur im Zuge einem Updates.

19. 7. 2013

+ "On Next Click To Track" mit Speed oder Altitude aktiviert, setzt eine Marke auf

dem Diagramm, die der angeklicken Stelle am Track entspricht.

+ "On Next Click To Track" kann mit 1 Click Wegpunkt loeschen aktivert werden.

+ Ein angewaehltes Objekt kann mit "Save" als Logfile mit dem Filenamen des Objekts

gespeichert werden (derzeit nur im Startverzeichnis). Existiert das File,
wird

hinten dran geschrieben. Es werden alle Daten aus dem RAM geschrieben auch
wenn

mit Trackfilter oder Fullbright Time ausgeblendet.

Manuell geloeschte Baken/Wegpunkte sind weg.

22.7.2013

+ Video/Animation Speed Einstellbereich erweitert von 1:1 (Echtzeit) bis 200s/Frame

womit die Speed-Zahl statt (Echt-)Sekunden zu Frames jetzt multiplikator fuer
Echtzeit ist.

+ Start Delay fuer beschleunigte Darstellung (wenn sich nichts bewegt) einstellbar

+ Log Import fuer ein Call wobei immer auf eine Zeitspanne gesucht wird in der das

Call aktiv war (keine wildcards)

25.7.2013

+ "On Next Click" mit mehreren Optionen gleichzeitig (wo es Sinn macht).
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9. 8. 2013

+ Durch erweitern der Menue-Darstellung auf Tabellen mit Farben und verbessern des

Zeilen-Editors (Maus kann Cursor setzen ...) ist Messages erstellen und
verwalten

moeglich geworden. Empfangene Messages sind noch ohne Tabelle.

2.9.2013

+ Nach komplettem Umbau des Konfigurations-Tools mit dynamischer Anzahl der

Eintraege geht nun Messages senden, mehrere Aprs-Server-urls die abgeklappert
werden bis einer antwortet, beliebig viele Watchcalls, Filtereintraege,
Baken. ..

Der Texteditor kann Insert/Overtype und Cursor setzen mit der Maus.

Mit Shift-Linksklick auf die Karte wird die Position in die Editorzeile
kopiert (jetzt einfach wiederholbar bis man "getroffen" hat)

(Die eigene Position und die Zoom>"Views" muessen neu eingegeben werden)

+ Die aktuelle Fenstergroesse wird im Konfigfile mit gespeichert.

"View 1" wird beim Programmstart dargestellt.
(speichern der aktuellen Ansicht mit Shift-Linksklick im Zoom-Menue)

+ Nach der Frage "was brauch ich alles um online zu gehn" ist dies nun in

einem Menue. Dabei kann man abgestuft von ganz ohne Call bis Call und eigene
Position nur dem Server sagen (zwecks funktionieren der m/... Filter) bis
Bake und Messages ins Netz senden konfigurieren.

+ lgate-Funktion ist nur in der Linux Version vorhanden da das Win-tcp-System

keine Info ueber bestaetigte Daten hat und dann einen als "haengend"
erkannten

Link nicht terminieren kann, ohne die veralteten Daten noch rauszuweinen.
Das waere im aktuellen AprsIs-Netz ohne Timestamps nicht mehr akzeptabel.
Auch die Linux Igate-Funktion sollte auf keinen Fall fuer einen Digi
verwendet

werden da zB. beim Logfiles durchsuchen die Durchlaufzeit erheblich werden
kann.

Fuer Igate gibts ohnhin ein eigenes Tool.

+ UDP-Ports fuer Funk rx/tx mit Soundmodem oder mittels "udpflex" (USB)seriellen
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TNC gibts derzeit 4. Eine dynamische Anzahl braucht noch Aufwand bei den
Schaltknépfen in den Menues.

Der Funk-Baken/Objekt/Items-Editor ist noch in Entwicklung, dort dann auch
wieder die verschwundene "Rfbeacomtime" fuer jede Bake extra.
(bis da hin 1 Bake manuell ins aprsmap.cfg)

4.9.2013

+ Baken senden mit Macros fuer Uhrzeit und File einfuegen (Wetterbake). Jede Bake

mit Port und Intervall Angabe und Zielport geht auch Net. Mit Beacons Shift
Time

wird die Startzeit jeder weiteren Bake so verschoben, dass sie nicht
innerhalb der

"dupe delete" zeit (meinst 57s) der Igates landen.

Syntax: intervall(s):port:rawformat 600:1:NOCALL>CQ:>test

\\z tag+zeit, \\h zeit, \\:filename:, \\\ \\

8.9.2013

+ Maus Hint Texte verbessert und deren Erscheinen an der Status Bar. + User Infos erweitert,
gefahrene km, Zaehler fuer Baken, Messages, Acks, Rejects

9.9.2013

+ "Show Objects of Sender" zeigt alle (anderen) Objekte und Items von dem Absender

des Ausgewaehlten Objekts auf einer dafuer gezoomten Karte unter
"Info>0bjects of.."

+ Shift-Click auf die Status-Bar (die bunten Laempchen) oeffnet direkt das zugehoerige

Config-Menue soweit Sinnvoll.

11.9. 2013

+ Menue Positionierung korrigiert und Menues nimmer schliessen bei Shift-Click

auf Map zum Position in Editor Zeile kopieren

13.9. 2013
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+ Statusbar Netzwerk-Buttons Mouse-Over wenn nicht online normale Hints,

wenn online, Status Info. X/N zeigt offline/online (sollten mal Symbole
werden)

+ "w" Temperatur-Karte wie bisher, "W" (w mit Shift) Regen-Karte mit blau fuer

24h und rot fuer aktuellen Regen (noch ohne Fehlerfilter, luegende Stationen
anklicken und mit DEL entsorgen).

16. 9. 2013

+ Logfile lesen mitn Binaersuche fuer den Anfang ab wo ins RAM eingelesen wird

mit dem Vorteil, dass auch lange Logs beim Programmstart und Log Import
schnell

nach Datum durchsucht sind, aber das Logfile muss nach Datum sortiert sein.
Derzeit max 4GB Logfile.

19. 9. 2013

+ Message (Query) Kommandowoerter + Antworten in Config > Rf-Ports.

Standard Querys (?APRSP) als auch beliebige Woerter koennen definiert
werden und in der Antwort Macros wie \\h Uhrzeit, \\p Path, \\1l Position,
\\v Programm Version, \\<filename> File senden, \\>filename> schreiben,
letzteres zum aktivieren von einem Programm zum was Steuern oder
Sprachausgabe

"TALK:\\>/tmp/talk.txt>Text um \\h Gesprochen!"

"?HELP:?APRSP, ?VER, TALK"

22.9. 2013

+ Windfahne und Temperatur beim Symbol mit Timeout. + 1 Kommastelle mehr bei Koordinaten-
Ausgabe und bei Maus-Koordinaten

Grad/Minuten/Sekunden-Schreibweise zuaetzlich.

+ Win32: bei der (oder mehr) Start-Fenstergroesse die der Bildschirm kann,

"Maximized" Fenster.

7.10. 2013
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+ Filesystem auf "Longfiles" umgestellt damit sollte Logfile >2GB geschrieben

und dank Binaersuche auch flott importiert werden koennen.

+ Programm Starter fuer Maps-Downloader bei Bedarf (gm.sh bzw gm.bat)

der kann sich nach getaner Arbeit beenden. Status in der Status-Bar
mit "D" statt "E" fuer Downloader laeuft erkennbar.

+ Beliebige Map-Typen configurierbar mit korrektur der Basis-Helligkeit,

die ersten 3 wie gewohnt mit Shortcut "7" "8" "9", die 1. beim Start aktiv.
Sat-Maps erst wenn ein JPEG-Dekoder vorhanden ist (ausser man wandelt
sie beim Download in PNG). Neu (voreingestellt): cyclemap

11. 10. 2013

+ Wegstrecken Summe (ohne Track) auf der Map (shift-click, click, click...) + Log Import (bis auf
Suche rueckwaerts nach Call) bei unsortiertem File

versucht etwas zu verbessern

13.10. 2013

+ Schriftgroesse einstellbar (Config > Map Paramter > Font Size)

15. 10. 2013

+ Screenshot auch als ".png" (vorerst nur Linux Version)

und osm-Verzeichnispfad wieder configurierbar

+ "On next click to Track" bei mehrfacher Auswahl mit "Zoom to" wird erst gezoomt

und dann im 1 Track Mode die anderen Funktionen aktiv.

31.10. 2013

+ Beep-Sounds mit beliebiger Frequenz und Dauer wenn Message oder Ack eintrifft,

wenn sich wer in den Warnradius bewegt mit steigender Frequenz und/oder Dauer
je naeher er zum Zentrum kommt und wenn ein Call aus der Watch Liste aktiv
wird.
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Alle getrennt schaltbar und limitiert auf maximal alle 5s.

Windoof 7 oder 8 geschaedigte koennten evtl. keinen Piepser haben dann gibts
als

Ersatz 3 System-Sounds (mit Oms einschalten, bis 500, bis 1000, ab 1000Hz
jeweils ein anderer Gong).

Config > Map Moving > Bell/Sound

6. 11. 2013

+ In Animation und gedimmten nicht-movern wird die schrift der "mover" im

nun Vordergrund gehalten

+ Einfaches Hyperlink Hilfetext System mit File "help.txt" unter "Help"

erreichbar mit ein bisschen Text als Beispiel

18. 11. 2013

+ Einstellbarer Timer zum Verzoegern vom Mapdownload Start waehrend Karte

verschieben, wer so vermeiden will, dass in hohem Zoom der Streifen an Karten
entlang der Bewegung durch die Botanik geladen wird. Config / Timers

+ Index Taste im Help Fenster

+ Schutz vor ewig loopenden Mapdownloads wenn durch zB volle Platte oder nicht

identischem Schreib/Lese-Pfad immer die gleichen Karten angefordert werden.
Kommt ein Kartenteil immer wieder, wird nach ein paar Versuchen 1. nur mehr
1 Karte angefordert, 2. die Pause zwischen Anforderungen immer Verdoppelt
und 3. poppt eine Fehlermeldung auf.

+ Copy/Paste hinein ins Program (rechte Maustaste im Textfeld oder ctrl-v)

(bei linux jetzt mit dem aktuellen "keiner verstehts..." selection-
Verfahren)

22.11. 2013

+ "Ok" im config-Zeileneditor schliesst das Fenster nach dem Speichern. + Map download Timing
(im Fehlerfall) optimiert, dass mit dem in entwicklung

befindlichen hochgeschwindigkeits-Downloader von oe5krn bei falscher
Einstellung oder voller Platte keine "Gigabyte" ins Nirvana geladen werden.
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28.11. 2013
+ "B" und "M" (gross) fuer Bakeneditor und Message senden
+ Index bei Helptext

+ Umfangreicher Baken/Objekt/Item Editor mit verschiebbarem Fenster,

Import von vorhandenen Objekten auf der Karte durch anklicken.

Testen lokal vorm Senden.

Einmal senden oder mit Timer und Verschiebung der Sendezeiten, dass die
Duplikatloeschung in den Igates Sendungen mit gleichen Inhalt aber
verschiedener Frequenz (oder direkt per tcp) im Netz sichtbar laesst.

Einfaches Fernloeschen von Items und Objects.

Normal/Mic-E/Compressed mit DAO Erweiterung fuer 20cm Genauigkeit

(die aber je nach Fliesskommaarithmetik nur etwa 1lm schafft)

mit Bytezaehler der Gesamtlaenge beim editieren der Kommentarzeile zum
optimieren der Kompressionsart.

Macros zum Einfuegen von Files zB fuer Wetterbake

+ Query standard Antworten (?APRST ...) vorkonfiguriert mit opt-out wers

nicht will. Config > Rf Ports > Query Keywords

+ Fehler behoben, Decodieren von Items mit kurzem Label.

Unsichtbare User wegen keinem oder falschem Symbol (die aber trotzdem
watch/approxy-piepsen) haben nun Label und Track

+ Listings im "Show 1 Modus" zeigen nun nur was zu dem User gehoert

4.12. 2013

+ Config > Rf-Ports > Monitor Headline
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Damit kann man 0 bis 20 Calls + Tempertur oder km/h als "Ticker"

von aktuellen Frames auf der Fenster-Ueberschrift durchlaufen lassen.
Bei minimiertem Fenster ist das aktuellste Call in der Taskleiste.

N> kommt von, N< get ans Netz, 1> 2> Funkports, N- heisst der Frame
ist entweder in den Callfiltern oder ohne verwertbarem Inhalt.

+ (grosses) "F" Shortcut Find (Call, Locator, Breite/Laenge)

+ Bakeneditor "Draw" schreibt nimmer ins rawlog

10. 12. 2013

+ Calls + Temp,km/h,Hoehe der ankommenden und abgehenden Daten in der

Fenster-Kopfzeile. Anzahl der Calls Config>Rf-Ports>Monitor Headline.
Updaterate auf (Mittelwert) 1s limitiert.

+ Maus-Verhalten umgestellt (aehnlich anderen Programmen).

Linksklick wartet auf Maus-Bewegung (mit ein bisschen Zitter Toleranz)
und zieht Karte (auch wenn ein Symbol getroffen) oder, am oberen Rand
angefasst, konnen einige Menues und die Status-Bar positioniert werden
mit "ankleben" an den Fensterrand und gespeichert in aprsmap.cfg.

Beim auslassen der Maustaste, wenn nicht bewegt, wird der normale Klick
ausgeloest.

Mittlere Maustaste zieht alles was ziehbar ist und an beliebiger Stelle
angefasst.

Rechte Maustaste wie bisher Back-in-zoom-History oder in einer
Texteingabe "Paste" (falls was im copy/paste Puffer ist)

15.12. 2013

+ Message Senden nun bis 67 Zeichen wie im Protokoll vorgesehen statt 57. + Umlautwandler
auf "Ae Oe Ue ss" (bis mal ein 8 Bit Zeichensatz definiert ist). + Message Eingabezeile geleert
wenn die vorherige Message abgeschickt wurde oder

an ein anderes Call als zuvor gesendet werden soll.

+ Schnelles Zoomen mit Shift-Linksklick und Rahmen um den gewuenschten Inhalt

aufziehen.
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+ (nur Linux) jpeg-Dekoder fuer Maps wobei erst .png versucht wird dann

jpeg in .png Filenamen und zuletzt jpeg als .jpg (gm.sh modifizieren).

16. 1. 2014

+ Config / Online / Serverfilter Aenderungen werden bei "Ok" sofort zum

Server geschickt. (sofern der die "# filter ..." Syntax versteht)

+ mit "<" ">" durch einen Track wandern geht mit gleichzeitig geoeffneter

Altitude- und Speed-Statistik und zeigt dort die Stelle am Track und die
Messwerte numerisch.

+ Tools / List neu mit verschieb- maximier-, ikonisierbarem Textfenster

mit Scrollbalken (und Cursortasten und Mausrad) und nach Zeit und
alfabetisch sortierbarem Inhalt.

Es kann Rohdaten und dekodiert listen. Text kann man markieren und mit
"Paste" in andere Anwendungen kopieren (auch auf Win ohne umstaendlichen
Dialog). Gibt man in Tools / Find ("F"-Taste) ein Wort ein, werden alle
gleichnamigen Stellen farblich hervorgehoben zB. "APLMO1" oder ein Call.

Klickt man auf eine Zeile, wird auf der Landkarte die Herkunft gezeigt,
sofern die Zeile eine Position enthaelt und wenn nicht, die letzte
bekannte Position vom Absender der Zeile.

Das Live-Monitor-Fenster fuer empfangene und gesendete Daten hat anstatt
sortieren "Clr" fuer Inhalt loeschen, es stoppt raufscrollen wenn man
mindesten 1 Zeile herunter geschoben hat, und kann mit "u"-Taste an und aus
geschaltet werden. (Beachten: bei Batteriebetrieb durch den laufenden
Bild-Update evtl mehr CPU/Akkuverbrauch)

Das Aktivieren des Monitors ist, bis eine selbsterklaerende Menue-Struktur
erfunden ist, noch wie zuvor unter Config / Rf-Ports / Monitor Frames.

+ Linux: F11-Taste (bei "seltsamen" Fenstermachern die selber kein Maximieren

oder dann wieder kleiner machen koennen) toggelt Fullscreen/Normal.

+ Win: Kein extra Textfenster mehr da Listings eingebaut.

20. 1. 2014 (Ver 0.32)
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+ Funkport (Soundmodem / udpflex) Kommandozeile in Config / Rf Ports /

Serial Interface
Task wird automatisch gestartet.

+ Monitor Ports off/raw/decoded einzeln mit Klick schaltbar Tools/List/Monitor.

3.2.2014 (Ver 0.32)

+ Message Rx: Schalter fuer Pop-up Fenster

Schalter fuer zeigen von Messages an andere SSID
Schalter fuer Messages an sich selber weg filtern (default on)

6. 6. 2014 (Ver 0.34-testversion)

+ Hohendaten (soweit in einem Datenfile vorhanden)

bei "show Location of Mouse" "on" werden m ueber NN angezeigt
ebenfalls neu, Distanz und Winkel zum Marker 1 wird angezeigt

Files zum selber besorgen:

osm/srtm3/N48E012.hgt
N48EO13.hgt

(90m aufloesung, 1x1 grad 2.8MByte pro File
http://dds.cr.usgs.gov/srtm/version2 1/SRTM3/Eurasia/)

osm/srtm30/WO20N90.DEM
(900m aufloesung, 20W..20E, 40 bis 90N 57Byte, deckt den Rest ab
http://dds.cr.usgs.gov/srtm/version2 1/SRTM30/)

osm/eudem/ (noch nicht implementiert)
30m Aufloesung, 640MByte fuer 5x5 grad, braucht aber erst
konvertierprogramm
vom (unbrauchbaren) "eu-geotiff" in lesbares Format
http://www.eea.europa.eu/data-and-maps/data/eu-dem#eeaEsriMap

+ Radiolink Berechnung zwischen Marker 1 und 2 nach Eingabe von Antennenhoehen
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und Wellenlaenge. Vorerst mal Darstellung auf der Map als farbige Fresnelzone
"blau" frei, "gelb" bis "rot" von angekratzter 1. Fresnelzone bis voll
verdeckt.

+ Radiolink mit 2 Klicks oder fuer tastaturlose Bedienung

"On next click to Map" mit "Set Marker 1" beim 1. Klick und Marker 2 bei
weiteren
Klicks nach "Clear Markers" wird wieder erst Marker 1 gesetzt.

+ "d" Shortcut fuer Map downlod on/off

+ Map download auch wenn auf "off" wenn "Reload" oder die Download funktion

betaetigt wird.

+ Testweise "High Resolution Track" Dekodierung als Protokollerweiterung eingebaut.

Dabei werden mit einer Bake 2 bis 30 Positionen gepackt als Abweichung von
einer

Geraden 2 oder 3 dimensional + Timestamp uebertragen. Wird die Erweiterung
nicht

erkannt bleibt die normale Position pro Bake.

Die Optionen sind erweiterbar, Positionsaufloesung, End-zu-End Pruefsumme,
"QRV"-Frequenz, direktgehoert von Igate, Climb-Rate und fuer Wanderer hoehere
Geschwindigkeitsaufloesung sind mal vorgesehen. Traegt sich der
direkthoerende

Igate ein, wird vom AprsIs-Service eine veraenderte Kommentarzeile erkannt
und

damit ALLE Igates ersichtlich, die direkt gehoert haben und nicht nur der mit

der schnellsten Glasfaser Anbindung. Dekodiert wird dabei eine in vom
Empfangsmodem

in Klartext umgesetzte Darstellung fuer AprsIs. Am Funkweg wird binaer und
wesentlich

kleiner gepackt lbertragen.

13. 6. 2014 (Ver 0.35-testversion)

® osm/srtm1/N48E012.hgt mit 30m horizontaler Auflésung aus den EU-DEM Daten
umformatiert in das srtm1-Format wird bevorzugt verwendet.
UDP-Ports restarten sich wenn beim Editieren was verandert wurde.
Map Loader startet beim enabeln ohne nochmal herumzoomen.
Speed/Altitude/Gelaendeschnitt-Diagramm updatet sich mit ankommenden Daten wenn mit
letztem Wegpunkt oder Symbol anklicken geoéffnet.
Igate (Rf to Net, nur Linux) jeder UDP Port kann einzeln freigeschaltet werden
Gelandeschnitt, Darstellungs-Versuch mit zusatzlichem Freiraum-Diagramm auf der
Landkarte. Praktisch zum Zoomen aber evtl. missverstandlich da nur die Fresnel-Zone zur
Karte passt und folglich die Punktreihe, die die Bodenhdhe darstellen soll, nicht.
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17. 6. 2014 (Ver 0.35-testversion)

® Sichtweiten Farbkarte, mit Marker 1 oder 2 oder beiden gesetzt, wird mit "R"-Taste die
optische Sichtweite dargestellt. Antennenhoehen am Marker ist 1. Wert in "Tools/Radiolink"
am andern Ende gilt Wert 2. Die Wellenlaenge wird hier auf 0 gesetzt und damit ist ab halber
Fresnelzone "Sicht". Farbhelligkeit in "Config/Map Parameter/Brightness Rfpath" Die
Berechnung ist noch experimentell und sollte nach optimierung deutlich schneller werden
und damit man die Landkarte noch lesen kann brauchts noch Darstellungs-ideen.

28. 6. 2014 (Ver 0.37-testversion)

® Marker setzen mit Einrasten auf die genaue Position eines angeklicktes Objekts (More Infos>
) und ohne Einrasten im Zoom Menue. Dort auch Marker einzeln I6schbar. Marker 1 als "hart
(gelb)" oder "weich (blau)", letzerer entsteht durch einfaches Anklicken, bewegt sich mit
fahrenden Objekten bzw. huepft auf neu angeklickte Objekte oder Wegpunke und hat ein
Timeout. Harter Marker bleibt bis I6schen.

® Netz/Funkport Status-Laempchen zeigen nun letzte Sendung (gelb) und letzten Empfang
(griin) seit 60s als Sanduhr.

® Mausrad (oder Zoom-Menue +/- mit Shift) Zoom Stufen (Config/Map Moveing/Fine Zoom
Steps) rastern nun die automatischen Zoomvorgaenge auf die eingestellten Werte
insbesondere auf "1" also original Osm-Stufen.

® Ausgeschaltete Tracks (Helligkeit auf 0) machen nun auch Funkwege und Zoom auf das was
man noch sieht.

1.7.2014 (Ver 0.38-testversion)

® Watchliste neu mit Schalter fuer Pieps / Landkarte mitbewegen / Logfile zB. mit OE*
getrennte Lodfiles fuer jedes Call mit OE vorn schreiben.
Shift-Click auf Rf-Port-Knopf geht direkt in Config-Editor.

Portname nach dem Port-URL zeigt in "i"-Liste und beim "Hovern" auf den aktiven Portknopf
Namen und ip Nummer.

® On Next Click to Track mit "Zoom to" schaltet erst in den 1 User Modus und tut dann (nun
hoffentlich) die anderen aktivierten Dinge.

3.7.2014 (Ver 0.38-testversion)

® Baken sollten sichn nun auch mit den "\\" Macros wieder in den Editor laden lassen ohne dass
diese expandiert werden. (Vorhandene Objekt-Baken neu eingeben)

® Message Routing verbessert mit automatischer "NOGATE"-Option wenn nur Funkports
verwendet werden

® Message und Baken Sende-Meldung und Rueckfrage wenn man (meist versehentlich)
Leerzeilen Msg senden will.

4.7.2014 (Ver 0.38-testversion)

® Logfile loeschen bzw. Filegroesse anzeigen
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® Etwas mehr "On Next Click"-Optionen kombinierbar

8. 7. 2014 (Ver 0.39-testversion)

WX grafik zeigen auch wenn WX Baken ohne WX Daten dabei sind
Schalter fuer nur WX-Stationen auf der Karte zeigen

17. 7. 2014 (Ver 0.40-testversion)

Nur WX Stationen auf der Karte Zeigen
Relief Karten rechnen mit Fortschrittsanzeige und nach 4s Abfrage auf Abbruch (mit srtm(1)
Files (Netzwerk-Laufwerk zu langsam) und noch ohne Antialiasing was ab zoom 12 sichtbar
wird) map parameter/brightness rfpath zB. "30 100 50 100 80 20 0 100 100" (der 3. Wert 0
fuer harten Kontrast/Funkreichweite oder 500 fir aufpeppen von osm-Karten) tools/radiolink
"2000 0 0 200" marker 1 und evtl marker 2 setzen und "R" "config/brightness map" zum ein
/ausblenden der osm karte)

® Digipeater (abgespeckte udpbox derzeit noch ohne klicker-Editor und nur grob getestet)
Config/Rf-Ports/Digipeater, derweil Internes Format mit Zeileneditor bearbeiten.

® Message Sendetaetigkeit-popup-Meldungen verfeinert und korrigiert

18. 7. 2014 (Ver 0.40-testversion)

® der Logfile-Pfad fuer das rawlog wird auch fuer die Watchcall-Logs verwendet

19. 7. 2014 (Ver 0.40-testversion)

® Watchcall-Liste nach "longest-match" durchsuchen. "OEOAAA" passt bei * OE* OE0* OEQB*
auf OEO* OE* +log / OE1X +log / OE1* nichts / OE5A +beep schreibt log von oe ausser oel
und oe5a aber schon oelx und peept bei OE5A

® Call-Log FilegroRe anzeigen und Files l6schen

20. 7. 2014 (Ver 0.40-testversion)

Cursor Up/Down Tasten in mehrzeiligen Textmenues
Tasten Fokus Lock auf Eingabefeld nach Anklicken oder Tastatureingabe
1. Klick auf eine Zeile verandert nicht die Kursorposition

25.7.2014 (Ver 0.41-testversion)

Digipeater, mit fein dosierbaren Standard (mach QRG voll) bis "sehr beruhigt" Optionen
Editor dazu Config / Rf-Ports / Digipeater und "Hints"

28. 7. 2014 (Ver 0.41-testversion)

® Farbe fuer Schrift, Menues, Hintergrund, Transparenz, Radiorange, Reliefkarte mit
Farbauswaehler (der noch 3eckig werden soll damit umgekehrt auch eingestellte Farbe drauf
gezeigt werden kann)
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31.

24.

26.

15.

7.2014 (Ver 0.42-testversion)

Statusknopf zeigt durchgehend wenn Wx/Temp./Regen/Radiorange oder single User Modus
ist und kann da ausgeschaltet werden.

8.2014 (Ver 0.42)

"F"ind auf einen sonst unsichtbaren Objekt-Sender zeigt dessen Objekte.

"More Infos" zeigt Button "Objects of Call" wenn Call Objekte sendet.

Wx-only mit "L"abels off zeigt nur Temperatur und Windfahne beim Symbol.
Antennenwinkel bei Gelandeschnitt Info.

"DUPE" Meldung bei Wegpunkt-Info nimmer "ewig" bei einer Fixposition nach einem
Ausreisser.

8.2014 (Ver 0.42)

ip-Nummer Schreiberei vereinfacht, "127.0.0.1" kann weggelassen werden

udpflex erweitert auf "net-kiss", also kiss via tcp, damit es mit dem dire-wolf-Soundmodem
kann "udpflex.exe -U :9002:9001 -T :" (http://home.comcast.net/~wb20sz/site/ geht mit
default Einstellung, Sampelrate sollte man aber halbieren sonst ziehts 750MHz CPU)

10. 2014 (Ver 0.43)

Input Filtern auf Stichwort im ganzen Frame

kleines "e" oder "d" im Map-expansion-Lampchen zeigt automatischer Map Download off
(toggle mit "d"), Manueller Map Reload/Download geht aber auch in dem Modus.

Im "F"ind Feld geht auch dezimal Grad "48.2 13.31".

bei den Config Zeilen geht "Enter-Taste" als Ok oder Add.

Textfarbe vom Items/Objects mit Farbauswahler unabhagnig von normalen Baken einstellbar.
Fontgroesse Eingabe zeigt sofort Ergebnis.

ist ein Objekt im "show 1" modus, kann man mit "Focus" Karte mitziehen einschalten ohne
Watchlisten Eintrag.

TAB-Taste schaltet zwischen 2 Kontexten hin und her, dazu zaehlt nebst Wetterkarten-Modi
auch der "Focus" Modus, womit 2 Objekte im Bild gehalten werden kénnen.
Baken/Message/Ack Senden Warnmeldungen verbessert, wenn der eingestellte Sendepfad
vermutlich nicht zum Erfolg fuehrt. (Port ausgeschaltet, nicht zum Senden konfiguriert, kein
Passcode am Internet ....)

Gelandeschnitt, Reichweiten-, Relief-Karten Parameter in ausfihrlicherem Menu
zusammengefasst.

Gelandeschnitt zeigt freie Meter zum Boden (Karte ziehen zum Messmarke bewegen)
Trackfilter beim Suchen auf Duplikate mit Indexsystem so verschnellert, dass beim aus dem
Speicher Entfernen von Wegpunkten, auch deren Folgefehler mit Entfernt werden kénnen.

. 11. 2014 (Ver 0.45)

Gelandeschnitt und Reliefkarten mit einstellbarem Hohendaten Cache damit Plattenzugriff
auf etwa 0.5% verringert.
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Schalter "kleine/mittlere/volle Aufloesung" entsprechend langsam bis schnell.
Interpolation der Hoehendaten und damit brauchbare Bilder bis Zoom 14

im "Find" Feld geht Call / Sender of Object / Locator / DDMM.MM / D.DDDD
Marker 1 setzen Sendet DDMM.MM zum c/p Buffer, Marker 2 D.DDDDD Format.

9. 12. 2014 (Ver 0.46)

Watchcall Popup-Fenster anklickbar und zentriert Map auf das Objekt
Point-Of-Interest-File (osm/poi.txt) mit Name/Position/(optional) Hoehe (als Beispiel ist ein File
mit etwa 20000 mehr oder weniger richtigen Alpengipfeln vorhanden)

® mit "F" oder Tools->Find kann mit Wildcards (ste?n*) auf die Namen gesucht werden und die
Karte zentriert auf die Position und setzt Marker 1. Bei mehreren passenden Namen mit Enter
oder Klick auf Find werden alle Positionen durchgesteppt.

® st "p" oder Config->Map Parameter->Show Loc of Mouse auf ON, geht beim Bewegen der
Maus eine Sprechblase mit Zeiger zum nachstgelegenen Poi auf. Mit "c" kann die Karte drauf
zentriert werden.

30. 12. 2014 (Ver 0.46)

® Marker 1 und 2 setzen ("x" "y") geht ohne vorher auf die Karte klicken gleiches bei Zentrieren
"c" mit dem Unterschied wenn ein POl maximal 5 Pixel entfernt angezeigt wird, exakt auf
diesen zentriert wird.

26. 1. 2015 (Ver 0.47)

® nebst "poi.txt" wird noch "mypoi.txt" gelesen damit beim Update bei Bedarf die selber
angelegten Punkte erhalten bleiben. nun auch viele SOTA-Standorte im poi.txt

® | og File (rawlog) durch Anhaengen von %d zB. "logs/rawlog%d" auf tageweise 1 File mit
Datum umstellbar. Ist auch kompatibel zu den Logs am www-Server. (Log Filename jetzt im
"File" Menue)

® Bei tageweisem Log einstellbar nach wieviel Tagen automatisch (beim Start oder Mitternacht)
Logs geloescht werden sollen.

® im Log suchen nach Datum und/oder Call sollte auch dank "Load" (fur ab eingegebenen
Datum) deutlich zuverlassiger gehen.
mehrfach eingetroffene selbe Message wird nur 1x Angezeigt.
Baken (Netzbake, Objekte) kdnnen Position aus File (auch in Grad mit Komma) lesen fuer
bewegliche Objekte oder Mobilbetrieb.

® Baken kdénnen Text-Macro-File I6schen nach 1 mal Senden zum Zweck des automatischen
Verstummens der Bake wenn zB das Wetterhauschen nimmer Updatet.

2. 3. 2015 (Ver 0.48)

® Nur Stationen mit einem bestimmten Symbol aufs Bild, Symbol-Wahl in Tools / Select Data /
Symbol>. On/Off mit "Symbol" oder "s"-Taste. Achtung: Screenshot Taste ist jetzt "S".
® OQverlay Symbole mit Mausklick eingebbar
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6. 3. 2015 (Ver 0.48)

® Zoom-Lupe aufziehen mit rechter Maustaste halten. Ohne Maus bewegen wie bisher
Backspace in der Zoom/Pan History oder (Copy/)Paste in Texteingaben.

15.3. 2015 (Ver 0.49)

® Hover Info Popup (Tools/On Next Click/Hover) auf den Symbolen und Glaendeschnitt zu
Marker 1 wenn Tools/Radiolink enabled.

24.3. 2015 (Ver 0.49)

® |Linkstreckenberechnung mit einstellbarer Beugung (refraktion) der Hf in der Atmosphaere.

15.6. 2015 (Ver 0.49)

® 'H" fuer Hoehendaten Farbdarstellung.

® Cache auch fuer nicht vorhandensein von Hoehendaten damits schneller mit Loechern im
Datenmaterial zurecht kommt.
poi.txt ohne Neustart einlesen mit "Reload Config".
Wx Radioaktivitaet dekodieren und (vorerst) als Text ausgeben.

21.6. 2015 (Ver 0.50)

Maidenhead Locator Ausgabe langes Format, Eingabe "Find" 6 8 oder 10 stellig.
Treiber Aufruf fuer Soundmodems und (USB-)serielle kiss/smack TNC/Funkgeraete
betriebssystemspezifisch voreingestellt (sofern noch kein aprsmap.cfg vorhanden ist).
Popup Fenster Ueberlappungen etwas seltener.

Radioaktivitaet (Sievert) Dekodierung in den Wx-Baken (vorerst ohne Grafik)
Getrennte Backspace/Rechte-Maus History fuer beide TABs

27.6. 2015 (Ver 0.50)

® etwas verbesserte popup Fenster Platzierung.

® Config > Map Parameter > Reset to Default oder kurz "D" stellt die meisten Bildparameter
und Klickverhalten auf Default. Die alten Werte gehen zuvor in die Backspace/rechte Maus-
History zwecks Undo der Funktion.

® History/TAB speichert die wichtigsten Bildparameter + Kartentyp.

6. 7. 2015 (Ver 0.52)

Parameter Reset "ctrl-L" statt "D"
dekodieren und darstellen vom Area-Objects, Kreis, Ellypse, Rechteck, Dreieck, Linie (ohne
Corridor) gefuellt oder leer in 8 Farben nach APRS101.pdf.

® Baken Editor erstmal fuer numerische Eingabe der Area Objects.
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® dekodieren und darstellen von Multiline-Objects mit 3 Linientypen und 4 Farben nach AE5PL
1-23 Linien pro Bake geschlossen oder offen.

® Anklicken aller Linien und Flaechen am Rand und Verhalten wie normale Objekte aber ohne
Track bei Bewegung.

8. 7.2015 (Ver 0.52)
® Multiline-Objekt Editor

25. 8. 2015 (Ver 0.54)

® Mic-e-Telemetrie Dekoder, die Herstellercodes aus den Mic-e Frames werden dazu vorher
entfernt (soweit es geht) was auch sauberere Kommentarzeilen ergibt.

16.10. 2015 (Ver 0.56)

® \Wetterbake (Netbeacon, Rf Beacon, Query) aus .csv File

\\!wx.csv,,,t,,,,,h,b,r,w,d,,,,,g! im comment extrahiert die Werte aus der
letzten Zeile

im File wx.csv. Es kann noch ein Multiplikator angegeben werden zb. ,w3.6,
statt ,w, zum

Umrechnen von m/s auf km/h. Werte siehe Hints. Wx Symbol auswaehlen.

® Messages/Queries bei 9-stelligem Mycall sollten nun bestaetigt/beantwortet werden.

24.11. 2015 (Ver 0.58)

® Wx Grafiken korrigiert

® Schaltknopf/Laempchen fuer Objekte Ein/Aus

® Gate Net-to-Rf mit Radius und Bit/s Limit und Option nur Message zu (gehoerten) Usern (mit
Standard-3rd-party Protokoll und ohne speichern/wiederholen von Messages). Einschalten mit
Config/Rf-Ports/Digipeater, Rx auf "N", Bit/s in "N-n Words" siehe Hints.

28.11. 2015 (Ver 0.58)

® Starten ohne "terminal" und Abstellen sollte ohne X11 abschmieren gehen.
® UDP Ports an und abschalten auch mit laufendem "serial interface".

29.11. 2015 (Ver 0.58)

® History bei der "Find" Zeile mit Cursor up/down.

® Rf-Monitor mit Txdelay, Level und Quality, sofern vom Modem geliefert (afskmodem linux).

® Fenster Kopfzeile "nur neue" Calls (Config/rf-ports/monitor headline 0) und Zeit seit letztem
mal gehort(1).
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7.1.2016 (Ver 0.59)
® "Storm Data" Auswertung und Flachen-Darstellung mit interpolierter Animation. (mangels
Aktueller Testdaten nach APRS101.pdf in nautischen Meilen 1.609km)

® Area-, Multiline-, Sturm-Objekte mit "<>" durchsteppen mit zum Wegpunkt gehdérender
Flachendarstellung.

23.1.2016 (Ver 0.59)

® |tem in Messages, (B)akeneditor (auf "Item") + (M)essage Send Fenster gedffnet kopiert den
Bakeninhalt in Message Text und erzeugt dann beim Empfaenger der Msg ein Symbol auf der
Karte. (APRS1.2) Da sich die Protokollerweiterung Item-Message und Multiline-Object
gegenseitig beissen ("{" symbol), geht die Kombination vermutlich nur mit aprsmap + send
with ack.

25.5.2016 (Ver 0.61)

® Objekte ohne Richtung und Geschwindigkeit zeichnen keinen Track mehr.
® alle alternativ Symbole koennen Overlay Zeichen haben (a..z A..Z 0..9)
® Hamnet Symbol in symbols.png

15.3.2017 (Ver 0.64)

® Trackfilter geht bei mehr als 15000 Wegpunkten nimmer gegen Rechenzeit unendlich.
® Trackfilter wird auch mit den kleinen Zappeleien bei Verzoegerungen unter 1Min fertig.
® "Find Item Message" zeigt auch bei mehreren solchen Msgs die dazu passende Position.

5.4.2017 (Ver 0.65)

® Rotes Fehlermeldung-Popupfenster groesser und umfangreicher bei der Baken Eingabe.
® mit []-Tasten Zeit aendern wie lang Dinge auf der Karte sichtbar bleiben.

25.5.2017 (Ver 0.66)

® Kontrast der Symbole verbessert.
® Fenster zu klicken sollte bei vielen Linux-Fenstermachern wieder geeordnet abstellen.
® Linux 64bit Version.

5.7.2017 (Ver 0.67)

® langen Locator suchen korrigiert und Kleinfeld Darstellung
® yudpflex (linux) tcpkiss server
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29.9.2017 (Ver 0.69)

Helligkeitskorrektur (Tools > Add Maptypes) als Gamma Werte statt +- Helligkeit. Bei
Bildschirm-Gamma (Config > Brightness) 2.2 entspricht 0.45 original und 0.3 etwa dem
bisherigen -128. Die Werte werden nun bei Kontextumschaltung mit TAB mit dem Kartentyp
gespeichert.

01.12.2017 (Ver 0.70)

Kartentypen mit Gamma-Korrektur statt Helligkeitskorrektur. (Tools > Add Maptypes) solang
ein Hellikeitswert konfiguriert ist, wird default 0.25 angewendet. (Sinn der Sache: Sat Map
von Sentinel2)

Eingestellte Karten Helligkeiten werden individuell fur Kartentype gespeichert. (Sat Maps sind
bei 100% ok, OSM karten eher bei 20 bis 40%)

"6" schaltet alle aktiven Kartentypen im kreisrum durch.

Font von 7x6 bis 24x12 und zoombare Symbole 16 bis 32 aus symbol file 16 bis 48 Track und
Wegpunkte werden mit angepasst. (Zweck: hochaufloesende Bildschirme)

Neue Fontfiles und Symbolfile mit teiltransparenten Symbolen (wird noch verschénbessert ...)
beim Symbol Zoom wird erst versucht ein zur Grdsse passendes symbolsXX.png zu laden falls
nicht vorhanden wird "symbols.png" gezoomt.

Weicher Alpha-Kanal (Transparenz) bei den Symbolen (win: neue "pngm.dll")

09.12.2017 (Ver 0.71)

win: jpegm.dll damit werden auch OSM Karten im jpeg Format gelesen (auch mit Filename *.
png)

win: getosm.exe (dank an oe5krn) neu mit "getosm.org" start Datei im zip und ohne "getosm.
ini" damit bei Programmupdate OSM-urls nimmer Gberschrieben werden

Urls mit .jpg hinten kdnnen eingegeben werden

Konvertierung auf png kann abgeschaltet bleiben, spart Plattenspeicher

12.02.2018 (Ver 0.72)

Logfile laden (besonders mit 270000 Baken Track drin) verschnellert.

Symbole-Zoom verbessert und % Eingabe als 3. Parameter bei Config>Font>Fontsize flr
Symbolgroesse/Texthoehe Verhaltnis

15.03.2018 (Ver 0.72)

Linux 64bit Copy/Paste Absturz behoben (hoffentlich)
Refraction Parameter wirkt auch bei Radiolink Ausleuchtung

12.07.2018 (Ver 0.74)

Neue-Version-Check Funktion mit shell/BAT script falls wer einen dazu passenden www-server
baut.
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® Radiowellen Ausbreitungsberechnung um Streckendaempfung und Antennendiagramme aus
Hersteller-Files erweitert.

07.10.2018 (Ver 0.75)

® Fehler beim Logfile importieren und nach Uhrzeit sortieren behoben.

12.10.2018 (Ver 0.75)

® poi.txt aus Hamnet-db und Foto-webcam Daten aktualisiert.
® "p" rechnet mit Refrac (0.13 Licht, 0.25 Funk)

17.11.2018 (Ver 0.76)

® Poi-Files mit beliebigen Namen in osm/poi/

® Darstellung eines Info-Fensters bei Maus nahe einem Poi sofern Info enthalten.

® Auswahlmenue "C" oder "Tools/Select Data/Show POI" zum Zeichen von einstellbaren
Symbolen eines oder mehrere Poi Files. "I'" (= kleines "L") schaltet Labels ein/aus. Dazu Text-
Filter im Namen oder Infofeld zum eingrenzen der Auswahl mit "*" und "?"

® Marker setzen mit Fangen der Position des nahen Poi mit "X" und "Y", ohne Fangen "x" "y".

24.7.2019 (Ver 0.77)

® Tagged srtm (wasser/wald/urban) und damit Gelaendeschnitt mit/ohne wald
® Message mit ziel "RAW" zum erzeugen einer handgekloeppelten nicht-standard Bake oder
"general query"

2.1.2020 (Ver 0.78)

® wetter grafik, gamma(Sievert) + PM10 PM2.5 PM1 PMO0.1 (ug/m3) feinstaub
® senden gamma + feinstaub aus csv-zeile mit baken-macro

h264 in mpeg4 Container: Linux: 1 mal machen: mknod map.y4m p

fuer jedes Video starten: x264 -o film.mp4 --muxer mp4 --crf 22 map.y4m
<Make Video>

win: File / Make Video gibt unkomprimiertes Videofile map.y4m

(.y4m sollten mplayer oder vlc abspielen koennen)

klein packen mit x264.exe "x264 -o film.mp4 --muxer mp4 --crf 22 map.y4m"
(crf=22..27 qualitaet gut bis sparsam)

vorher mit Animate und auf Map klicken passende Geschwindigkeit einstellen

files/dirs:
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aprsmap programm

aprsmap.cfg beispiel config, wenn nicht vorhanden werden default werte
erzeugt

hints.txt tipps beim verweilen mit der maus auf buttons

help.txt Hyperlink-Hilfetext unter Help > Helptext

gm.sh shell script zum osm karten holen

(geht nun auch mit der busybox am tinycore)
(darf/soll verbessert werden HI)

./gm.sh

symbols.png icons
font.png buchstaben
gettiles vom aprsmap erzeugte liste fehlender map tiles
rawlog timestamp+aprsis format wenn vorhanden beim start
eingelesen
bei connect zu aprs server kommts neue dazu
dargestellt werden die eingestellten minuten vom ende des
logs
mit connect zu server eingestellte minuten von jetzt
file darf editiert, beschnitten, gefiltert werden
wird nach timestamp sortiert eingelesen
(langes file einlesen geht mit serverconnect schneller
da erst ab "jetzt-darstellzeit" decodiert wird)
osm/tiles/ karten im osm format

osm/tiles sat/
osm/tiles topo/

udpflex axudp<->kiss/smack/flexkiss interface fuer TNC, TMx7xx ...
kisson.txt kiss initialisierung fuer TMD72 mit udpflex
getosm.exe Win: Schneller Maplader von OE5KRN
poi.txt globales/privates
mypoi.txt Points-0f-Interest-File mit aktiviertem "p" zum zeigen bei
Mauszeigernaehe oder Suchen mit "F"
oe5dxl|

<< Zurlck zur DXL-APRSmap Ubersicht
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APRSmap Release notes: Unterschied zwischen den Versionen

Versionsgeschichte interaktiv durchsuchen
VisuellWikitext

Aktuelle Version vom 9. August 2020, 18:
10 Uhr (Quelltext anzeigen)
OE2WAO (Diskussion | Beitrage)

Version vom 2. Dezember 2018, 17:26
Uhr (Quelltext anzeigen)
OE2WAO (Diskussion | Beitrage)

. . . K
< Zum vorherigen Versionsunterschied
(Eine dazwischenliegende Version desselben Benutzers wird nicht angezeigt)
Zeile 1.147: Zeile 1.147:
* Auswahlmenue "C" oder "Tools/Select * Auswahlmenue "C" oder "Tools/Select
Data/Show POI" zum Zeichen von Data/Show POI" zum Zeichen von
einstellbaren Symbolen eines oder einstellbaren Symbolen eines oder
mehrere Poi Files. "I" (= kleines "L") mehrere Poi Files. "I" (= kleines "L")
schaltet Labels ein/aus. Dazu Text-Filter im schaltet Labels ein/aus. Dazu Text-Filter im
Namen oder Infofeld zum eingrenzen der Namen oder Infofeld zum eingrenzen der
Auswahl mit "*" und "?" Auswahl mit "*" und "?"
* Marker setzen mit Fangen der Position * Marker setzen mit Fangen der Position
des nahen Poi mit "X" und "Y", ohne des nahen Poi mit "X" und "Y", ohne
Fangen IIXII Ilyll' Fangen IIXII Ilyll.
+
+

+ 24.7.2019 (Ver 0.77)

* Tagaed srtm (wasser/wald/urban)
+ und damit Gelaendeschnitt mit/ohne
wald

* Messadge mit ziel "RAW" zum
erzeuaen einer handaekloepnelten

+
nicht-standard Bake oder "general
queryll

+

+

+ 2.1.2020 (Ver 0.78)
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* wetter grafik, gamma(Sievert) +
+ PM10 PM2.5 PM1 PMO.1 (ug/m3)
feinstaub

* senden gamma + feinstaub aus csv-
zeile mit baken-macro

Aktuelle Version vom 9. August 2020, 18:10 Uhr

libpng und libz statisch dazu gelinkt
font symbol und OSM karten nun im png Format

4 Kursortasten zum Karteverschieben und Backspace fur letzte Position(en) (sofern die bei
allen x11 gleichen hexcode haben)

® (OSM Karten in Unterverzeichnissen nach Zoom Faktor 1..16 vorhandene maps léschen oder
einsortieren
wenn Files fehlen wird sofern vorhanden die mit dem nachste Zoomfaktor gedehnt eingesetzt
./Jgm.sh starten bzw anpassen nach Bedarf zum Kartenholen
linke Maus auf Karte klicken oder auf Track oder Symbol 6ffnet Menu, viele Funktionen mit
Klick erreichbar aber noch nicht alle MenUs, noch chaotisch aber mal zum Testen

® Wettergrafik + statistik auf x11 abrufbar

® ESC taste zum Menisschliessen

® Funktion der Klicks auf symbol/text/map/track getrennt konfigurierbar

® 5 watch calls (ohne wildcard) statt "follow car"

® Wwettersymbol etwas besser anklickbar (symbols.png) (alpha Kanal nach heller verschoben,
sollte mal nach 255 wenn alle Symbole daflr adaptiert)

® rechte Maustaste = BACKSPACE (back in zoom/pan-history) (bei www Version lokal back am
Browser)

® map move steps teil der Fenstergrosse

6.1.2013

® Marker auf "Next click to Map": ohne Einrasten auf Symbole "Next click to Symbol oder Text":
mit Einrasten auf genaue Position wenn vorhanden

® Marker l6schen und keycode "@"

® zoom to markers wieder da "Y"

® kmh Histogramm und Animation entsprechend der eingestellten Sichtbarkeitszeit des Tracks

® blaue popup Mendls sortiert nach der GroBe angereiht von links oben

® ‘"Expandes Tiles" geht auch weg wenn alle tiles 1:1

°

call in die watchlist mit click
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7.1.2013

Taste "@" umgewidmet auf "on click" Reset

Taste ":" 16scht beide Marker

30s langer Retry Mechanismus zum Tiles Laden, sobald "gettiles" geldscht, je Sekunde 1
Ladeversuch aller benétigten oder expandierter Tiles und was fehlt oder "png error" hat wird
erneut im "gettiles" angefordert.

7.1.2013

® Tasten "<" und ">" entsprechend "Debug Track" raw+decoded Text der Waypoints oder
Baken durchsteppen und setzt Marker 1

® Backspace history size 20 statt 10

10. 1. 2013

Tasten < > getauscht und Textinfo bleibt sichtbar

Click to WxSymbol neu und dort dann entweder 1 nicht-Wetter Messwert oder beliebig viele
Wetterwerte zugleich ein/aus schaltbar (Menu bleibt offen)

14. 1. 2013

Letzter Wettermesswert in der Kopfzeile der Wettergrafik
Wettergrafik passt sich der Fensterbreite an (ab 320 Breite)
Raw+Decoded Fenster bleibt trotz "Marker to Klick" Messdaten Fenster offen

16. 1. 2013

® Decodiert positionless WX Daten

® Decodiert negative NN im "/A="-Format

® Zoom to Markers geht auch bei Zoomlevel>14

® Fractional Map Zoom rechnet etwa 2x so schnell und richtiger

® Shift-Taste bei Map Move macht 1/10 Schrittweite

® Shift-Taste bei Zoom (derzeit nur mit Maus) macht 1/10 Zoom Schritte

20. 1. 2013

® Klick auf Track mit Raw+Decoded fir den Geklickten Wegpunkt

® Raw+Decoded mit Wegpunkt Nummer / Gesamtpunkte zur Orientierung wo man ist

® Cut + Paste Puffer wird mit angeklicktem Call gefullt

® Ppaste in Texteingabefelder

® |eider geht beides nicht nach aussen weil die Fenster heute mit "selections" miteinander
telefonieren und das ist etwa so aufwendig wie das gesamte Interface zum X11 bis jetzt

® (derzeit noch nicht ein/fausschaltbares) Textfenster mit Scrollbalken fur lange Texte. Zum
Test mit Rawdaten von tcp connect.

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice Seite 35 von 197



B I ue S p|Ce 4 APRSmap Release notes

® nach 4 Tagen Suche noch nicht gefunden wie man Kill des Fensters abfangen kann ohne dass
dabei alles abschmiert. Da auch die ganzen Xlib Aufrufe zum Text reinzeichnen keiner auf
Windoof/sontswas portieren wird, wirds wieder abgeschafft.

26.1. 2013

Textfenster mal wieder weg
rawlog File wird nun auch nach dem Einlesen geschlossen und wie bisher beim Schreiben fur
jede Zeile neu gedffnet

® Marker 1 zu klick misst, wenn genau 1 Objekt mit klick erfasst wird mit Einrasten auf dieses,
wenn "on next click set marker 2" immer ohne Einrasten

3.2.2013

(minimierbare) fixe Toolbar (die minimierte verdeckt noch manchmal Text Messages)
Popup Menls ausgemistet, z.B "Show All" nur wenns nicht schon ist

Von den neuen Kommandos aus der Toolbar gehen erst ein paar wirklich (WV Q S)
Messages, Listen, Config noch nicht

6.2.2013

® Fahrtrichtungspfeil + Windfahne bei Wx Symbol, 20kmh pro Strich beides als Teil vom
Symbol anklickbar und abschaltbar

10. 2. 2013

® Auswahl ob Toolbar oder Popup Fenster, damit beim Start normale Toolbar da ist. Muss noch
optimiert werden was in welchem Menu sein soll und was offen bleibt oder verschwindet.
Histogramme verdecken die Pulldown MenuUs aus der Toolbar

® Hohenangabe bei den Symbolen, noch nicht abschaltbar weil alle Symbol-Attribute ab einem
einstellbaren Wert (mindest meter, km/h) konfigurierbar erscheinen sollten.

13. 2. 2013

® Text Editor mit Scrollen fir Config und (wenn fertig) Messages, Parameter werden erst
einzelne ausgewertet
Screenshot mit Filename
rawlog einlesen mit Filenamen (Datum Eingabe noch nicht ausgewertet)

16. 2. 2013

® Watch Calls per Click suchen freien Platz in der Liste weil jetzt tastaturlos auch wieder
abschaltbar
Watch Calls mit * als Wildcard
Setzen der Start Map Position auf Bildmitte per Lokator, Long/Lat, oder mit "?" im Config und
dann Marker 1 setzen auf der Map

® cigene Position im Config auch mit "?" mit Marker 1 Gbertragbar.
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Config File Speichern/Laden beim Start verwenden und automatisch bei Quit Speichern
fehlt noch Auswerten einiger Config Parameter zb Helligkeiten und "next click to Wx"

15. 2. 2013

® Ausser Igate/Network und LogDatum Configs sollten alle gehen und gekoppelt sein mit den
Schiebereglern. Manche Werte, die beim teilweise eingegeben sein Unfug machen, werden
erst bei "Save" "Reload" oder Start ausgewertet

28.2.2013

+ Bei Click auf Pixel das zu mehr als 1 Objekt gehoert, werden die gefundenen Objekte

bei jedem weiteren Click der Reihe nach an die 1. Stelle cykliert

+ Logfile Import mit Datum + ganze Stunde

+ Netbeacon aus Configparametern damit per Modem empfangenes ein Symbol fuer MH hat

(noch nicht per tcp gesendet)

3.3.2013
+ Objekte Loeschen

+ Filtern von Call, Igate, Objekt/Iltem-Absender (erst mal ohne Wildcards)

7.3.2013

+ transparente Menues oder schwarzer oder grauer Hintergrund

(Config Transparency 2..100, 1, 0)

+ Config Baken Symbol mit Auswahimenu ("My Symbol" clicken)

+ Objekt loeschen mit DEL-Taste

17.4.2013

+ Nach wochenlangem Kampf mit den Windoof Compilern ist nun etwa Gleichstand bei der

Win32 Version und es kann wieder am gemeinsamen Teil weiter gebaut werden.
Die innere Struktur ist etwas umgekrempelt zwecks minimiertem
systemabhaengigen

Teil. Leider hat sich die "Tile" Filestruktur (mit schnell mal 3500 Files in
einem

Verzeichnis) am Win als Bremse erwiesen und daher ist noch eine
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Unterverzeichnis-

Ebene dazu gekommen und die Struktur nun gleich wie auf den Servern und
"Marble".

Zum Konvertieren der vorhandenen Maps ist das "rentile" script dabei das man

noch anpassen muss und mit der Kommandozeile, die drin angegeben ist,
Aufrufen.

Es wird nix geloescht nur kopiert. "gm.sh" ist auch darauf angepasst.

+ Neu sind nur ein paar Filter im Config und fuer Besitzer eines Mausrades damit Zoomen

und Pull der Map mit der mittleren Maustaste. Fuer Touchpad-geschaedigte
muss man sich

noch eine Alternative mit Shift/Alt oder Klick auf die leere Map ausdenken.
Screenshot geht nun auch als "bmp" wenns File .bmp heisst.

17.4.2013
+ Pull Map auch mit linker Maustaste auf leere Map (configurierbar ?)
+ Shift + Click to Map: Set Marker 1 (configurierbare andere kommandos ?)

+ On next Click to Wxsymbol: Raw+Decoded zu den Wettergrafiken dazu einschaltbar

20. 4. 2013

+ tcp Connect zum Server mit neuer Syntax, -g <ip>:<port>[#<filter>] -g 44.143.100.1:
14580#m/300

MYCALL und PASSWORT jetzt schon aus dem Config statt -s -p

+ Netzbake: "File" > "Config" -> Mycall, MyPos, Net Beacontext, My Symbol,

Netbeacontime mit Enable, PassCode mit Enable
My Symbol Anklicken fuer Auswahl
My Position "?" an 1. Stelle und dann Marker 1 Setzen

29. 4. 2013

+ tcp Connect nun probisorisch im File>Config, wenn man editiert gruen ausschalten und wenn

fertig wieder ein.

+ auf Wunsch Massstab auf der Karte (noch nicht schaltbar) und auch problematisch wegen

nicht entfernungstreuer Merkator Karten bei kleinem Zoom
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4.5.2013

+ Vorschlag von dI8rdl eingebaut, Maps Download im Hintergrund komplett fuer das sichtbare

Fenster von Zoom 1 bis einstellbarem maximalen Zoom mit Vorkalkulation der
Datenmenge,
abbrechen, weitertun, und Fortschrittsanzeige.

+ Messages empfangen (derzeit erst von tcp)

6.5.2013

+ "DAO"-Erweiterung in Frame-Decoder eingebaut zum Position auf etwa 20cm genau
uebertragen

und auch genauere Auswertung vom GPS-raw-Format und Anpassung der Rundung
auf Feldmitte
(leider ist die fliesskomma Genauigkeit nur etwa 1-2m)

8.5.2013
+ Mehr Status Meldungen von "on/off" Schaltern und (Shortcut) Funktionen

+ <Make Video> legt "map.y4m" auch auf Linux neu an wenn nicht (zB. als named-pipe)
vorhanden,

meldet Schreibvorgang, refresht alle 1s den Bildschirm und ist abbrechbar.

+ Buttons mit noch nicht implementierter Funktion melden das.

+ Im Screenshot Filenamen wird "%t" durch Datum-Uhrzeit und %n durch "000" bis "999"

ersetzt bis der Filename neu ist.

+ Shortcut Tasten Liste im <Help>

10. 5. 2013

+ 4 direkt waehlbare Map Positionen + Zooms im Zoom-Menue oder per "1..4" Tasten.

Dabei kann entweder der Zoomlevel oder die Position oder beides abgerufen
werden.

Der Eintrag dieser "Views" kann manuell im File>Config>View durch
"Zoomfaktor Position"

(wobei Position auch ein QTH-Lokator sein kann), oder eines von beiden, oder
viel

schneller durch "Shift" + Click auf einen der 3 "Views" im Zoom Menue
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erfolgen.
Dabei wird die aktuelle Karten-Position mit Zoom gespeichert.
Shortcuts anders: "1" (one user) nun "."
II2II +rf nun II=II
"On next click" neu einstellen erforderlich

12.5. 2013

+ Tooltipps mit Text aus externem File "hints.txt" und schon etlichen Texten drin.

Darf natuerlich verbessert oder uebersetzt werden wobei das Ergebnis der
Arbeit

sofort aktiv ist sobald das hints.txt gespeichert ist.

|Buttonnummer Text

die fehlenden Texte werden als "<Buttonnummer> hint text" gezeigt

die Struktur des File>Config wird noch umgebaut daher mit den hints dafuer
abwarten

15. 5. 2013

+ "Zitter"-Toleranz fuer Mausposition innerhalb der die Hints sichtbar bleiben + Zeigt aktuelle
"Mbytes written" des Video Files + List>Internals zeigt System Zustand + "L" Shortcut nun
"toggle Labels on/off" Labels=Text bei den Symbolen + Fine Zoom Steps im Config

17.5.2013

+ "L" und "O" bzw "Labels off" "Objects off" wird nun nimmer in Form von 0% Helligkeit

im Config verewigt

+ In Vorbereitung auf ein Text-Fenster kommt nun mal List>Messages und List>Bulletins

auf das Start Terminal Fenster raus, wobei die Bulletins noch nach
Absender/Eintreffzeit sortiert sind und nicht nach der BLN<nummer>

+ Angeklickte Objekte kann man in Infos>List Raw oder Infos>+Decoded auf das Textfenster

auflisten lassen (ohne farbige Fehlermeldungen)

18. 5. 2013

+ Config>Show Incoming "n" Zeigt TCP-Frames auf dem Textfenster, "n+" Dekodiert

fuer die Radio Ports entsprechend 1 2 3 ... und 1+ 2+ ... Dekodiert
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21.5.2013

+ Raw+Decoded Sprechblase aktualisiert sich mit ankommenden Daten falls sie den letzten

Wegpunkt anzeigt

+ Delete Waypoint, wenn mit Debug oder Raw+Decoded markiert. Mit DEL-Taste zum entfernen

von (falschen) Wegpunkten. Marker 1 springt dann zum naechsten
(vermutlichen) Fehler weiter.
(Wann alles loeschen oder nur Waypoint muss noch besser definiertbar sein)

+ Hoehe wird auch bei Symbolen ohne km/h Daten angezeigt falls Hoehendaten vorhanden und

eingeschaltet.

23.5.2013

+ UDP-Port im Config (erst mal 1 Stueck) + Fenstergroesse veraendern schneller + Trackfilter
Fehlererkennung verbessert + Bei Debug Funktionen Verzoegerungszeit von doppelten
Waypoints in Sekunden sichtbar

29.5. 2013

+ Zwecks schnellem Tracks Debuggen mit "E" oder File>Infos>Waypoints-Button toggelt

alle, oder nur die als verdaechtig markierte Waypoints anzeigen mit den "<""
>" Tasten
oder den Buttons daneben.

+ rawlog mit lesbarem Datum/Zeitstempel, das alte Format wird lesend auch akzeptiert.

+ axudp-kiss (usb)seriell Interface (udpflex) erweitert, sodass nebst an/abstecken von

usb-Seriellen auch ein resetteter TNC2 an empfangenen (nun nicht mehr kiss)
Daten

erkannt und wieder auf kiss geschaltet wird. Geht mit init File auch fuer
andere TNC

wie in THD7x oder TMD7x.

udpflex (linux), udpflex.exe (win32)

8.6.2013
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+ Configurierbare default Speed fuer Animation + Parkplatzzittern-Erkennung fuer Animation
Startzeit verbessert + Source Code Entruempelung zum einfacheren Compilieren fuer
verschiedene Prozessoren

15. 6. 2013

+ km/h und/oder Hoehe in Animation und Video wobei Lesbarkeit bei schneller Aenderung

noch verbessert werden kann.

+ Uhrzeit beim Log schreiben laeuft nun auch waehrend Animation in Echtzeit. + +-24h
Zeitversatz Systemzeit/angezeigte Zeit einstellbar

5.7.2013

+ Objekte mit extra "keep in memory time" zB um den schon nach 5 bis 6h recycelten

Blitz-0Object-Namen keinen Track erzeugen zu lassen.

+ Logfile browsen geht gleichzeitig mit online Betrieb. Dazu wurde eine zweite

Uhrzeit geschaffen die den Logdaten folgt und die Echtzeit Daten werden
unabhaengig

von den Logdaten (wie sonst auch) im RAM und writelog gepspeichert.

Es kann jederzeit zwischen Log und Echtzeit gschalten werden und in den
Logdaten

an Anfang, Ende, und in "Fullbright" Zeitspruengen vor und zurueck gegangen
werden

womit immer alle Daten einmal sichtbar sind.

+ Status Bar zeigt Betriebszustand, erst mal experimentell zum sehen was man braucht

mit Buchstaben bis Symbole entworfen sind. Bei TCP (Internet) und und UDP
(Funk)

wandert die Farbe von gruen nach rot binnen 1 Min. solang keine Daten
ankommen.

Message soll mal anstatt dem Popup Fenster vorhandene Messages anzeigen und
erst bei

draufklicken Inhalt zeigen.

16. 7. 2013

+ Hoehen Diagramm ueber Wegstrecke, mit Trackfiler on "F" wird versucht die manchmal

ungenaue Hoehenmessung etwas glatt zu buegeln.
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+ Beim Track anklicken wird der Wegpunkt ausgewaehlt der der Klickpunkt am naechten

liegt.

+ Popup Meldungen, die Befehle bestaetigen, werden nach ein paar Sekunden wieder

entfernt. Da, um CPU Zeit zu sparen, der Bildschirm nur aktualisiert wird
wenn neue
Daten kommn, geschieht das Loeschen nur im Zuge einem Updates.

19. 7. 2013

+ "On Next Click To Track" mit Speed oder Altitude aktiviert, setzt eine Marke auf

dem Diagramm, die der angeklicken Stelle am Track entspricht.

+ "On Next Click To Track" kann mit 1 Click Wegpunkt loeschen aktivert werden.

+ Ein angewaehltes Objekt kann mit "Save" als Logfile mit dem Filenamen des Objekts

gespeichert werden (derzeit nur im Startverzeichnis). Existiert das File,
wird

hinten dran geschrieben. Es werden alle Daten aus dem RAM geschrieben auch
wenn

mit Trackfilter oder Fullbright Time ausgeblendet.

Manuell geloeschte Baken/Wegpunkte sind weg.

22.7.2013

+ Video/Animation Speed Einstellbereich erweitert von 1:1 (Echtzeit) bis 200s/Frame

womit die Speed-Zahl statt (Echt-)Sekunden zu Frames jetzt multiplikator fuer
Echtzeit ist.

+ Start Delay fuer beschleunigte Darstellung (wenn sich nichts bewegt) einstellbar

+ Log Import fuer ein Call wobei immer auf eine Zeitspanne gesucht wird in der das

Call aktiv war (keine wildcards)

25.7.2013

+ "On Next Click" mit mehreren Optionen gleichzeitig (wo es Sinn macht).
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9. 8. 2013

+ Durch erweitern der Menue-Darstellung auf Tabellen mit Farben und verbessern des

Zeilen-Editors (Maus kann Cursor setzen ...) ist Messages erstellen und
verwalten

moeglich geworden. Empfangene Messages sind noch ohne Tabelle.

2.9.2013

+ Nach komplettem Umbau des Konfigurations-Tools mit dynamischer Anzahl der

Eintraege geht nun Messages senden, mehrere Aprs-Server-urls die abgeklappert
werden bis einer antwortet, beliebig viele Watchcalls, Filtereintraege,
Baken. ..

Der Texteditor kann Insert/Overtype und Cursor setzen mit der Maus.

Mit Shift-Linksklick auf die Karte wird die Position in die Editorzeile
kopiert (jetzt einfach wiederholbar bis man "getroffen" hat)

(Die eigene Position und die Zoom>"Views" muessen neu eingegeben werden)

+ Die aktuelle Fenstergroesse wird im Konfigfile mit gespeichert.

"View 1" wird beim Programmstart dargestellt.
(speichern der aktuellen Ansicht mit Shift-Linksklick im Zoom-Menue)

+ Nach der Frage "was brauch ich alles um online zu gehn" ist dies nun in

einem Menue. Dabei kann man abgestuft von ganz ohne Call bis Call und eigene
Position nur dem Server sagen (zwecks funktionieren der m/... Filter) bis
Bake und Messages ins Netz senden konfigurieren.

+ lgate-Funktion ist nur in der Linux Version vorhanden da das Win-tcp-System

keine Info ueber bestaetigte Daten hat und dann einen als "haengend"
erkannten

Link nicht terminieren kann, ohne die veralteten Daten noch rauszuweinen.
Das waere im aktuellen AprsIs-Netz ohne Timestamps nicht mehr akzeptabel.
Auch die Linux Igate-Funktion sollte auf keinen Fall fuer einen Digi
verwendet

werden da zB. beim Logfiles durchsuchen die Durchlaufzeit erheblich werden
kann.

Fuer Igate gibts ohnhin ein eigenes Tool.

+ UDP-Ports fuer Funk rx/tx mit Soundmodem oder mittels "udpflex" (USB)seriellen
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TNC gibts derzeit 4. Eine dynamische Anzahl braucht noch Aufwand bei den
Schaltknépfen in den Menues.

Der Funk-Baken/Objekt/Items-Editor ist noch in Entwicklung, dort dann auch
wieder die verschwundene "Rfbeacomtime" fuer jede Bake extra.
(bis da hin 1 Bake manuell ins aprsmap.cfg)

4.9.2013

+ Baken senden mit Macros fuer Uhrzeit und File einfuegen (Wetterbake). Jede Bake

mit Port und Intervall Angabe und Zielport geht auch Net. Mit Beacons Shift
Time

wird die Startzeit jeder weiteren Bake so verschoben, dass sie nicht
innerhalb der

"dupe delete" zeit (meinst 57s) der Igates landen.

Syntax: intervall(s):port:rawformat 600:1:NOCALL>CQ:>test

\\z tag+zeit, \\h zeit, \\:filename:, \\\ \\

8.9.2013

+ Maus Hint Texte verbessert und deren Erscheinen an der Status Bar. + User Infos erweitert,
gefahrene km, Zaehler fuer Baken, Messages, Acks, Rejects

9.9.2013

+ "Show Objects of Sender" zeigt alle (anderen) Objekte und Items von dem Absender

des Ausgewaehlten Objekts auf einer dafuer gezoomten Karte unter
"Info>0bjects of.."

+ Shift-Click auf die Status-Bar (die bunten Laempchen) oeffnet direkt das zugehoerige

Config-Menue soweit Sinnvoll.

11.9. 2013

+ Menue Positionierung korrigiert und Menues nimmer schliessen bei Shift-Click

auf Map zum Position in Editor Zeile kopieren

13.9. 2013
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+ Statusbar Netzwerk-Buttons Mouse-Over wenn nicht online normale Hints,

wenn online, Status Info. X/N zeigt offline/online (sollten mal Symbole
werden)

+ "w" Temperatur-Karte wie bisher, "W" (w mit Shift) Regen-Karte mit blau fuer

24h und rot fuer aktuellen Regen (noch ohne Fehlerfilter, luegende Stationen
anklicken und mit DEL entsorgen).

16. 9. 2013

+ Logfile lesen mitn Binaersuche fuer den Anfang ab wo ins RAM eingelesen wird

mit dem Vorteil, dass auch lange Logs beim Programmstart und Log Import
schnell

nach Datum durchsucht sind, aber das Logfile muss nach Datum sortiert sein.
Derzeit max 4GB Logfile.

19. 9. 2013

+ Message (Query) Kommandowoerter + Antworten in Config > Rf-Ports.

Standard Querys (?APRSP) als auch beliebige Woerter koennen definiert
werden und in der Antwort Macros wie \\h Uhrzeit, \\p Path, \\1l Position,
\\v Programm Version, \\<filename> File senden, \\>filename> schreiben,
letzteres zum aktivieren von einem Programm zum was Steuern oder
Sprachausgabe

"TALK:\\>/tmp/talk.txt>Text um \\h Gesprochen!"

"?HELP:?APRSP, ?VER, TALK"

22.9. 2013

+ Windfahne und Temperatur beim Symbol mit Timeout. + 1 Kommastelle mehr bei Koordinaten-
Ausgabe und bei Maus-Koordinaten

Grad/Minuten/Sekunden-Schreibweise zuaetzlich.

+ Win32: bei der (oder mehr) Start-Fenstergroesse die der Bildschirm kann,

"Maximized" Fenster.

7.10. 2013
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+ Filesystem auf "Longfiles" umgestellt damit sollte Logfile >2GB geschrieben

und dank Binaersuche auch flott importiert werden koennen.

+ Programm Starter fuer Maps-Downloader bei Bedarf (gm.sh bzw gm.bat)

der kann sich nach getaner Arbeit beenden. Status in der Status-Bar
mit "D" statt "E" fuer Downloader laeuft erkennbar.

+ Beliebige Map-Typen configurierbar mit korrektur der Basis-Helligkeit,

die ersten 3 wie gewohnt mit Shortcut "7" "8" "9", die 1. beim Start aktiv.
Sat-Maps erst wenn ein JPEG-Dekoder vorhanden ist (ausser man wandelt
sie beim Download in PNG). Neu (voreingestellt): cyclemap

11. 10. 2013

+ Wegstrecken Summe (ohne Track) auf der Map (shift-click, click, click...) + Log Import (bis auf
Suche rueckwaerts nach Call) bei unsortiertem File

versucht etwas zu verbessern

13.10. 2013

+ Schriftgroesse einstellbar (Config > Map Paramter > Font Size)

15. 10. 2013

+ Screenshot auch als ".png" (vorerst nur Linux Version)

und osm-Verzeichnispfad wieder configurierbar

+ "On next click to Track" bei mehrfacher Auswahl mit "Zoom to" wird erst gezoomt

und dann im 1 Track Mode die anderen Funktionen aktiv.

31.10. 2013

+ Beep-Sounds mit beliebiger Frequenz und Dauer wenn Message oder Ack eintrifft,

wenn sich wer in den Warnradius bewegt mit steigender Frequenz und/oder Dauer
je naeher er zum Zentrum kommt und wenn ein Call aus der Watch Liste aktiv
wird.
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Alle getrennt schaltbar und limitiert auf maximal alle 5s.

Windoof 7 oder 8 geschaedigte koennten evtl. keinen Piepser haben dann gibts
als

Ersatz 3 System-Sounds (mit Oms einschalten, bis 500, bis 1000, ab 1000Hz
jeweils ein anderer Gong).

Config > Map Moving > Bell/Sound

6. 11. 2013

+ In Animation und gedimmten nicht-movern wird die schrift der "mover" im

nun Vordergrund gehalten

+ Einfaches Hyperlink Hilfetext System mit File "help.txt" unter "Help"

erreichbar mit ein bisschen Text als Beispiel

18. 11. 2013

+ Einstellbarer Timer zum Verzoegern vom Mapdownload Start waehrend Karte

verschieben, wer so vermeiden will, dass in hohem Zoom der Streifen an Karten
entlang der Bewegung durch die Botanik geladen wird. Config / Timers

+ Index Taste im Help Fenster

+ Schutz vor ewig loopenden Mapdownloads wenn durch zB volle Platte oder nicht

identischem Schreib/Lese-Pfad immer die gleichen Karten angefordert werden.
Kommt ein Kartenteil immer wieder, wird nach ein paar Versuchen 1. nur mehr
1 Karte angefordert, 2. die Pause zwischen Anforderungen immer Verdoppelt
und 3. poppt eine Fehlermeldung auf.

+ Copy/Paste hinein ins Program (rechte Maustaste im Textfeld oder ctrl-v)

(bei linux jetzt mit dem aktuellen "keiner verstehts..." selection-
Verfahren)

22.11. 2013

+ "Ok" im config-Zeileneditor schliesst das Fenster nach dem Speichern. + Map download Timing
(im Fehlerfall) optimiert, dass mit dem in entwicklung

befindlichen hochgeschwindigkeits-Downloader von oe5krn bei falscher
Einstellung oder voller Platte keine "Gigabyte" ins Nirvana geladen werden.
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28.11. 2013
+ "B" und "M" (gross) fuer Bakeneditor und Message senden
+ Index bei Helptext

+ Umfangreicher Baken/Objekt/Item Editor mit verschiebbarem Fenster,

Import von vorhandenen Objekten auf der Karte durch anklicken.

Testen lokal vorm Senden.

Einmal senden oder mit Timer und Verschiebung der Sendezeiten, dass die
Duplikatloeschung in den Igates Sendungen mit gleichen Inhalt aber
verschiedener Frequenz (oder direkt per tcp) im Netz sichtbar laesst.

Einfaches Fernloeschen von Items und Objects.

Normal/Mic-E/Compressed mit DAO Erweiterung fuer 20cm Genauigkeit

(die aber je nach Fliesskommaarithmetik nur etwa 1lm schafft)

mit Bytezaehler der Gesamtlaenge beim editieren der Kommentarzeile zum
optimieren der Kompressionsart.

Macros zum Einfuegen von Files zB fuer Wetterbake

+ Query standard Antworten (?APRST ...) vorkonfiguriert mit opt-out wers

nicht will. Config > Rf Ports > Query Keywords

+ Fehler behoben, Decodieren von Items mit kurzem Label.

Unsichtbare User wegen keinem oder falschem Symbol (die aber trotzdem
watch/approxy-piepsen) haben nun Label und Track

+ Listings im "Show 1 Modus" zeigen nun nur was zu dem User gehoert

4.12. 2013

+ Config > Rf-Ports > Monitor Headline

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice Seite 49 von 197



B | ue S p|Ce 4 APRSmap Release notes

Damit kann man 0 bis 20 Calls + Tempertur oder km/h als "Ticker"

von aktuellen Frames auf der Fenster-Ueberschrift durchlaufen lassen.
Bei minimiertem Fenster ist das aktuellste Call in der Taskleiste.

N> kommt von, N< get ans Netz, 1> 2> Funkports, N- heisst der Frame
ist entweder in den Callfiltern oder ohne verwertbarem Inhalt.

+ (grosses) "F" Shortcut Find (Call, Locator, Breite/Laenge)

+ Bakeneditor "Draw" schreibt nimmer ins rawlog

10. 12. 2013

+ Calls + Temp,km/h,Hoehe der ankommenden und abgehenden Daten in der

Fenster-Kopfzeile. Anzahl der Calls Config>Rf-Ports>Monitor Headline.
Updaterate auf (Mittelwert) 1s limitiert.

+ Maus-Verhalten umgestellt (aehnlich anderen Programmen).

Linksklick wartet auf Maus-Bewegung (mit ein bisschen Zitter Toleranz)
und zieht Karte (auch wenn ein Symbol getroffen) oder, am oberen Rand
angefasst, konnen einige Menues und die Status-Bar positioniert werden
mit "ankleben" an den Fensterrand und gespeichert in aprsmap.cfg.

Beim auslassen der Maustaste, wenn nicht bewegt, wird der normale Klick
ausgeloest.

Mittlere Maustaste zieht alles was ziehbar ist und an beliebiger Stelle
angefasst.

Rechte Maustaste wie bisher Back-in-zoom-History oder in einer
Texteingabe "Paste" (falls was im copy/paste Puffer ist)

15.12. 2013

+ Message Senden nun bis 67 Zeichen wie im Protokoll vorgesehen statt 57. + Umlautwandler
auf "Ae Oe Ue ss" (bis mal ein 8 Bit Zeichensatz definiert ist). + Message Eingabezeile geleert
wenn die vorherige Message abgeschickt wurde oder

an ein anderes Call als zuvor gesendet werden soll.

+ Schnelles Zoomen mit Shift-Linksklick und Rahmen um den gewuenschten Inhalt

aufziehen.
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+ (nur Linux) jpeg-Dekoder fuer Maps wobei erst .png versucht wird dann

jpeg in .png Filenamen und zuletzt jpeg als .jpg (gm.sh modifizieren).

16. 1. 2014

+ Config / Online / Serverfilter Aenderungen werden bei "Ok" sofort zum

Server geschickt. (sofern der die "# filter ..." Syntax versteht)

+ mit "<" ">" durch einen Track wandern geht mit gleichzeitig geoeffneter

Altitude- und Speed-Statistik und zeigt dort die Stelle am Track und die
Messwerte numerisch.

+ Tools / List neu mit verschieb- maximier-, ikonisierbarem Textfenster

mit Scrollbalken (und Cursortasten und Mausrad) und nach Zeit und
alfabetisch sortierbarem Inhalt.

Es kann Rohdaten und dekodiert listen. Text kann man markieren und mit
"Paste" in andere Anwendungen kopieren (auch auf Win ohne umstaendlichen
Dialog). Gibt man in Tools / Find ("F"-Taste) ein Wort ein, werden alle
gleichnamigen Stellen farblich hervorgehoben zB. "APLMO1" oder ein Call.

Klickt man auf eine Zeile, wird auf der Landkarte die Herkunft gezeigt,
sofern die Zeile eine Position enthaelt und wenn nicht, die letzte
bekannte Position vom Absender der Zeile.

Das Live-Monitor-Fenster fuer empfangene und gesendete Daten hat anstatt
sortieren "Clr" fuer Inhalt loeschen, es stoppt raufscrollen wenn man
mindesten 1 Zeile herunter geschoben hat, und kann mit "u"-Taste an und aus
geschaltet werden. (Beachten: bei Batteriebetrieb durch den laufenden
Bild-Update evtl mehr CPU/Akkuverbrauch)

Das Aktivieren des Monitors ist, bis eine selbsterklaerende Menue-Struktur
erfunden ist, noch wie zuvor unter Config / Rf-Ports / Monitor Frames.

+ Linux: F11-Taste (bei "seltsamen" Fenstermachern die selber kein Maximieren

oder dann wieder kleiner machen koennen) toggelt Fullscreen/Normal.

+ Win: Kein extra Textfenster mehr da Listings eingebaut.

20. 1. 2014 (Ver 0.32)
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+ Funkport (Soundmodem / udpflex) Kommandozeile in Config / Rf Ports /

Serial Interface
Task wird automatisch gestartet.

+ Monitor Ports off/raw/decoded einzeln mit Klick schaltbar Tools/List/Monitor.

3.2.2014 (Ver 0.32)

+ Message Rx: Schalter fuer Pop-up Fenster

Schalter fuer zeigen von Messages an andere SSID
Schalter fuer Messages an sich selber weg filtern (default on)

6. 6. 2014 (Ver 0.34-testversion)

+ Hohendaten (soweit in einem Datenfile vorhanden)

bei "show Location of Mouse" "on" werden m ueber NN angezeigt
ebenfalls neu, Distanz und Winkel zum Marker 1 wird angezeigt

Files zum selber besorgen:

osm/srtm3/N48E012.hgt
N48EO13.hgt

(90m aufloesung, 1x1 grad 2.8MByte pro File
http://dds.cr.usgs.gov/srtm/version2 1/SRTM3/Eurasia/)

osm/srtm30/WO20N90.DEM
(900m aufloesung, 20W..20E, 40 bis 90N 57Byte, deckt den Rest ab
http://dds.cr.usgs.gov/srtm/version2 1/SRTM30/)

osm/eudem/ (noch nicht implementiert)
30m Aufloesung, 640MByte fuer 5x5 grad, braucht aber erst
konvertierprogramm
vom (unbrauchbaren) "eu-geotiff" in lesbares Format
http://www.eea.europa.eu/data-and-maps/data/eu-dem#eeaEsriMap

+ Radiolink Berechnung zwischen Marker 1 und 2 nach Eingabe von Antennenhoehen
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und Wellenlaenge. Vorerst mal Darstellung auf der Map als farbige Fresnelzone
"blau" frei, "gelb" bis "rot" von angekratzter 1. Fresnelzone bis voll
verdeckt.

+ Radiolink mit 2 Klicks oder fuer tastaturlose Bedienung

"On next click to Map" mit "Set Marker 1" beim 1. Klick und Marker 2 bei
weiteren
Klicks nach "Clear Markers" wird wieder erst Marker 1 gesetzt.

+ "d" Shortcut fuer Map downlod on/off

+ Map download auch wenn auf "off" wenn "Reload" oder die Download funktion

betaetigt wird.

+ Testweise "High Resolution Track" Dekodierung als Protokollerweiterung eingebaut.

Dabei werden mit einer Bake 2 bis 30 Positionen gepackt als Abweichung von
einer

Geraden 2 oder 3 dimensional + Timestamp uebertragen. Wird die Erweiterung
nicht

erkannt bleibt die normale Position pro Bake.

Die Optionen sind erweiterbar, Positionsaufloesung, End-zu-End Pruefsumme,
"QRV"-Frequenz, direktgehoert von Igate, Climb-Rate und fuer Wanderer hoehere
Geschwindigkeitsaufloesung sind mal vorgesehen. Traegt sich der
direkthoerende

Igate ein, wird vom AprsIs-Service eine veraenderte Kommentarzeile erkannt
und

damit ALLE Igates ersichtlich, die direkt gehoert haben und nicht nur der mit

der schnellsten Glasfaser Anbindung. Dekodiert wird dabei eine in vom
Empfangsmodem

in Klartext umgesetzte Darstellung fuer AprsIs. Am Funkweg wird binaer und
wesentlich

kleiner gepackt lbertragen.

13. 6. 2014 (Ver 0.35-testversion)

® osm/srtm1/N48E012.hgt mit 30m horizontaler Auflésung aus den EU-DEM Daten
umformatiert in das srtm1-Format wird bevorzugt verwendet.
UDP-Ports restarten sich wenn beim Editieren was verandert wurde.
Map Loader startet beim enabeln ohne nochmal herumzoomen.
Speed/Altitude/Gelaendeschnitt-Diagramm updatet sich mit ankommenden Daten wenn mit
letztem Wegpunkt oder Symbol anklicken geoéffnet.
Igate (Rf to Net, nur Linux) jeder UDP Port kann einzeln freigeschaltet werden
Gelandeschnitt, Darstellungs-Versuch mit zusatzlichem Freiraum-Diagramm auf der
Landkarte. Praktisch zum Zoomen aber evtl. missverstandlich da nur die Fresnel-Zone zur
Karte passt und folglich die Punktreihe, die die Bodenhdhe darstellen soll, nicht.
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17. 6. 2014 (Ver 0.35-testversion)

® Sichtweiten Farbkarte, mit Marker 1 oder 2 oder beiden gesetzt, wird mit "R"-Taste die
optische Sichtweite dargestellt. Antennenhoehen am Marker ist 1. Wert in "Tools/Radiolink"
am andern Ende gilt Wert 2. Die Wellenlaenge wird hier auf 0 gesetzt und damit ist ab halber
Fresnelzone "Sicht". Farbhelligkeit in "Config/Map Parameter/Brightness Rfpath" Die
Berechnung ist noch experimentell und sollte nach optimierung deutlich schneller werden
und damit man die Landkarte noch lesen kann brauchts noch Darstellungs-ideen.

28. 6. 2014 (Ver 0.37-testversion)

® Marker setzen mit Einrasten auf die genaue Position eines angeklicktes Objekts (More Infos>
) und ohne Einrasten im Zoom Menue. Dort auch Marker einzeln I6schbar. Marker 1 als "hart
(gelb)" oder "weich (blau)", letzerer entsteht durch einfaches Anklicken, bewegt sich mit
fahrenden Objekten bzw. huepft auf neu angeklickte Objekte oder Wegpunke und hat ein
Timeout. Harter Marker bleibt bis I6schen.

® Netz/Funkport Status-Laempchen zeigen nun letzte Sendung (gelb) und letzten Empfang
(griin) seit 60s als Sanduhr.

® Mausrad (oder Zoom-Menue +/- mit Shift) Zoom Stufen (Config/Map Moveing/Fine Zoom
Steps) rastern nun die automatischen Zoomvorgaenge auf die eingestellten Werte
insbesondere auf "1" also original Osm-Stufen.

® Ausgeschaltete Tracks (Helligkeit auf 0) machen nun auch Funkwege und Zoom auf das was
man noch sieht.

1.7.2014 (Ver 0.38-testversion)

® Watchliste neu mit Schalter fuer Pieps / Landkarte mitbewegen / Logfile zB. mit OE*
getrennte Lodfiles fuer jedes Call mit OE vorn schreiben.
Shift-Click auf Rf-Port-Knopf geht direkt in Config-Editor.

Portname nach dem Port-URL zeigt in "i"-Liste und beim "Hovern" auf den aktiven Portknopf
Namen und ip Nummer.

® On Next Click to Track mit "Zoom to" schaltet erst in den 1 User Modus und tut dann (nun
hoffentlich) die anderen aktivierten Dinge.

3.7.2014 (Ver 0.38-testversion)

® Baken sollten sichn nun auch mit den "\\" Macros wieder in den Editor laden lassen ohne dass
diese expandiert werden. (Vorhandene Objekt-Baken neu eingeben)

® Message Routing verbessert mit automatischer "NOGATE"-Option wenn nur Funkports
verwendet werden

® Message und Baken Sende-Meldung und Rueckfrage wenn man (meist versehentlich)
Leerzeilen Msg senden will.

4.7.2014 (Ver 0.38-testversion)

® Logfile loeschen bzw. Filegroesse anzeigen
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® Etwas mehr "On Next Click"-Optionen kombinierbar

8. 7. 2014 (Ver 0.39-testversion)

WX grafik zeigen auch wenn WX Baken ohne WX Daten dabei sind
Schalter fuer nur WX-Stationen auf der Karte zeigen

17. 7. 2014 (Ver 0.40-testversion)

Nur WX Stationen auf der Karte Zeigen
Relief Karten rechnen mit Fortschrittsanzeige und nach 4s Abfrage auf Abbruch (mit srtm(1)
Files (Netzwerk-Laufwerk zu langsam) und noch ohne Antialiasing was ab zoom 12 sichtbar
wird) map parameter/brightness rfpath zB. "30 100 50 100 80 20 0 100 100" (der 3. Wert 0
fuer harten Kontrast/Funkreichweite oder 500 fir aufpeppen von osm-Karten) tools/radiolink
"2000 0 0 200" marker 1 und evtl marker 2 setzen und "R" "config/brightness map" zum ein
/ausblenden der osm karte)

® Digipeater (abgespeckte udpbox derzeit noch ohne klicker-Editor und nur grob getestet)
Config/Rf-Ports/Digipeater, derweil Internes Format mit Zeileneditor bearbeiten.

® Message Sendetaetigkeit-popup-Meldungen verfeinert und korrigiert

18. 7. 2014 (Ver 0.40-testversion)

® der Logfile-Pfad fuer das rawlog wird auch fuer die Watchcall-Logs verwendet

19. 7. 2014 (Ver 0.40-testversion)

® Watchcall-Liste nach "longest-match" durchsuchen. "OEOAAA" passt bei * OE* OE0* OEQB*
auf OEO* OE* +log / OE1X +log / OE1* nichts / OE5A +beep schreibt log von oe ausser oel
und oe5a aber schon oelx und peept bei OE5A

® Call-Log FilegroRe anzeigen und Files l6schen

20. 7. 2014 (Ver 0.40-testversion)

Cursor Up/Down Tasten in mehrzeiligen Textmenues
Tasten Fokus Lock auf Eingabefeld nach Anklicken oder Tastatureingabe
1. Klick auf eine Zeile verandert nicht die Kursorposition

25.7.2014 (Ver 0.41-testversion)

Digipeater, mit fein dosierbaren Standard (mach QRG voll) bis "sehr beruhigt" Optionen
Editor dazu Config / Rf-Ports / Digipeater und "Hints"

28. 7. 2014 (Ver 0.41-testversion)

® Farbe fuer Schrift, Menues, Hintergrund, Transparenz, Radiorange, Reliefkarte mit
Farbauswaehler (der noch 3eckig werden soll damit umgekehrt auch eingestellte Farbe drauf
gezeigt werden kann)
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31.

24.

26.

15.

7.2014 (Ver 0.42-testversion)

Statusknopf zeigt durchgehend wenn Wx/Temp./Regen/Radiorange oder single User Modus
ist und kann da ausgeschaltet werden.

8.2014 (Ver 0.42)

"F"ind auf einen sonst unsichtbaren Objekt-Sender zeigt dessen Objekte.

"More Infos" zeigt Button "Objects of Call" wenn Call Objekte sendet.

Wx-only mit "L"abels off zeigt nur Temperatur und Windfahne beim Symbol.
Antennenwinkel bei Gelandeschnitt Info.

"DUPE" Meldung bei Wegpunkt-Info nimmer "ewig" bei einer Fixposition nach einem
Ausreisser.

8.2014 (Ver 0.42)

ip-Nummer Schreiberei vereinfacht, "127.0.0.1" kann weggelassen werden

udpflex erweitert auf "net-kiss", also kiss via tcp, damit es mit dem dire-wolf-Soundmodem
kann "udpflex.exe -U :9002:9001 -T :" (http://home.comcast.net/~wb20sz/site/ geht mit
default Einstellung, Sampelrate sollte man aber halbieren sonst ziehts 750MHz CPU)

10. 2014 (Ver 0.43)

Input Filtern auf Stichwort im ganzen Frame

kleines "e" oder "d" im Map-expansion-Lampchen zeigt automatischer Map Download off
(toggle mit "d"), Manueller Map Reload/Download geht aber auch in dem Modus.

Im "F"ind Feld geht auch dezimal Grad "48.2 13.31".

bei den Config Zeilen geht "Enter-Taste" als Ok oder Add.

Textfarbe vom Items/Objects mit Farbauswahler unabhagnig von normalen Baken einstellbar.
Fontgroesse Eingabe zeigt sofort Ergebnis.

ist ein Objekt im "show 1" modus, kann man mit "Focus" Karte mitziehen einschalten ohne
Watchlisten Eintrag.

TAB-Taste schaltet zwischen 2 Kontexten hin und her, dazu zaehlt nebst Wetterkarten-Modi
auch der "Focus" Modus, womit 2 Objekte im Bild gehalten werden kénnen.
Baken/Message/Ack Senden Warnmeldungen verbessert, wenn der eingestellte Sendepfad
vermutlich nicht zum Erfolg fuehrt. (Port ausgeschaltet, nicht zum Senden konfiguriert, kein
Passcode am Internet ....)

Gelandeschnitt, Reichweiten-, Relief-Karten Parameter in ausfihrlicherem Menu
zusammengefasst.

Gelandeschnitt zeigt freie Meter zum Boden (Karte ziehen zum Messmarke bewegen)
Trackfilter beim Suchen auf Duplikate mit Indexsystem so verschnellert, dass beim aus dem
Speicher Entfernen von Wegpunkten, auch deren Folgefehler mit Entfernt werden kénnen.

. 11. 2014 (Ver 0.45)

Gelandeschnitt und Reliefkarten mit einstellbarem Hohendaten Cache damit Plattenzugriff
auf etwa 0.5% verringert.
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Schalter "kleine/mittlere/volle Aufloesung" entsprechend langsam bis schnell.
Interpolation der Hoehendaten und damit brauchbare Bilder bis Zoom 14

im "Find" Feld geht Call / Sender of Object / Locator / DDMM.MM / D.DDDD
Marker 1 setzen Sendet DDMM.MM zum c/p Buffer, Marker 2 D.DDDDD Format.

9. 12. 2014 (Ver 0.46)

Watchcall Popup-Fenster anklickbar und zentriert Map auf das Objekt
Point-Of-Interest-File (osm/poi.txt) mit Name/Position/(optional) Hoehe (als Beispiel ist ein File
mit etwa 20000 mehr oder weniger richtigen Alpengipfeln vorhanden)

® mit "F" oder Tools->Find kann mit Wildcards (ste?n*) auf die Namen gesucht werden und die
Karte zentriert auf die Position und setzt Marker 1. Bei mehreren passenden Namen mit Enter
oder Klick auf Find werden alle Positionen durchgesteppt.

® st "p" oder Config->Map Parameter->Show Loc of Mouse auf ON, geht beim Bewegen der
Maus eine Sprechblase mit Zeiger zum nachstgelegenen Poi auf. Mit "c" kann die Karte drauf
zentriert werden.

30. 12. 2014 (Ver 0.46)

® Marker 1 und 2 setzen ("x" "y") geht ohne vorher auf die Karte klicken gleiches bei Zentrieren
"c" mit dem Unterschied wenn ein POl maximal 5 Pixel entfernt angezeigt wird, exakt auf
diesen zentriert wird.

26. 1. 2015 (Ver 0.47)

® nebst "poi.txt" wird noch "mypoi.txt" gelesen damit beim Update bei Bedarf die selber
angelegten Punkte erhalten bleiben. nun auch viele SOTA-Standorte im poi.txt

® | og File (rawlog) durch Anhaengen von %d zB. "logs/rawlog%d" auf tageweise 1 File mit
Datum umstellbar. Ist auch kompatibel zu den Logs am www-Server. (Log Filename jetzt im
"File" Menue)

® Bei tageweisem Log einstellbar nach wieviel Tagen automatisch (beim Start oder Mitternacht)
Logs geloescht werden sollen.

® im Log suchen nach Datum und/oder Call sollte auch dank "Load" (fur ab eingegebenen
Datum) deutlich zuverlassiger gehen.
mehrfach eingetroffene selbe Message wird nur 1x Angezeigt.
Baken (Netzbake, Objekte) kdnnen Position aus File (auch in Grad mit Komma) lesen fuer
bewegliche Objekte oder Mobilbetrieb.

® Baken kdénnen Text-Macro-File I6schen nach 1 mal Senden zum Zweck des automatischen
Verstummens der Bake wenn zB das Wetterhauschen nimmer Updatet.

2. 3. 2015 (Ver 0.48)

® Nur Stationen mit einem bestimmten Symbol aufs Bild, Symbol-Wahl in Tools / Select Data /
Symbol>. On/Off mit "Symbol" oder "s"-Taste. Achtung: Screenshot Taste ist jetzt "S".
® OQverlay Symbole mit Mausklick eingebbar
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6. 3. 2015 (Ver 0.48)

® Zoom-Lupe aufziehen mit rechter Maustaste halten. Ohne Maus bewegen wie bisher
Backspace in der Zoom/Pan History oder (Copy/)Paste in Texteingaben.

15.3. 2015 (Ver 0.49)

® Hover Info Popup (Tools/On Next Click/Hover) auf den Symbolen und Glaendeschnitt zu
Marker 1 wenn Tools/Radiolink enabled.

24.3. 2015 (Ver 0.49)

® |Linkstreckenberechnung mit einstellbarer Beugung (refraktion) der Hf in der Atmosphaere.

15.6. 2015 (Ver 0.49)

® 'H" fuer Hoehendaten Farbdarstellung.

® Cache auch fuer nicht vorhandensein von Hoehendaten damits schneller mit Loechern im
Datenmaterial zurecht kommt.
poi.txt ohne Neustart einlesen mit "Reload Config".
Wx Radioaktivitaet dekodieren und (vorerst) als Text ausgeben.

21.6. 2015 (Ver 0.50)

Maidenhead Locator Ausgabe langes Format, Eingabe "Find" 6 8 oder 10 stellig.
Treiber Aufruf fuer Soundmodems und (USB-)serielle kiss/smack TNC/Funkgeraete
betriebssystemspezifisch voreingestellt (sofern noch kein aprsmap.cfg vorhanden ist).
Popup Fenster Ueberlappungen etwas seltener.

Radioaktivitaet (Sievert) Dekodierung in den Wx-Baken (vorerst ohne Grafik)
Getrennte Backspace/Rechte-Maus History fuer beide TABs

27.6. 2015 (Ver 0.50)

® etwas verbesserte popup Fenster Platzierung.

® Config > Map Parameter > Reset to Default oder kurz "D" stellt die meisten Bildparameter
und Klickverhalten auf Default. Die alten Werte gehen zuvor in die Backspace/rechte Maus-
History zwecks Undo der Funktion.

® History/TAB speichert die wichtigsten Bildparameter + Kartentyp.

6. 7. 2015 (Ver 0.52)

Parameter Reset "ctrl-L" statt "D"
dekodieren und darstellen vom Area-Objects, Kreis, Ellypse, Rechteck, Dreieck, Linie (ohne
Corridor) gefuellt oder leer in 8 Farben nach APRS101.pdf.

® Baken Editor erstmal fuer numerische Eingabe der Area Objects.

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice Seite 58 von 197



B I ue S p|Ce 4 APRSmap Release notes

® dekodieren und darstellen von Multiline-Objects mit 3 Linientypen und 4 Farben nach AE5PL
1-23 Linien pro Bake geschlossen oder offen.

® Anklicken aller Linien und Flaechen am Rand und Verhalten wie normale Objekte aber ohne
Track bei Bewegung.

8. 7.2015 (Ver 0.52)
® Multiline-Objekt Editor

25. 8. 2015 (Ver 0.54)

® Mic-e-Telemetrie Dekoder, die Herstellercodes aus den Mic-e Frames werden dazu vorher
entfernt (soweit es geht) was auch sauberere Kommentarzeilen ergibt.

16.10. 2015 (Ver 0.56)

® \Wetterbake (Netbeacon, Rf Beacon, Query) aus .csv File

\\!wx.csv,,,t,,,,,h,b,r,w,d,,,,,g! im comment extrahiert die Werte aus der
letzten Zeile

im File wx.csv. Es kann noch ein Multiplikator angegeben werden zb. ,w3.6,
statt ,w, zum

Umrechnen von m/s auf km/h. Werte siehe Hints. Wx Symbol auswaehlen.

® Messages/Queries bei 9-stelligem Mycall sollten nun bestaetigt/beantwortet werden.

24.11. 2015 (Ver 0.58)

® Wx Grafiken korrigiert

® Schaltknopf/Laempchen fuer Objekte Ein/Aus

® Gate Net-to-Rf mit Radius und Bit/s Limit und Option nur Message zu (gehoerten) Usern (mit
Standard-3rd-party Protokoll und ohne speichern/wiederholen von Messages). Einschalten mit
Config/Rf-Ports/Digipeater, Rx auf "N", Bit/s in "N-n Words" siehe Hints.

28.11. 2015 (Ver 0.58)

® Starten ohne "terminal" und Abstellen sollte ohne X11 abschmieren gehen.
® UDP Ports an und abschalten auch mit laufendem "serial interface".

29.11. 2015 (Ver 0.58)

® History bei der "Find" Zeile mit Cursor up/down.

® Rf-Monitor mit Txdelay, Level und Quality, sofern vom Modem geliefert (afskmodem linux).

® Fenster Kopfzeile "nur neue" Calls (Config/rf-ports/monitor headline 0) und Zeit seit letztem
mal gehort(1).

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice Seite 59 von 197



B I ue S p|Ce 4 APRSmap Release notes

7.1.2016 (Ver 0.59)
® "Storm Data" Auswertung und Flachen-Darstellung mit interpolierter Animation. (mangels
Aktueller Testdaten nach APRS101.pdf in nautischen Meilen 1.609km)

® Area-, Multiline-, Sturm-Objekte mit "<>" durchsteppen mit zum Wegpunkt gehdérender
Flachendarstellung.

23.1.2016 (Ver 0.59)

® |tem in Messages, (B)akeneditor (auf "Item") + (M)essage Send Fenster gedffnet kopiert den
Bakeninhalt in Message Text und erzeugt dann beim Empfaenger der Msg ein Symbol auf der
Karte. (APRS1.2) Da sich die Protokollerweiterung Item-Message und Multiline-Object
gegenseitig beissen ("{" symbol), geht die Kombination vermutlich nur mit aprsmap + send
with ack.

25.5.2016 (Ver 0.61)

® Objekte ohne Richtung und Geschwindigkeit zeichnen keinen Track mehr.
® alle alternativ Symbole koennen Overlay Zeichen haben (a..z A..Z 0..9)
® Hamnet Symbol in symbols.png

15.3.2017 (Ver 0.64)

® Trackfilter geht bei mehr als 15000 Wegpunkten nimmer gegen Rechenzeit unendlich.
® Trackfilter wird auch mit den kleinen Zappeleien bei Verzoegerungen unter 1Min fertig.
® "Find Item Message" zeigt auch bei mehreren solchen Msgs die dazu passende Position.

5.4.2017 (Ver 0.65)

® Rotes Fehlermeldung-Popupfenster groesser und umfangreicher bei der Baken Eingabe.
® mit []-Tasten Zeit aendern wie lang Dinge auf der Karte sichtbar bleiben.

25.5.2017 (Ver 0.66)

® Kontrast der Symbole verbessert.
® Fenster zu klicken sollte bei vielen Linux-Fenstermachern wieder geeordnet abstellen.
® Linux 64bit Version.

5.7.2017 (Ver 0.67)

® langen Locator suchen korrigiert und Kleinfeld Darstellung
® yudpflex (linux) tcpkiss server
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29.9.2017 (Ver 0.69)

Helligkeitskorrektur (Tools > Add Maptypes) als Gamma Werte statt +- Helligkeit. Bei
Bildschirm-Gamma (Config > Brightness) 2.2 entspricht 0.45 original und 0.3 etwa dem
bisherigen -128. Die Werte werden nun bei Kontextumschaltung mit TAB mit dem Kartentyp
gespeichert.

01.12.2017 (Ver 0.70)

Kartentypen mit Gamma-Korrektur statt Helligkeitskorrektur. (Tools > Add Maptypes) solang
ein Hellikeitswert konfiguriert ist, wird default 0.25 angewendet. (Sinn der Sache: Sat Map
von Sentinel2)

Eingestellte Karten Helligkeiten werden individuell fur Kartentype gespeichert. (Sat Maps sind
bei 100% ok, OSM karten eher bei 20 bis 40%)

"6" schaltet alle aktiven Kartentypen im kreisrum durch.

Font von 7x6 bis 24x12 und zoombare Symbole 16 bis 32 aus symbol file 16 bis 48 Track und
Wegpunkte werden mit angepasst. (Zweck: hochaufloesende Bildschirme)

Neue Fontfiles und Symbolfile mit teiltransparenten Symbolen (wird noch verschénbessert ...)
beim Symbol Zoom wird erst versucht ein zur Grdsse passendes symbolsXX.png zu laden falls
nicht vorhanden wird "symbols.png" gezoomt.

Weicher Alpha-Kanal (Transparenz) bei den Symbolen (win: neue "pngm.dll")

09.12.2017 (Ver 0.71)

win: jpegm.dll damit werden auch OSM Karten im jpeg Format gelesen (auch mit Filename *.
png)

win: getosm.exe (dank an oe5krn) neu mit "getosm.org" start Datei im zip und ohne "getosm.
ini" damit bei Programmupdate OSM-urls nimmer Gberschrieben werden

Urls mit .jpg hinten kdnnen eingegeben werden

Konvertierung auf png kann abgeschaltet bleiben, spart Plattenspeicher

12.02.2018 (Ver 0.72)

Logfile laden (besonders mit 270000 Baken Track drin) verschnellert.

Symbole-Zoom verbessert und % Eingabe als 3. Parameter bei Config>Font>Fontsize flr
Symbolgroesse/Texthoehe Verhaltnis

15.03.2018 (Ver 0.72)

Linux 64bit Copy/Paste Absturz behoben (hoffentlich)
Refraction Parameter wirkt auch bei Radiolink Ausleuchtung

12.07.2018 (Ver 0.74)

Neue-Version-Check Funktion mit shell/BAT script falls wer einen dazu passenden www-server
baut.
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® Radiowellen Ausbreitungsberechnung um Streckendaempfung und Antennendiagramme aus
Hersteller-Files erweitert.

07.10.2018 (Ver 0.75)

® Fehler beim Logfile importieren und nach Uhrzeit sortieren behoben.

12.10.2018 (Ver 0.75)

® poi.txt aus Hamnet-db und Foto-webcam Daten aktualisiert.
® "p" rechnet mit Refrac (0.13 Licht, 0.25 Funk)

17.11.2018 (Ver 0.76)

® Poi-Files mit beliebigen Namen in osm/poi/

® Darstellung eines Info-Fensters bei Maus nahe einem Poi sofern Info enthalten.

® Auswahlmenue "C" oder "Tools/Select Data/Show POI" zum Zeichen von einstellbaren
Symbolen eines oder mehrere Poi Files. "I'" (= kleines "L") schaltet Labels ein/aus. Dazu Text-
Filter im Namen oder Infofeld zum eingrenzen der Auswahl mit "*" und "?"

® Marker setzen mit Fangen der Position des nahen Poi mit "X" und "Y", ohne Fangen "x" "y".

24.7.2019 (Ver 0.77)

® Tagged srtm (wasser/wald/urban) und damit Gelaendeschnitt mit/ohne wald
® Message mit ziel "RAW" zum erzeugen einer handgekloeppelten nicht-standard Bake oder
"general query"

2.1.2020 (Ver 0.78)

® wetter grafik, gamma(Sievert) + PM10 PM2.5 PM1 PMO0.1 (ug/m3) feinstaub
® senden gamma + feinstaub aus csv-zeile mit baken-macro

h264 in mpeg4 Container: Linux: 1 mal machen: mknod map.y4m p

fuer jedes Video starten: x264 -o film.mp4 --muxer mp4 --crf 22 map.y4m
<Make Video>

win: File / Make Video gibt unkomprimiertes Videofile map.y4m

(.y4m sollten mplayer oder vlc abspielen koennen)

klein packen mit x264.exe "x264 -o film.mp4 --muxer mp4 --crf 22 map.y4m"
(crf=22..27 qualitaet gut bis sparsam)

vorher mit Animate und auf Map klicken passende Geschwindigkeit einstellen

files/dirs:
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aprsmap programm

aprsmap.cfg beispiel config, wenn nicht vorhanden werden default werte
erzeugt

hints.txt tipps beim verweilen mit der maus auf buttons

help.txt Hyperlink-Hilfetext unter Help > Helptext

gm.sh shell script zum osm karten holen

(geht nun auch mit der busybox am tinycore)
(darf/soll verbessert werden HI)

./gm.sh

symbols.png icons
font.png buchstaben
gettiles vom aprsmap erzeugte liste fehlender map tiles
rawlog timestamp+aprsis format wenn vorhanden beim start
eingelesen
bei connect zu aprs server kommts neue dazu
dargestellt werden die eingestellten minuten vom ende des
logs
mit connect zu server eingestellte minuten von jetzt
file darf editiert, beschnitten, gefiltert werden
wird nach timestamp sortiert eingelesen
(langes file einlesen geht mit serverconnect schneller
da erst ab "jetzt-darstellzeit" decodiert wird)
osm/tiles/ karten im osm format

osm/tiles sat/
osm/tiles topo/

udpflex axudp<->kiss/smack/flexkiss interface fuer TNC, TMx7xx ...
kisson.txt kiss initialisierung fuer TMD72 mit udpflex
getosm.exe Win: Schneller Maplader von OE5KRN
poi.txt globales/privates
mypoi.txt Points-0f-Interest-File mit aktiviertem "p" zum zeigen bei
Mauszeigernaehe oder Suchen mit "F"
oe5dxl|

<< Zurlck zur DXL-APRSmap Ubersicht
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APRSmap Release notes und Benutzer:OE2WAO: Unterschied

zwischen den Seiten

VisuellWikitext

Version vom 2. Dezember 2018, 17:26
Uhr (Quelltext anzeigen)
OE2WAO (Diskussion | Beitrage)

Zeile 1:
— [[Kategorie:APRS]]

— *libpng und libz statisch dazu gelinkt

* font svmbol und OSM karten nun im
png Format

* 4 Kursortasten zum
Karteverschieben und Backspace fiir
letzte Position(en) (sofern die bei
allen x11 gleichen hexcode haben)

* OSM Karten in Unterverzeichnissen
— nach Zoom Faktor 1..16 vorhandene
maps loschen oder einsortieren

* wenn Files fehlen wird sofern
— vorhanden die mit dem nachste
Zoomfaktor gedehnt eingesetzt

* ./am.sh starten bzw anpassen nach
Bedarf zum Kartenholen

* linke Maus auf Karte klicken oder
auf Track oder Symbol o6ffnet Menu,
— viele Funktionen mit Klick erreichbar
aber noch nicht alle Meniis, noch
chaotisch aber mal zum Testen

* Wettergrafik + statistik auf x11
abrufbar

— * ESC taste zum Menisschliessen

* Funktion der Klicks auf symbol/text
/map/track getrennt konfigurierbar

* 5 watch calls (ohne wildcard) statt
"follow car"

Aktuelle Version vom 9. August 2020, 23:
41 Uhr (Quelltext anzeigen)
OE2WAO (Diskussion | Beitrage)

(Die Seite wurde neu angelegt:
Lhttps://oe2wao.info*)

Zeile 1:

+  https://oe2wao.info
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* Wwettersymbol etwas besser
anklickbar (svmbols.pna) (alpha

— Kanal nach heller verschoben, sollte
mal nach 255 wenn alle Symbole
dafiir adaptiert)

* rechte Maustaste = BACKSPACE
— (back in zoom/pan-historv) (bei www
Version lokal back am Browser)

* map move steps teil der
Fenstergrosse

- 6.1.2013

* Marker auf "Next click to Map":
ohne Einrasten auf Svmbole "Next

— click to Svmbol oder Text": mit
Einrasten auf genaue Position wenn
vorhanden

— * Marker loschen und keycode "@"
— * zoom to markers wieder da "Y"

* kmh Histoaramm und Animation
— entsprechend der eingestellten
Sichtbarkeitszeit des Tracks

* blaue popup Menls sortiert nach
der GroRe angereiht von links oben

* "Expandes Tiles" geht auch weg
wenn alle tiles 1:1

— * call in die watchlist mit click

- 7.1.2013

* Taste "@" umgewidmet auf "on
click" Reset

— * Taste ":" loscht beide Marker

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice Seite 65 von 197



BlueSpice 4l

APRSmap Release notes

* 30s langer Retrv Mechanismus zum
Tiles Laden, sobald "qgettiles"
aeloscht, ie Sekunde 1 Ladeversuch

— aller benotiaten oder expandierter
Tiles und was fehlt oder "pnag error"
hat wird erneut im "gettiles"
angefordert.

- 7.1.2013

* Tasten "<" und ">" entsprechend
"Debua Track" raw+decoded Text der
Wavpoints oder Baken durchsteppen
und setzt Marker 1

— * Backspace history size 20 statt 10

— 10.1. 2013

* Tasten < > getauscht und Textinfo
bleibt sichtbar

* Click to WxSvmbol neu und dort
dann entweder 1 nicht-Wetter

— Messwert oder beliebig viele
Wetterwerte zuagleich ein/aus
schaltbar (Menu bleibt offen)

- 14.1. 2013

* Letzter Wettermesswert in der
Kopfzeile der Wettergrafik

* Wetterarafik passt sich der
Fensterbreite an (ab 320 Breite)
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* Raw+Decoded Fenster bleibt trotz
— "Marker to Klick" Messdaten Fenster
offen

— 16.1.2013

— * Decodiert positionless WX Daten

* Decodiert negative NN im "/A="-
Format

* Zoom to Markers geht auch bei
Zoomlevel>14

* Fractional Map Zoom rechnet etwa
2x so schnell und richtiger

* Shift-Taste bei Map Move macht 1
/10 Schrittweite

* Shift-Taste bei Zoom (derzeit nur
mit Maus) macht 1/10 Zoom Schritte

- 20.1.2013

* Klick auf Track mit Raw+Decoded
fiir den Geklickten Wegpunkt

* Raw+Decoded mit Weapunkt
—  Nummer / Gesamtpunkte zur
Orientierung wo man ist

* Cut + Paste Puffer wird mit
angeklicktem Call gefiillt

— * Paste in Texteingabefelder

* leider aeht beides nicht nach
aussen weil die Fenster heute mit
"selections" miteinander telefonieren
und das ist etwa so aufwendiqg wie
das gesamte Interface zum X11 bis
jetzt
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* (derzeit noch nicht ein
/ausschaltbares) Textfenster mit
Scrollbalken fiir lanae Texte. Zum
Test mit Rawdaten von tcp connect.

* nach 4 Tagen Suche noch nicht
gefunden wie man Kill des Fensters
abfanaen kann ohne dass dabei alles

— abschmiert. Da auch die aanzen Xlib
Aufrufe zum Text reinzeichnen keiner
auf Windoof/sontswas portieren wird,
wirds wieder abgeschafft.

- 26.1.2013

— * Textfenster mal wieder weg

* rawloq File wird nun auch nach dem
Einlesen aeschlossen und wie bisher
beim Schreiben fiir jede Zeile neu
geoffnet

* Marker 1 zu klick misst, wenn genau
1 Obijekt mit klick erfasst wird mit

— Einrasten auf dieses, wenn "on next
click set marker 2" immer ohne
Einrasten

- 3.2.2013

* (minimierbare) fixe Toolbar (die
— minimierte verdeckt noch manchmal
Text Messages)

* Popup Meniis ausaemistet, z.B
"Show All" nur wenns nicht schon ist

* Von den neuen Kommandos aus der
Toolbar gehen erst ein paar wirklich
(W V Q S) Messages, Listen, Config
noch nicht
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6. 2. 2013

* Fahrtrichtunaspfeil + Windfahne bei
Wx Svmbol, 20kmh pro Strich beides
als Teil vom Symbol anklickbar und
abschaltbar

10. 2. 2013

* Auswahl ob Toolbar oder Popup
Fenster, damit beim Start normale
Toolbar da ist. Muss noch optimiert
werden was in welchem Menii sein
soll und was offen bleibt oder
verschwindet. Histoaramme
verdecken die Pulldown Meniis aus
der Toolbar

* Hohenanagabe bei den Svmbolen,
noch nicht abschaltbar weil alle
Svmbol-Attribute ab einem
einstellbaren Wert (mindest meter,
km/h) konfigurierbar erscheinen
sollten.

13. 2. 2013

* Text Editor mit Scrollen fiir Config
und (wenn fertiag) Messaades,
Parameter werden erst einzelne
ausgewertet

* Screenshot mit Filename
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* rawloqg einlesen mit Filenamen
— (Datum Einaabe noch nicht
ausgewertet)

— 16. 2. 2013

* Watch Calls per Click suchen freien
— Platz in der Liste weil jetzt tastaturlos
auch wieder abschaltbar

— * Watch Calls mit * als Wildcard

* Setzen der Start Map Position auf
Bildmitte per Lokator, Lona/Lat, oder
mit "?" im Config und dann Marker 1
setzen auf der Map

* eigene Position im Config auch mit
"?" mit Marker 1 ubertragbar.

* Confia File Speichern/Laden beim
— Start verwenden und automatisch bei
Quit Speichern

* fehlt noch Auswerten einiger Confiqg
— Parameter zb Helligkeiten und "next
click to Wx"

- 15. 2. 2013

* Ausser lgate/Network und
LoaDatum Configs sollten alle gehen
und aekoppelt sein mit den

— Schieberealern. Manche Werte, die
beim teilweise eingeaeben sein Unfug
machen, werden erst bei "Save"
"Reload" oder Start ausgewertet
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28. 2. 2013

+ Bei Click auf Pixel das zu mehr als 1
Obiekt aehoert, werden die
gefundenen Objekte

bei iedem weiteren Click der Reihe
nach an die 1. Stelle cykliert

+ Lodfile Import mit Datum + ganze
Stunde

+ Netbeacon aus Confiaparametern
damit per Modem empfangenes ein
Symbol fuer MH hat

(noch nicht per tcp gesendet)

3. 3. 2013

+ Objekte Loeschen

+ Filtern von Call, laate, Obiekt/Item-
Absender (erst mal ohne Wildcards)

7. 3. 2013

+ transparente Menues oder
schwarzer oder grauer Hintergrund

(Config Transparency 2..100, 1, 0)

+ Config Baken Symbol mit
Auswahlmenu ("My Symbol" clicken)
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— + Objekt loeschen mit DEL-Taste

- 17.4. 2013

+ Nach wochenlanaem Kampf mit den
— Windoof Compilern ist nun etwa
Gleichstand bei der

Win32 Version und es kann wieder
— am aemeinsamen Teil weiter gebaut
werden.

Die innere Struktur ist etwas
—  umaekrempelt zwecks minimiertem
systemabhaengigen

Teil. Leider hat sich die "Tile"
— Filestruktur (mit schnell mal 3500
Files in einem

Verzeichnis) am Win als Bremse
— erwiesen und daher ist noch eine
Unterverzeichnis-

Ebene dazu aekommen und die
— Struktur nun gleich wie auf den
Servern und "Marble".

Zum Konvertieren der vorhandenen
— Maps ist das "rentile" script dabei das
man

noch anpassen muss und mit der
— Kommandozeile, die drin angegeben
ist, Aufrufen.

Es wird nix geloescht nur kopiert.
"gm.sh" ist auch darauf angepasst.

+ Neu sind nur ein paar Filter im
— Confia und fuer Besitzer eines
Mausrades damit Zoomen
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und Pull der Map mit der mittleren
— Maustaste. Fuer Touchpad-
geschaedigte muss man sich

noch eine Alternative mit Shift/Alt
— oder Klick auf die leere Map
ausdenken.

Screenshot geht nun auch als "bmp"
wenns File .bmp heisst.

- 17.4. 2013

+ Pull Map auch mit linker Maustaste
auf leere Map (configurierbar ?)

+ Shift + Click to Map: Set Marker
— 1 (confiagurierbare andere
kommandos ?)

+ On next Click to Wxsvmbol:
— Raw+Decoded zu den Wettergrafiken
dazu einschaltbar

— 20.4.2013

+ tcp Connect zum Server mit neuer
— Svntax, -a <ip>:<port>[#<filter>] -g
44.143.100.1:14580#m/300

MYCALL und PASSWORT jetzt schon
aus dem Config statt -s -p

+ Netzbake: "File" > "Confiq" ->
— Myvcall, MyPos, Net Beacontext, My
Symbol,
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Netbeacontime mit Enable,
PassCode mit Enable

My Symbol Anklicken fuer
Auswahl

My Position "?" an 1. Stelle
und dann Marker 1 Setzen

- 29.4.2013

+ tcp Connect nun probisorisch im
— File>Confia, wenn man editiert gruen
ausschalten und wenn

- fertig wieder ein.

+ auf Wunsch Massstab auf der Karte
— (noch nicht schaltbar) und auch
problematisch wegen

nicht entfernunastreuer Merkator
Karten bei kleinem Zoom

— 4.5.2013

+ Vorschlaa von dI8rdl einaebaut,
— Maps Download im Hinterarund
komplett fuer das sichtbare

Fenster von Zoom 1 bis
— einstellbarem maximalen Zoom mit
Vorkalkulation der Datenmenge,

abbrechen, weitertun, und
Fortschrittsanzeige.

+ Messages empfangen (derzeit erst
von tcp)
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6. 5. 2013

+ "DAO"-Erweiterunqg in Frame-
Decoder einaebaut zum Position auf
etwa 20cm genau uebertragen

und auch genauere Auswertung vom
GPS-raw-Format und Anpassung der
Rundung auf Feldmitte

(leider ist die fliesskomma
Genauigkeit nur etwa 1-2m)

8. 5. 2013

+ Mehr Status Meldunaen von "on
/off" Schaltern und (Shortcut)
Funktionen

+ <Make Video> leat "map.v4m" auch
auf Linux neu an wenn nicht (zB. als
named-pipe) vorhanden,

meldet Schreibvorgana, refresht alle
1s den Bildschirm und ist abbrechbar.

+ Buttons mit noch nicht
implementierter Funktion melden das.

+ Im Screenshot Filenamen wird "%t"
durch Datum-Uhrzeit und %n durch
"000" bis "999"

ersetzt bis der Filename neu ist.
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— + Shortcut Tasten Liste im <Help>

— 10.5. 2013

+ 4 direkt waehlbare Map Positionen
— + Zooms im Zoom-Menue oder per "1..
4" Tasten.

Dabei kann entweder der Zoomlevel
— oder die Position oder beides
abgerufen werden.

Der Eintraq dieser "Views" kann
— manuell im File>Config>View durch
"Zoomfaktor Position"

(wobei Position auch ein QTH-
— Lokator sein kann), oder eines von
beiden, oder viel

schneller durch "Shift" + Click auf
— einen der 3 "Views" im Zoom Menue
erfolgen.

Dabei wird die aktuelle Karten-
Position mit Zoom gespeichert.

Shortcuts anders: "1" (one user) nun

— ||2|| +rf nun n_n

"On next click" neu einstellen
erforderlich

- 12.5.2013

+ Tooltipps mit Text aus externem
— File "hints.txt" und schon etlichen
Texten drin.
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Darf natuerlich verbessert oder
— uebersetzt werden wobei das
Ergebnis der Arbeit

sofort aktiv ist sobald das hints.txt
gespeichert ist.

- |Buttonnummer Text

die fehlenden Texte werden als
"<Buttonnummer> hint text" gezeigt

die Struktur des File>Confia wird
— noch umaebaut daher mit den hints
dafuer abwarten

— 15.5.2013

+ "Zitter"-Toleranz fuer Mausposition
— innerhalb der die Hints sichtbar
bleiben

+ Zeiat aktuelle "Mbytes written" des
Video Files

— + List>Internals zeigt System Zustand

+ "L" Shortcut nun "toaale Labels on
/off" Labels=Text bei den Symbolen

— + Fine Zoom Steps im Config

- 17.5. 2013

+ "L" und "O" bzw "Labels off"
— "Obijects off" wird nun nimmer in
Form von 0% Helligkeit

- im Config verewigt
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+ In Vorbereituna auf ein Text-
— Fenster kommt nun mal
List>Messages und List>Bulletins

auf das Start Terminal Fenster raus,
wobei die Bulletins noch nach

Absender/Eintreffzeit sortiert sind
und nicht nach der BLN<nummer>

+ Anaeklickte Obiekte kann man in
— Infos>List Raw oder Infos>+Decoded
auf das Textfenster

auflisten lassen (ohne farbige
Fehlermeldungen)

— 18.5.2013

+ Confia>Show Incomina "n" Zeiat
— TCP-Frames auf dem Textfenster,
"n+" Dekodiert

fuer die Radio Ports entsprechend 1
23...und 1+ 2+ ... Dekodiert

- 21.5.2013

+ Raw+Decoded Sprechblase
— aktualisiert sich mit ankommenden
Daten falls sie den letzten

- Wegpunkt anzeigt
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+ Delete Waypoint, wenn mit Debuaq
— oder Raw+Decoded markiert. Mit DEL-
Taste zum entfernen

von (falschen) Weapunkten. Marker
— 1 sprinat dann zum naechsten
(vermutlichen) Fehler weiter.

(Wann alles loeschen oder nur
— Wavpoint muss noch besser
definiertbar sein)

+ Hoehe wird auch bei Symbolen
— ohne km/h Daten anaezeiat falls
Hoehendaten vorhanden und

- eingeschaltet.

— 23.5.2013

+ UDP-Port im Config (erst mal 1
Stueck)

+ Fenstergroesse veraendern
schneller

+ Trackfilter Fehlererkennung
verbessert

+ Bei Debuag Funktionen
— Verzoedgerungszeit von doppelten
Waypoints in Sekunden sichtbar

— 29.5.2013
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+ Zwecks schnellem Tracks Debugaen
— mit "E" oder File>Infos>Waypoints-
Button toggelt

alle, oder nur die als verdaechtia
— markierte Wavpoints anzeigen mit
den "<"">" Tasten

- oder den Buttons daneben.

+ rawloa mit lesbarem Datum
— /Zeitstempel, das alte Format wird
lesend auch akzeptiert.

+ axudp-kiss (usb)seriell Interface
— (udpflex) erweitert, sodass nebst an
/abstecken von

usb-Seriellen auch ein resetteter
— TNC2 an empfangenen (nun nicht
mehr kiss) Daten

erkannt und wieder auf kiss
— daeschaltet wird. Geht mit init File
auch fuer andere TNC

- wie in THD7x oder TMD7x.

- udpflex (linux), udpflex.exe (win32)

- 8.6.2013

+ Confiaurierbare default Speed fuer
Animation

+ Parkplatzzittern-Erkennung fuer
Animation Startzeit verbessert

+ Source Code Entruempelung zum
— einfacheren Compilieren fuer
verschiedene Prozessoren
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15. 6. 2013

+ km/h und/oder Hoehe in Animation
und Video wobei Lesbarkeit bei
schneller Aenderung

noch verbessert werden kann.

+ Uhrzeit beim Loa schreiben laeuft
nun auch waehrend Animation in
Echtzeit.

+ +-24h Zeitversatz Svstemzeit
/angezeigte Zeit einstellbar

5.7.2013

+ Objekte mit extra "keep in memory
time" zB um den schon nach 5 bis 6h
recycelten

Blitz-Object-Namen keinen Track
erzeugen zu lassen.

+ Lodafile browsen aeht daleichzeitia
mit online Betrieb. Dazu wurde eine
zweite

Uhrzeit geschaffen die den Loadaten
folat und die Echtzeit Daten werden
unabhaengig

von den Loadaten (wie sonst auch)
im RAM und writelog gepspeichert.

Es kann jederzeit zwischen Log und
Echtzeit gschalten werden und in den
Logdaten

an Anfana, Ende, und in "Fullbright"
Zeitspruenaen vor und zurueck
gegangen werden
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womit immer alle Daten einmal
sichtbar sind.

+ Status Bar zeiat Betriebszustand,
— erst mal experimentell zum sehen
was man braucht

mit Buchstaben bis Symbole
— entworfen sind. Bei TCP (Internet)
und und UDP (Funk)

wandert die Farbe von aruen nach
— rot binnen 1 Min. solang keine Daten
ankommen.

Messaae soll mal anstatt dem Popup
— Fenster vorhandene Messages
anzeigen und erst bei

- draufklicken Inhalt zeigen.

- 16.7.2013

+ Hoehen Diaaramm ueber
— Weastrecke, mit Trackfiler on "F"
wird versucht die manchmal

unagenaue Hoehenmessung etwas
glatt zu buegeln.

+ Beim Track anklicken wird der
— Weapunkt ausaewaehlt der der
Klickpunkt am naechten

- liegt.

+ Popup Meldunagen, die Befehle
— bestaetigen, werden nach ein paar
Sekunden wieder
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entfernt. Da, um CPU Zeit zu sparen,
— der Bildschirm nur aktualisiert wird
wenn neue

Daten kommn, geschieht das
Loeschen nur im Zuge einem Updates.

- 19.7.2013

+ "On Next Click To Track" mit Speed
— oder Altitude aktiviert, setzt eine
Marke auf

dem Diaaramm, die der angeklicken
Stelle am Track entspricht.

+ "On Next Click To Track" kann mit 1
— Click Wegpunkt loeschen aktivert
werden.

+ Ein anaewaehltes Obiekt kann mit
— "Save" als Logfile mit dem Filenamen
des Objekts

aespeichert werden (derzeit nur im
— Startverzeichnis). Existiert das File,
wird

hinten dran geschrieben. Es werden
— alle Daten aus dem RAM geschrieben
auch wenn

mit Trackfilter oder Fullbright Time
ausgeblendet.

Manuell geloeschte Baken
/Wegpunkte sind weg.

- 22.7.2013
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+ Video/Animation Speed
— Einstellbereich erweitert von 1:1
(Echtzeit) bis 200s/Frame

womit die Speed-Zahl statt (Echt-)
— Sekunden zu Frames jetzt
multiplikator fuer

- Echtzeit ist.

+ Start Delav fuer beschleunigte
— Darstellunag (wenn sich nichts
bewegt) einstellbar

+ Loa Import fuer ein Call wobei
— immer auf eine Zeitspanne gesucht
wird in der das

- Call aktiv war (keine wildcards)

- 25.7.2013

+ "On Next Click" mit mehreren
— Optionen gleichzeitig (wo es Sinn
macht).

- 9.8.2013

+ Durch erweitern der Menue-
— Darstelluna auf Tabellen mit Farben
und verbessern des

Zeilen-Editors (Maus kann Cursor
— setzen ...) ist Messages erstellen und
verwalten

moealich aeworden. Empfanaene
Messages sind noch ohne Tabelle.
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2. 9. 2013

+ Nach komplettem Umbau des
Konfiqurations-Tools mit dynamischer
Anzahl der

Eintraeae aeht nun Messaqges
senden, mehrere Aprs-Server-urls die
abgeklappert

werden bis einer antwortet, beliebig
viele Watchcalls, Filtereintraege,
Baken...

Der Texteditor kann Insert/Overtype
und Cursor setzen mit der Maus.

Mit Shift-Linksklick auf die Karte
wird die Position in die Editorzeile

kopiert (ietzt einfach wiederholbar
bis man "getroffen" hat)

(Die eiagene Position und die Zoom>"
Views" muessen neu eingegeben
werden)

+ Die aktuelle Fensteraroesse wird im
Konfigfile mit gespeichert.

"View 1" wird beim Programmstart
dargestellt.

(speichern der aktuellen Ansicht mit
Shift-Linksklick im Zoom-Menue)

+ Nach der Fraage "was brauch ich
alles um online zu gehn" ist dies nun
in

einem Menue. Dabei kann man
abgestuft von ganz ohne Call bis Call
und eigene
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Position nur dem Server sagen
— (zwecks funktionieren der m/... Filter)
bis

Bake und Messages ins Netz senden
konfigurieren.

+ laate-Funktion ist nur in der Linux
— Version vorhanden da das Win-tcp-
System

keine Info ueber bestaetiate Daten
— hat und dann einen als "haengend"
erkannten

Link nicht terminieren kann, ohne
— die veralteten Daten noch
rauszuweinen.

Das waere im aktuellen Aprsis-Netz
— ohne Timestamps nicht mehr
akzeptabel.

Auch die Linux laate-Funktion sollte
— auf keinen Fall fuer einen Digi
verwendet

werden da zB. beim Lodfiles
— durchsuchen die Durchlaufzeit
erheblich werden kann.

Fuer Igate gibts ohnhin ein eigenes
Tool.

+ UDP-Ports fuer Funk rx/tx mit
— Soundmodem oder mittels "udpflex"
(USB)seriellen

TNC aibts derzeit 4. Eine
— dvnamische Anzahl braucht noch
Aufwand bei den

- Schaltknopfen in den Menues.

Der Funk-Baken/Objekt/Items-Editor
— ist noch in Entwicklung, dort dann
auch
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wieder die verschwundene
"Rfbeacomtime" fuer jede Bake extra.

(bis da hin 1 Bake manuell ins
aprsmap.cfg)

- 4.9.2013

+ Baken senden mit Macros fuer
— Uhrzeit und File einfueaden
(Wetterbake). Jede Bake

mit Port und Intervall Anaabe und
— Zielport aeht auch Net. Mit Beacons
Shift Time

wird die Startzeit ieder weiteren
— Bake so verschoben, dass sie nicht
innerhalb der

"dupe delete" zeit (meinst 57s) der
Igates landen.

Svntax: intervall(s):port:rawformat
600:1:NOCALL>CQ:>test

- \\z tag+zeit, \\h zeit, \\:filename:, \\\ \\

- 8.9.2013

+ Maus Hint Texte verbessert und
deren Erscheinen an der Status Bar.

+ User Infos erweitert, aefahrene km,
— Zaehler fuer Baken, Messages, Acks,
Rejects
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9. 9. 2013

+ "Show Objects of Sender" zeiqt alle
(anderen) Objekte und Items von dem
Absender

des Ausaewaehlten Objekts auf
einer dafuer aezoomten Karte unter
"Info>Objects of.."

+ Shift-Click auf die Status-Bar (die
bunten Laempchen) oeffnet direkt
das zugehoerige

Config-Menue soweit Sinnvoll.

11. 9. 2013

+ Menue Positionieruna korrigiert
und Menues nimmer schliessen bei
Shift-Click

auf Map zum Position in Editor Zeile
kopieren

13. 9. 2013

+ Statusbar Netzwerk-Buttons Mouse-
Over wenn nicht online normale Hints,

wenn online, Status Info. X/N zeigt
offline/online (sollten mal Symbole
werden)
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+ "w" Temperatur-Karte wie bisher,
- "W" (w mit Shift) Regen-Karte mit
blau fuer

24h und rot fuer aktuellen Reaen
— (noch ohne Fehlerfilter, luegende
Stationen

- anklicken und mit DEL entsorgen).

- 16.9. 2013

+ Lodfile lesen mitn Binaersuche fuer
— den Anfang ab wo ins RAM eingelesen
wird

mit dem Vorteil, dass auch lanage
— Loas beim Programmstart und Log
Import schnell

nach Datum durchsucht sind, aber
— das Logfile muss nach Datum sortiert
sein.

- Derzeit max 4GB Logdfile.

- 19.9.2013

+ Messadqe (Querv)
— Kommandowoerter + Antworten in
Config > Rf-Ports.

Standard Quervs (?APRSP) als auch
beliebige Woerter koennen definiert

werden und in der Antwort Macros
wie \\h Uhrzeit, \\p Path, \\l Position,

\\vV Proaramm Version, \\<filename>
File senden, \\>filename> schreiben,
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letzteres zum aktivieren von einem
—  Proaramm zum was Steuern oder
Sprachausgabe

"TALK:\\>/tmp/talk.txt>Text um \\h
Gesprochen!"

- "?HELP:?APRSP, ?VER, TALK"

- 22.9.2013

+ Windfahne und Temperatur beim
Symbol mit Timeout.

+ 1 Kommastelle mehr bei
— Koordinaten-Ausgabe und bei Maus-
Koordinaten

Grad/Minuten/Sekunden-
Schreibweise zuaetzlich.

+ Win32: bei der (oder mehr) Start-
— Fenstergroesse die der Bildschirm
kann,

- "Maximized" Fenster.

- 7.10. 2013

+ Filesvstem auf "Londfiles"
— umagestellt damit sollte Logfile >2GB
geschrieben

und dank Binaersuche auch flott
importiert werden koennen.

+ Proaramm Starter fuer Maps-
— Downloader bei Bedarf (gm.sh bzw
gm.bat)
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der kann sich nach getaner Arbeit
beenden. Status in der Status-Bar

mit "D" statt "E" fuer Downloader
laeuft erkennbar.

+ Beliebiae Map-Tvpen confiqurierbar
mit korrektur der Basis-Helligkeit,

die ersten 3 wie aewohnt mit
— Shortcut "7" "8" "9", die 1. beim Start
aktiv.

Sat-Maps erst wenn ein |IPEG-
— Dekoder vorhanden ist (ausser man
wandelt

sie beim Download in PNG). Neu
(voreingestellt): cyclemap

— 11.10. 2013

+ Weastrecken Summe (ohne Track)
auf der Map (shift-click, click, click...)

+ Loa Import (bis auf Suche
— rueckwaerts nach Call) bei
unsortiertem File

- versucht etwas zu verbessern

— 13.10. 2013

+ Schriftgroesse einstellbar (Config >
Map Paramter > Font Size)
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15. 10. 2013

+ Screenshot auch als ".png" (vorerst
nur Linux Version)

und osm-Verzeichnispfad wieder
configurierbar

+ "On next click to Track" bei
mehrfacher Auswahl mit "Zoom to"
wird erst gezoomt

und dann im 1 Track Mode die
anderen Funktionen aktiv.

31. 10. 2013

+ Beep-Sounds mit beliebiger
Freaquenz und Dauer wenn Message
oder Ack eintrifft,

wenn sich wer in den Warnradius
beweat mit steigender Frequenz und
/oder Dauer

ie naeher er zum Zentrum kommt
und wenn ein Call aus der Watch Liste
aktiv wird.

Alle getrennt schaltbar und limitiert
auf maximal alle 5s.

Windoof 7 oder 8 aeschaediate
koennten evtl. keinen Piepser haben
dann gibts als

Ersatz 3 Svystem-Sounds (mit Oms
einschalten, bis 500, bis 1000, ab
1000Hz

jeweils ein anderer Gong).

Config > Map Moving > Bell/Sound
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6. 11. 2013

+ In Animation und gedimmten nicht-
movern wird die schrift der "mover"
im

nun Vordergrund gehalten

+ Einfaches Hvperlink Hilfetext
System mit File "help.txt" unter "Help"

erreichbar mit ein bisschen Text als
Beispiel

18. 11. 2013

+ Einstellbarer Timer zum Verzoeaern
vom Mapdownload Start waehrend
Karte

verschieben, wer so vermeiden will,
dass in hohem Zoom der Streifen an
Karten

entlang der Beweaunq durch die
Botanik geladen wird. Config / Timers

+ Index Taste im Help Fenster

+ Schutz vor ewia loopenden
Mapndownloads wenn durch zB volle
Platte oder nicht

identischem Schreib/Lese-Pfad
immer die aleichen Karten
angefordert werden.
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Kommt ein Kartenteil immer wieder,
— wird nach ein paar Versuchen 1. nur
mehr

1 Karte anqgefordert, 2. die Pause
— zwischen Anforderungen immer
Verdoppelt

und 3. poppt eine Fehlermeldung
auf.

+ Copyv/Paste hinein ins Proaram
— (rechte Maustaste im Textfeld oder
ctrl-v)

(bei linux jetzt mit dem aktuellen
— '"keiner verstehts..." selection-
Verfahren)

- 22.11. 2013

+ "Ok" im confia-Zeileneditor
— schliesst das Fenster nach dem
Speichern.

+ Map download Timina (im
— Fehlerfall) optimiert, dass mit dem in
entwicklung

befindlichen hochaeschwindiakeits-
Downloader von oe5krn bei falscher

Einstelluna oder voller Platte keine
— "Gigabvte" ins Nirvana geladen
werden.

— 28.11. 2013
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+ "B" und "M" (aross) fuer
Bakeneditor und Message senden

— + Index bei Helptext

+ Umfanareicher Baken/Objekt/Item
Editor mit verschiebbarem Fenster,

Import von vorhandenen Objekten
auf der Karte durch anklicken.

- Testen lokal vorm Senden.

Einmal senden oder mit Timer und
— Verschiebung der Sendezeiten, dass
die
Duplikatloeschung in den lagates

Sendungen mit gleichen Inhalt aber

verschiedener Frequenz (oder direkt
per tcp) im Netz sichtbar laesst.

Einfaches Fernloeschen von Items
und Objects.

Normal/Mic-E/Compressed mit DAO
Erweiterung fuer 20cm Genauigkeit

(die aber ie nach
— Fliesskommaarithmetik nur etwa 1m
schafft)

mit Bvtezaehler der Gesamtlaenae
— beim editieren der Kommentarzeile
zum

- optimieren der Kompressionsart.

Macros zum Einfuegen von Files zB
fuer Wetterbake
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+ Queryv standard Antworten (?APRST
...) vorkonfiguriert mit opt-out wers

nicht will. Config > Rf Ports > Query
Keywords

+ Fehler behoben, Decodieren von
Items mit kurzem Label.

Unsichtbare User weaen keinem
— oder falschem Symbol (die aber
trotzdem

watch/approxv-piepsen) haben nun
Label und Track

+ Listinas im "Show 1 Modus" zeigen
nun nur was zu dem User gehoert

- 4.12.2013

+ Confia > Rf-Ports > Monitor
Headline

Damit kann man 0 bis 20 Calls +
Tempertur oder km/h als "Ticker"

von aktuellen Frames auf der
— Fenster-Ueberschrift durchlaufen
lassen.

Bei minimiertem Fenster ist das
aktuellste Call in der Taskleiste.

N> kommt von, N< aget ans Netz, 1>
2> Funkports, N- heisst der Frame

ist entweder in den Callfiltern oder
ohne verwertbarem Inhalt.
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+ (arosses) "F" Shortcut Find (Call,
Locator, Breite/Laenge)

+ Bakeneditor "Draw" schreibt
nimmer ins rawlog

— 10. 12. 2013

+ Calls + Temp,km/h,Hoehe der
— ankommenden und abgehenden
Daten in der

Fenster-Kopfzeile. Anzahl der Calls
Config>Rf-Ports>Monitor Headline.

Updaterate auf (Mittelwert) 1s
limitiert.

+ Maus-Verhalten umagestelit
(aehnlich anderen Programmen).

Linksklick wartet auf Maus-
— Bewedgung (mit ein bisschen Zitter
Toleranz)

und zieht Karte (auch wenn ein
— Svmbol getroffen) oder, am oberen
Rand

anaefasst, konnen einiage Menues
— und die Status-Bar positioniert
werden

mit "ankleben" an den Fensterrand
und gespeichert in aprsmap.cfg.

Beim auslassen der Maustaste,
— wenn nicht bewegt, wird der normale
Klick
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- ausgeloest.

Mittlere Maustaste zieht alles was
ziehbar ist und an beliebiger Stelle

- angefasst.

Rechte Maustaste wie bisher Back-in-
zoom-History oder in einer

Texteinaabe "Paste" (falls was im
copy/paste Puffer ist)

- 15.12. 2013

+ Messade Senden nun bis 67
— Zeichen wie im Protokoll vorgesehen
statt 57.

+ Umlautwandler auf "Ae Oe Ue ss"
— (bis mal ein 8 Bit Zeichensatz
definiert ist).

+ Messadae Eingabezeile geleert wenn
— die vorherige Message abgeschickt
wurde oder

an ein anderes Call als zuvor
gesendet werden soll.

+ Schnelles Zoomen mit Shift-
— Linksklick und Rahmen um den
gewuenschten Inhalt

- aufziehen.

+ (nur Linux) ipea-Dekoder fuer Maps
wobei erst .png versucht wird dann
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ipeq in .png Filenamen und zuletzt
jpeg als .jpg (gm.sh modifizieren).

- 16. 1. 2014

+ Confia / Online / Serverfilter
— Aenderungen werden bei "Ok" sofort
zum

Server geschickt. (sofern der die "#
filter ..." Syntax versteht)

+ mit "<" ">" durch einen Track
— wandern aeht mit gleichzeitig
geoeffneter

Altitude- und Speed-Statistik und
zeigt dort die Stelle am Track und die

- Messwerte numerisch.

+ Tools / List neu mit verschieb-
maximier-, ikonisierbarem Textfenster

mit Scrollbalken (und Cursortasten
und Mausrad) und nach Zeit und

- alfabetisch sortierbarem Inhalt.

Es kann Rohdaten und dekodiert
— listen. Text kann man markieren und
mit

"Paste" in andere Anwendungen
— kopieren (auch auf Win ohne
umstaendlichen

Dialod). Gibt man in Tools / Find ("F"-
Taste) ein Wort ein, werden alle
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aleichnamiagen Stellen farblich
— hervorgehoben zB. "APLMO1" oder ein
Call.

Klickt man auf eine Zeile, wird auf
der Landkarte die Herkunft gezeigt,

sofern die Zeile eine Position
enthaelt und wenn nicht, die letzte

bekannte Position vom Absender der
Zeile.

Das Live-Monitor-Fenster fuer
— empfanaene und gesendete Daten
hat anstatt

sortieren "CIr" fuer Inhalt loeschen,
es stoppt raufscrollen wenn man

mindesten 1 Zeile herunter
— daeschoben hat, und kann mit "u"-
Taste an und aus

aeschaltet werden. (Beachten: bei
Batteriebetrieb durch den laufenden

Bild-Update evtl mehr CPU
/Akkuverbrauch)

Das Aktivieren des Monitors ist, bis
— eine selbsterklaerende Menue-
Struktur

erfunden ist, noch wie zuvor unter
Config / Rf-Ports / Monitor Frames.

+ Linux: F1l1l-Taste (bei "seltsamen"
— Fenstermachern die selber kein
Maximieren

oder dann wieder kleiner machen
koennen) toggelt Fullscreen/Normal.

+ Win: Kein extra Textfenster mehr
da Listings eingebaut.
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— 20.1.2014 (Ver 0.32)

+ Funkport (Soundmodem / udpflex)
Kommandozeile in Config / Rf Ports /

- Serial Interface

- Task wird automatisch gestartet.

+ Monitor Ports off/raw/decoded
— einzeln mit Klick schaltbar Tools/List
/Monitor.

— 3.2.2014 (Ver 0.32)

+ Message Rx: Schalter fuer Pop-up
Fenster

Schalter fuer zeigen von
Messages an andere SSID

Schalter fuer Messadges an
sich selber weg filtern (default on)

— 6.6.2014 (Ver 0.34-testversion)

+ Hohendaten (soweit in einem
Datenfile vorhanden)

bei "show Location of Mouse" "on"
werden m ueber NN angezeigt

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice Seite 101 von 197



BlueSpice 4l

APRSmap Release notes

ebenfalls neu, Distanz und Winkel
zum Marker 1 wird angezeigt

- Files zum selber besorgen:

- osm/srtm3/N48E012.hgt

- N48E013.hgt

(90m aufloesung, 1x1 grad 2.8
MByte pro File

http://dds.cr.usas.aov/srtm
/version2_1/SRTM3/Eurasia/)

- osm/srtm30/W020N90.DEM

(900m aufloesuna, 20W..20E, 40
bis 90N 57Byte, deckt den Rest ab

http://dds.cr.usas.gov/srtm
/version2_1/SRTM30/)

osm/eudem/ (noch nicht
implementiert)

30m Aufloesuna, 640MByvte fuer
— 5x5 arad, braucht aber erst
konvertierprogramm

vom (unbrauchbaren) "eu-geotiff"
in lesbares Format

http://www.eea.europa.eu/data-
and-maps/data/eu-dem#eeaEsriMap

+ Radiolink Berechnuna zwischen
— Marker 1 und 2 nach Eingabe von
Antennenhoehen
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und Wellenlaenge. Vorerst mal
— Darstelluna auf der Map als farbige
Fresnelzone

"blau" frei, "aelb" bis "rot" von
— anaekratzter 1. Fresnelzone bis voll
verdeckt.

+ Radiolink mit 2 Klicks oder fuer
tastaturlose Bedienung

"On next click to Map" mit "Set
— Marker 1" beim 1. Klick und Marker 2
bei weiteren

Klicks nach "Clear Markers" wird
wieder erst Marker 1 gesetzt.

+ "d" Shortcut fuer Map downlod on
[off

+ Map download auch wenn auf "off"
— wenn "Reload" oder die Download
funktion

- betaetigt wird.

+ Testweise "Hiah Resolution Track"
— Dekodierung als Protokollerweiterung
eingebaut.

Dabei werden mit einer Bake 2 bis
— 30 Positionen aepackt als
Abweichung von einer

Geraden 2 oder 3 dimensional +
— Timestamp uebertragen. Wird die
Erweiterung nicht

erkannt bleibt die normale Position
pro Bake.

Die Optionen sind erweiterbar,
— Positionsaufloesung, End-zu-End
Pruefsumme,
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"QRV"-Freqauenz, direktaehoert von
— laate, Climb-Rate und fuer Wanderer
hoehere

Geschwindigkeitsaufloesuna sind
— mal voraesehen. Traegt sich der
direkthoerende

lgate ein, wird vom Aprsis-Service
— eine veraenderte Kommentarzeile
erkannt und

damit ALLE lgates ersichtlich, die
— direkt gehoert haben und nicht nur
der mit

der schnellsten Glasfaser
— Anbinduna. Dekodiert wird dabei eine
in vom Empfangsmodem

in Klartext umaesetzte Darstelluna
— fuer Aprsis. Am Funkweg wird binaer
und wesentlich

- kleiner gepackt iibertragen.

— 13. 6. 2014 (Ver 0.35-testversion)

* osm/srtm1/N48E012.hat mit 30m
horizontaler Auflésung aus den EU-
DEM Daten umformatiert in das srtml-
Format wird bevorzugt verwendet.

* UDP-Ports restarten sich wenn beim
Editieren was verandert wurde.

* Map Loader startet beim enabeln
ohne nochmal herumzoomen.

* Speed/Altitude/Gelaendeschnitt-
Diaaramm updatet sich mit

— ankommenden Daten wenn mit
letztem Weapunkt oder Symbol
anklicken geoffnet.
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* laate (Rf to Net, nur Linux) jeder
— UDP Port kann einzeln freigeschaltet
werden

* Gelandeschnitt, Darstellungs-
Versuch mit zusatzlichem Freiraum-
Diaaramm auf der Landkarte.
Praktisch zum Zoomen aber evtl.
missverstandlich da nur die Fresnel-
Zone zur Karte passt und folalich die
Punktreihe, die die Bodenhoéhe
darstellen soll, nicht.

— 17. 6. 2014 (Ver 0.35-testversion)

* Sichtweiten Farbkarte, mit Marker 1
oder 2 oder beiden gesetzt, wird mit
"R"-Taste die optische Sichtweite
dargestellt. Antennenhoehen am
Marker ist 1. Wert in "Tools
/Radiolink"” am andern Ende qilt Wert
2. Die Wellenlaenae wird hier auf 0
agesetzt und damit ist ab halber
Fresnelzone "Sicht". Farbhelligkeit in
"Confia/Map Parameter/Brightness
Rfpath" Die Berechnung ist noch
experimentell und sollte nach
optimierung deutlich schneller
werden und damit man die Landkarte
noch lesen kann brauchts noch
Darstellungs-ideen.

— 28. 6. 2014 (Ver 0.37-testversion)

* Marker setzen mit Einrasten auf die
aenaue Position eines anaeklicktes
Obijekts (More Infos> ) und ohne
Einrasten im Zoom Menue. Dort auch
Marker einzeln Ioschbar. Marker 1 als
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— "hart (agelb)" oder "weich (blau)",
letzerer entsteht durch einfaches
Anklicken, beweat sich mit fahrenden
Obiekten bzw. huepft auf neu
anaeklickte Objekte oder Weapunke
und hat ein Timeout. Harter Marker
bleibt bis I6schen.

* Netz/Funkport Status-Laempchen
zeigen nun letzte Sendunaq (gelb) und
letzten Empfang (griin) seit 60s als
Sanduhr.

* Mausrad (oder Zoom-Menue +/- mit
Shift) Zoom Stufen (Confia/Map
Moveina/Fine Zoom Steps) rastern

— nun die automatischen
Zoomvorgaenge auf die eingesteliten
Werte insbesondere auf "1" also
original Osm-Stufen.

* Ausaeschaltete Tracks (Helligkeit
auf 0) machen nun auch Funkwege
und Zoom auf das was man noch
sieht.

— 1.7.2014 (Ver 0.38-testversion)

* Watchliste neu mit Schalter fuer
Pieps / Landkarte mitbeweaen /
Loafile zB. mit OE* getrennte Lodfiles
fuer jedes Call mit OE vorn schreiben.

* Shift-Click auf Rf-Port-Knopf geht
direkt in Config-Editor.

* Portname nach dem Port-URL zeiqgt
in "i"-Liste und beim "Hovern" auf den
aktiven Portknopf Namen und ip
Nummer.

* On Next Click to Track mit "Zoom
to" schaltet erst in den 1 User Modus
und tut dann (nun hoffentlich) die
anderen aktivierten Dinge.
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3.7.2014 (Ver 0.38-testversion)

* Baken sollten sichn nun auch mit
den "\\" Macros wieder in den Editor
laden lassen ohne dass diese
expandiert werden. (Vorhandene
Objekt-Baken neu eingeben)

* Messaae Routing verbessert mit
automatischer "NOGATE"-Option
wenn nur Funkports verwendet
werden

* Messade und Baken Sende-Meldung
und Rueckfrage wenn man (meist
versehentlich) Leerzeilen Msg senden
will.

4. 7. 2014 (Ver 0.38-testversion)

* Lodfile loeschen bzw. Filegroesse
anzeigen

* Etwas mehr "On Next Click"-
Optionen kombinierbar

8. 7. 2014 (Ver 0.39-testversion)

* WX arafik zeiaen auch wenn WX
Baken ohne WX Daten dabei sind

* Schalter fuer nur WX-Stationen auf
der Karte zeigen
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— 17.7. 2014 (Ver 0.40-testversion)

* Nur WX Stationen auf der Karte
Zeigen

* Relief Karten rechnen mit
Fortschrittsanzeiae und nach 4s
Abfraage auf Abbruch (mit srtm(1)
Files (Netzwerk-Laufwerk zu langsam)
und noch ohne Antialiasina was ab
zoom 12 sichtbar wird) map
parameter/brightness rfpath zB. "30
— 10050 1008020 0 100 100" (der 3.
Wert 0 fuer harten Kontrast
/Funkreichweite oder 500 fiir
aufpeppen von osm-Karten) tools
/radiolink "2000 0 0 200" marker 1
und evtl marker 2 setzen und "R"
"confia/brightness map" zum ein
/ausblenden der osm karte)

* Diagipeater (abaespeckte udpbox
derzeit noch ohne klicker-Editor und

— nur arob agetestet) Confia/Rf-Ports
/Diaipeater, derweil Internes Format
mit Zeileneditor bearbeiten.

* Messadge Sendetaetigkeit-popup-
Meldungen verfeinert und korrigiert

— 18. 7. 2014 (Ver 0.40-testversion)

* der Lodfile-Pfad fuer das rawloa
— wird auch fuer die Watchcall-Logs
verwendet

— 19. 7. 2014 (Ver 0.40-testversion)
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* Watchcall-Liste nach "longest-
match" durchsuchen. "OEOAAA"
passt bei * OE* OEQ0* OEOB* auf OEO*

— OE* +log / OE1X +log / OE1* nichts /
OE5A +beep schreibt loa von oe
ausser oel und oe5a aber schon oelx
und peept bei OE5A

* Call-Log FilegréBRe anzeigen und
Files l6schen

— 20.7.2014 (Ver 0.40-testversion)

* Cursor Up/Down Tasten in
mehrzeiligen Textmenues

* Tasten Fokus Lock auf Einaabefeld
nach Anklicken oder Tastatureingabe

* 1. Klick auf eine Zeile verandert
nicht die Kursorposition

— 25.7.2014 (Ver 0.41-testversion)

* Digipeater, mit fein dosierbaren
— Standard (mach QRG voll) bis "sehr
beruhigt" Optionen

* Editor dazu Config / Rf-Ports /
Digipeater und "Hints"

— 28.7.2014 (Ver 0.41-testversion)
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* Farbe fuer Schrift, Menues,
Hinterarund, Transparenz,
Radioranage, Reliefkarte mit

— Farbauswaehler (der noch 3eckia
werden soll damit umaekehrt auch
eingestellte Farbe drauf gezeigt
werden kann)

— 31.7. 2014 (Ver 0.42-testversion)

* Statusknopf zeiat durchgehend
wenn Wx/Temp./Reaen/Radiorange
oder sinale User Modus ist und kann
da ausgeschaltet werden.

— 24. 8. 2014 (Ver 0.42)

* "F"ind auf einen sonst unsichtbaren
Objekt-Sender zeigt dessen Objekte.

* "More Infos" zeiqgt Button "Objects
of Call" wenn Call Objekte sendet.

* Wx-onlv mit "L"abels off zeiat nur
— Temperatur und Windfahne beim
Symbol.

* Antennenwinkel bei Gelandeschnitt
Info.

* "DUPE" Meldunag bei Weapunkt-Info
— nimmer "ewiq" bei einer Fixposition
nach einem Ausreisser.

— 26. 8. 2014 (Ver 0.42)
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* ip-Nummer Schreiberei vereinfacht,
"127.0.0.1" kann weggelassen werden

* udpflex erweitert auf "net-kiss",
also kiss via tcp, damit es mit dem
dire-wolf-Soundmodem kann "udpflex.
exe -U :9002:9001 -T :" (http://home.
comcast.net/~wb2osz/site/ geht mit
default Einstelluna, Sampelrate sollte
man aber halbieren sonst ziehts
750MHz CPU)

— 15. 10. 2014 (Ver 0.43)

* Input Filtern auf Stichwort im
ganzen Frame

* kleines "e" oder "d" im Map-
expansion-Lampchen zeiqgt
automatischer Map Download off
(toagale mit "d"), Manueller Map
Reload/Download geht aber auch in
dem Modus.

* Im "F"ind Feld gaeht auch dezimal
Grad "48.2 13.31".

* bei den Confia Zeilen geht "Enter-
Taste" als Ok oder Add.

* Textfarbe vom Items/Objects mit
— Farbauswahler unabhaaniaq von
normalen Baken einstellbar.

* Fontaroesse Eingabe zeigt sofort
Ergebnis.

* jst ein Obiekt im "show 1" modus,
kann man mit "Focus" Karte
mitziehen einschalten ohne
Watchlisten Eintrag.
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* TAB-Taste schaltet zwischen 2
Kontexten hin und her, dazu zaehlt

— nebst Wetterkarten-Modi auch der
"Focus" Modus, womit 2 Objekte im
Bild gehalten werden kénnen.

* Baken/Messaqge/Ack Senden
Warnmeldungen verbessert, wenn
der einaestellte Sendepfad

— vermutlich nicht zum Erfolg fuehrt.
(Port ausgeschaltet, nicht zum
Senden konfiquriert, kein Passcode
am Internet ....)

* Gelandeschnitt, Reichweiten-, Relief-
— Karten Parameter in ausfihrlicherem
Menii zusammengefasst.

* Gelandeschnitt zeigt freie Meter
— zum Boden (Karte ziehen zum
Messmarke bewegen)

* Trackfilter beim Suchen auf
Duplikate mit Indexsystem so
verschnellert, dass beim aus dem
Speicher Entfernen von Weapunkten,
auch deren Folagefehler mit Entfernt
werden kénnen.

— 11.11. 2014 (Ver 0.45)

* Gelandeschnitt und Reliefkarten mit
einstellbarem Hohendaten Cache
damit Plattenzugriff auf etwa 0.5%
verringert.

* Schalter "kleine/mittlere/volle
— Aufloesung” entsprechend langsam
bis schnell.

* Interpolation der Hoehendaten und
damit brauchbare Bilder bis Zoom 14

* im "Find" Feld aeht Call / Sender of
Object / Locator / DDMM.MM / D.DDDD

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice

Seite 112 von 197



BlueSpice 4l

APRSmap Release notes

* Marker 1 setzen Sendet DDMM.MM
— zum c/p Buffer, Marker 2 D.DDDDD
Format.

- 9.12. 2014 (Ver 0.46)

* Watchcall Popup-Fenster anklickbar
und zentriert Map auf das Objekt

* Point-Of-Interest-File (osm/poi.txt)
mit Name/Position/(optional) Hoehe
— (als Beispiel ist ein File mit etwa
20000 mehr oder weniaer richtigen
Alpengipfeln vorhanden)

* mit "F" oder Tools->Find kann mit
Wildcards (ste?n*) auf die Namen
gesucht werden und die Karte

— zentriert auf die Position und setzt
Marker 1. Bei mehreren passenden
Namen mit Enter oder Klick auf Find
werden alle Positionen durchgesteppt.

* ist "p" oder Config->Map Parameter-
>Show Loc of Mouse auf ON, geht
beim Beweaen der Maus eine
Spnrechblase mit Zeiager zum
nachstaelegenen Poi auf. Mit "c" kann
die Karte drauf zentriert werden.

— 30. 12. 2014 (Ver 0.46)

* Marker 1 und 2 setzen ("x" "v") geht
ohne vorher auf die Karte klicken
aleiches bei Zentrieren "c" mit dem
Unterschied wenn ein POl maximal 5
Pixel entfernt anaezeiat wird, exakt
auf diesen zentriert wird.

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice

Seite 113 von 197



BlueSpice 4l

APRSmap Release notes

26. 1. 2015 (Ver 0.47)

* nebst "poi.txt" wird noch "mvpoi.
txt" gelesen damit beim Update bei
Bedarf die selber anaeleaten Punkte
erhalten bleiben. nun auch viele
SOTA-Standorte im poi.txt

* Loa File (rawloa) durch Anhaengen
von %d zB. "loas/rawloa%d" auf
tageweise 1 File mit Datum
umstellbar. Ist auch kompatibel zu
den Loas am www-Server. (Loa
Filename jetzt im "File" Menue)

* Bei tageweisem Log einstellbar nach
wieviel Taaen automatisch (beim
Start oder Mitternacht) Logs
geloescht werden sollen.

* im Loa suchen nach Datum und/oder
Call sollte auch dank "Load" (fir ab
eingeagebenen Datum) deutlich
zuverlassiger gehen.

* mehrfach eingetroffene selbe
Message wird nur 1x Angezeigt.

* Baken (Netzbake. Obiekte) konnen
Position aus File (auch in Grad mit
Komma) lesen fuer bewealiche
Objekte oder Mobilbetrieb.

* Baken konnen Text-Macro-File
loschen nach 1 mal Senden zum
Zweck des automatischen
Verstummens der Bake wenn zB das
Wetterhauschen nimmer Updatet.

2. 3. 2015 (Ver 0.48)
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* Nur Stationen mit einem

bestimmten Svmbol aufs Bild, Symbol-
Wahl in Tools / Select Data / Svmbol>.
On/Off mit "Svmbol" oder "s"-Taste.
Achtung: Screenshot Taste ist jetzt
TS

* Overlay Symbole mit Mausklick
eingebbar

— 6. 3. 2015 (Ver 0.48)

* Zoom-Lupe aufziehen mit rechter
Maustaste halten. Ohne Maus

— bewegen wie bisher Backspace in der
Zoom/Pan Historv oder (Copy/)Paste
in Texteingaben.

— 15.3. 2015 (Ver 0.49)

* Hover Info Popup (Tools/On Next
Click/Hover) auf den Symbolen und
Glaendeschnitt zu Marker 1 wenn
Tools/Radiolink enabled.

— 24.3. 2015 (Ver 0.49)

* Linkstreckenberechnuna mit
— einstellbarer Beuqguna (refraktion)
der Hf in der Atmosphaere.

— 15.6. 2015 (Ver 0.49)
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* "H" fuer Hoehendaten
Farbdarstellung.

* Cache auch fuer nicht
vorhandensein von Hoehendaten
damits schneller mit Loechern im
Datenmaterial zurecht kommt.

* poi.txt ohne Neustart einlesen mit
"Reload Config".

* Wx Radioaktivitaet dekodieren und
(vorerst) als Text ausgeben.

— 21.6. 2015 (Ver 0.50)

* Maidenhead Locator Ausgabe
— lanaes Format, Eingabe "Find" 6 8
oder 10 stellig.

* Treiber Aufruf fuer Soundmodems
und (USB-)serielle kiss/smack TNC
/Funkageraete
betriebssvstemspezifisch
voreinagestellt (sofern noch kein
aprsmap.cfg vorhanden ist).

* Popup Fenster Ueberlappungen
etwas seltener.

* Radioaktivitaet (Sievert)
— Dekodierung in den Wx-Baken
(vorerst ohne Grafik)

* Getrennte Backspace/Rechte-Maus
History fuer beide TABs

- 27.6. 2015 (Ver 0.50)
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* etwas verbesserte popup Fenster
Platzierung.

* Confia > Map Parameter > Reset to
Default oder kurz "D" stellt die
meisten Bildparameter und
Klickverhalten auf Default. Die alten
Werte aehen zuvor in die Backspace
/rechte Maus-History zwecks Undo
der Funktion.

* Historv/TAB speichert die
wichtiasten Bildparameter +
Kartentyp.

6. 7. 2015 (Ver 0.52)

* Parameter Reset "ctrl-L" statt "D"

* dekodieren und darstellen vom Area-
Obijects, Kreis, Ellvpse, Rechteck,
Dreieck, Linie (ohne Corridor) gefuellt
oder leer in 8 Farben nach APRS101.
pdf.

* Baken Editor erstmal fuer
numerische Eingabe der Area Objects.

* dekodieren und darstellen von
Multiline-Obijects mit 3 Linientvpen
und 4 Farben nach AE5PL 1-23 Linien
pro Bake geschlossen oder offen.

* Anklicken aller Linien und Flaechen
am Rand und Verhalten wie normale
Obiekte aber ohne Track bei
Bewegung.

8. 7. 2015 (Ver 0.52)

* Multiline-Objekt Editor
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— 25. 8. 2015 (Ver 0.54)

* Mic-e-Telemetrie Dekoder, die
Herstellercodes aus den Mic-e Frames
— werden dazu vorher entfernt (soweit
es aeht) was auch sauberere
Kommentarzeilen ergibt.

— 16.10. 2015 (Ver 0.56)

* Wetterbake (Netbeacon, Rf Beacon,
Query) aus .csv File

\!wx.csv,,.t,,,,,h,b,r,w.d,,,,,a! im
— comment extrahiert die Werte aus
der letzten Zeile

im File wx.csv. Es kann noch ein
— Multiplikator angegeben werden zb. ,
w3.6, statt ,w, zum

Umrechnen von m/s auf km/h. Werte
siehe Hints. Wx Symbol auswaehlen.

* Messadges/Queries bei 9-stelligem
— Mycall sollten nun bestaetigt
/beantwortet werden.

— 24.11. 2015 (Ver 0.58)

— * Wx Grafiken korrigiert

* Schaltknopf/Laempchen fuer
Objekte Ein/Aus
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* Gate Net-to-Rf mit Radius und Bit/s
Limit und Option nur Messaae zu
(aehoerten) Usern (mit Standard-3rd-
partyv Protokoll und ohne speichern
/wiederholen von Messages).
Einschalten mit Confia/Rf-Ports
/Digipeater, Rx auf "N", Bit/s in "N-n
Words" siehe Hints.

28.11. 2015 (Ver 0.58)

* Starten ohne "terminal" und
Abstellen sollte ohne X11
abschmieren gehen.

* UDP Ports an und abschalten auch
mit laufendem "serial interface".

29.11. 2015 (Ver 0.58)

* Historv bei der "Find" Zeile mit
Cursor up/down.

* Rf-Monitor mit Txdelayv, Level und
Quality, sofern vom Modem geliefert
(afskmodem linux).

* Fenster Kopfzeile "nur neue" Calls
(Confia/rf-ports/monitor headline 0)
und Zeit seit letztem mal gehort(1).

7. 1. 2016 (Ver 0.59)
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* "Storm Data" Auswertung und
Flachen-Darstelluna mit interpolierter
— Animation. (manaels Aktueller
Testdaten nach APRS101.pdf in
nautischen Meilen 1.609km)

* Area-, Multiline-, Sturm-Objekte mit
"<>" durchsteppen mit zum
Weabpunkt aehorender
Flachendarstellung.

— 23.1.2016 (Ver 0.59)

* |tem in Messaades, (B)akeneditor
(auf “lItem") + (M)essadge Send
Fenster geoffnet kopiert den
Bakeninhalt in Messaae Text und
erzeugt dann beim Empfaenger der
Msa ein Svmbol auf der Karte.
(APRS1.2) Da sich die
Protokollerweiterunag Item-Message
und Multiline-Object aeaenseitig
beissen ("{" svymbol), aeht die
Kombination vermutlich nur mit
aprsmap + send with ack.

— 25.5.2016 (Ver 0.61)

* Obiekte ohne Richtunag und
— Geschwindigkeit zeichnen keinen
Track mehr.

* alle alternativ Symbole koennen
Overlay Zeichen haben (a..z A..Z 0..9)

— * Hamnet Symbol in symbols.png
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15.3.2017 (Ver 0.64)

* Trackfilter aeht bei mehr als 15000
Weapunkten nimmer gegen
Rechenzeit unendlich.

* Trackfilter wird auch mit den
kleinen Zappeleien bei
Verzoegerungen unter 1Min fertig.

* "Find Item Messaae" zeiat auch bei
mehreren solchen Msgs die dazu
passende Position.

5.4.2017 (Ver 0.65)

* Rotes Fehlermelduna-Popupfenster
aroesser und umfangreicher bei der
Baken Eingabe.

* mit [1-Tasten Zeit aendern wie lana
Dinge auf der Karte sichtbar bleiben.

25.5.2017 (Ver 0.66)

* Kontrast der Symbole verbessert.

* Fenster zu klicken sollte bei vielen
Linux-Fenstermachern wieder
geeordnet abstellen.

* Linux 64bit Version.

5.7.2017 (Ver 0.67)
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* langen Locator suchen korrigiert
und Kleinfeld Darstellung

* udpflex (linux) tcpkiss server

29.9.2017 (Ver 0.69)

* Helligkeitskorrektur (Tools > Add
Maptvpes) als Gamma Werte statt +-
Helligkeit. Bei Bildschirm-Gamma
(Confia > Brightness) 2.2 entspricht
0.45 original und 0.3 etwa dem
bisheriaen -128. Die Werte werden
nun bei Kontextumschaltung mit TAB
mit dem Kartentyp gespeichert.

01.12.2017 (Ver 0.70)

* Kartentypen mit Gamma-Korrektur
statt Helligkeitskorrektur. (Tools >
Add Maptvpes) solanqg ein
Hellikeitswert konfiguriert ist, wird
default 0.25 anaewendet. (Sinn der
Sache: Sat Map von Sentinel2)

* Eingestellte Karten Helligkeiten
werden individuell fir Kartentvpe
agespeichert. (Sat Maps sind bei 100%
ok, OSM karten eher bei 20 bis 40%)

* "6" schaltet alle aktiven
Kartentypen im kreisrum durch.

* Font von 7x6 bis 24x12 und
zoombare Svmbole 16 bis 32 aus
svmbol file 16 bis 48 Track und
Weapunkte werden mit angepasst.
(Zweck: hochaufloesende Bildschirme)
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* Neue Fontfiles und Symbolfile mit
teiltransparenten Svmbolen (wird
noch verschonbessert ...) beim

— Svmbol Zoom wird erst versucht ein
zur Grosse passendes svmbolsXX.png
zu laden falls nicht vorhanden wird
"symbols.png" gezoomt.

* Weicher Alpha-Kanal (Transparenz)
— bei den Symbolen (win: neue "pngm.
di)

— 09.12.2017 (Ver 0.71)

* win: jpeam.dll damit werden auch
— OSM Karten im inea Format gelesen
(auch mit Filename *.png)

* win: getosm.exe (dank an oe5krn)
neu mit "getosm.ora" start Datei im
— zip und ohne "getosm.ini" damit bei
Proarammupdate OSM-urls nimmer
uberschrieben werden

* Urls mit .ipa hinten kénnen
eingegeben werden

* Konvertierung auf pna kann
— abaeschaltet bleiben, spart
Plattenspeicher

— 12.02.2018 (Ver 0.72)

* Lodfile laden (besonders mit 270000
Baken Track drin) verschnellert.

* Svmbole-Zoom verbessert und %
Eingabe als 3. Parameter bei
Confia>Font>Fontsize fir
Symbolgroesse/Texthoehe Verhaltnis
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— 15.03.2018 (Ver 0.72)

* Linux 64bit Copv/Paste Absturz
behoben (hoffentlich)

* Refraction Parameter wirkt auch bei
Radiolink Ausleuchtung

— 12.07.2018 (Ver 0.74)

* Neue-Version-Check Funktion mit
— shell/BAT script falls wer einen dazu
passenden www-server baut.

* Radiowellen
Ausbreitunasberechnung um

— Streckendaempfuna und
Antennendiagramme aus Hersteller-
Files erweitert.

— 07.10.2018 (Ver 0.75)

* Fehler beim Lodfile importieren und
nach Uhrzeit sortieren behoben.

- 12.10.2018 (Ver 0.75)

* poi.txt aus Hamnet-db und Foto-
webcam Daten aktualisiert.
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* "P" rechnet mit Refrac (0.13 Licht,
0.25 Funk)

— 17.11.2018 (Ver 0.76)

* Poi-Files mit beliebigen Namen in
osm/poi/

* Darstellunag eines Info-Fensters bei
— Maus nahe einem Poi sofern Info
enthalten.

* Auswahlmenue "C" oder "Tools
/Select Data/Show POI" zum Zeichen
von einstellbaren Svmbolen eines
oder mehrere Poi Files. "I" (= kleines
"L") schaltet Labels ein/aus. Dazu
Text-Filter im Namen oder Infofeld
zum eingrenzen der Auswahl mit "*"
und "?"

* Marker setzen mit Fanaen der
— Position des nahen Poi mit "X" und
"Y", ohne Fangen "x" "y".

— h264 in mpeg4 Container:

Linux: 1 mal machen: mknod
map.ydm p

fuer jedes Video starten: x264 -o
— film.mp4 --muxer mp4 --crf 22 map.
ydm

- <Make Video>

win: File / Make Video qgibt
unkomprimiertes Videofile map.y4m

(.vdm sollten mplayer oder vic
abspielen koennen)
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klein packen mit x264.exe "x264 -o
— film.mp4 --muxer mp4 --crf 22 map.
ydam"

(crf=22..27 qualitaet gut bis
sparsam)

vorher mit Animate und auf Man
— klicken passende Geschwindigkeit

einstellen
— files/dirs:
- aprsmap programm
aprsmap.cfa beispiel confia,

— wenn nicht vorhanden werden default
werte erzeugt

hints.txt tipps beim verweilen
mit der maus auf buttons

help.txt Hvperlink-Hilfetext
unter Help > Helptext

am.sh shell script zum osm
karten holen

(aeht nun auch mit der
busybox am tinycore) ./gm.sh

(darf/soll verbessert

werden HI)
- symbols.png icons
- font.png buchstaben
gettiles vom aprsmap erzeugte

liste fehlender map tiles

rawloa timestamp+anprsis
— format wenn vorhanden beim start
eingelesen

bei connect zu aprs
server kommts neue dazu
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dargestellt werden die
— eingestellten minuten vom ende des
logs

mit connect zu server
eingestellte minuten von jetzt

file darf editiert,
beschnitten, gefiltert werden

wird nach timestamp
sortiert eingelesen

(lanaes file einlesen geht
mit serverconnect schneller

da erst ab "jetzt-
darstellzeit" decodiert wird)

- osm/tiles/ karten im osm format
- osm/tiles_sat/
- osm/tiles_topo/

udpflex axudp<->kiss/smack
/flexkiss interface fuer TNC, TMx7xX ...

kisson.txt kiss initialisierung
fuer TMD72 mit udpflex

aetosm.exe Win: Schneller
Maplader von OE5KRN

- poi.txt globales/privates
mypoi.txt Points-Of-Interest-
— File mit aktiviertem "p" zum zeigen
bei

Mauszeigernaehe oder
Suchen mit "F"

— oebdxl

[[IDXL - APRSmap | << Zuriick zur DXL-
APRSmap Ubersicht]]
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Aktuelle Version vom 9. August 2020, 23:41 Uhr

https://oe2wao.info
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APRSmap Release notes und DXL - APRSmap: Unterschied

zwischen den Seiten

VisuellWikitext

Version vom 2. Dezember 2018, 17:26
Uhr (Quelltext anzeigen)
OE2WAO (Diskussion | Beitrage)

Zeile 1:
[[Kategorie:APRS]]

— *libpng und libz statisch dazu gelinkt +

* font symbol und OSM karten nun im
png Format

* 4 Kursortasten zum
Karteverschieben und Backspace fiir
letzte Position(en) (sofern die bei
allen x11 gleichen hexcode haben)

* OSM Karten in Unterverzeichnissen
— nach Zoom Faktor 1..16 vorhandene
maps loschen oder einsortieren

* wenn Files fehlen wird sofern
— vorhanden die mit dem nachste
Zoomfaktor gedehnt eingesetzt

* ./am.sh starten bzw anpassen nach
Bedarf zum Kartenholen

* linke Maus auf Karte klicken oder
auf Track oder Svmbol 6ffnet Menii,
— viele Funktionen mit Klick erreichbar
aber noch nicht alle Menus, noch
chaotisch aber mal zum Testen

* Wettergrafik + statistik auf x11
abrufbar

— * ESC taste zum Menisschliessen

* Funktion der Klicks auf svmbol/text
/map/track getrennt konfigurierbar

* 5 watch calls (ohne wildcard) statt
"follow car"

Aktuelle Version vom 9. April 2021, 09:
08 Uhr (Quelltext anzeigen)
OE2WAO (Diskussion | Beitrage)

K
Markierung: Visuelle Bearbeitung

Zeile 1:
[[Kategorie:APRS]]

[[Kategorie:Digitaler Backbone]]
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* Wwettersymbol etwas besser
anklickbar (svmbols.pna) (alpha

— Kanal nach heller verschoben, sollte
mal nach 255 wenn alle Symbole
dafiir adaptiert)

* rechte Maustaste = BACKSPACE
— (back in zoom/pan-historv) (bei www
Version lokal back am Browser)

* map move steps teil der
Fenstergrosse

6.1.2013

* Marker auf "Next click to Map": ohne
Einrasten auf Svmbole "Next click to
Svmbol oder Text": mit Einrasten auf
genaue Position wenn vorhanden

— * Marker lIéschen und keycode "@"
— * zoom to markers wieder da "Y"

* kmh Histoaramm und Animation
— entsprechend der eingestellten
Sichtbarkeitszeit des Tracks

* blaue popup Meniis sortiert nach
der GroBRe angereiht von links oben

* "Expandes Tiles" geht auch weg
wenn alle tiles 1:1

— * call in die watchlist mit click

- 7.1.2013

[[Datei:Enalisch.ipa | link=DXL -
APRSmap enalischl] For enalish
version on this project [[DXL -
APRSmap englisch | >>click here<<]]

[[Datei:Aprsmap-download.ipaq |
link=DXL - APRSmap Download]]

:<code>""'Aktuelle Programmversion
v0.79'"'</code>

==Einleitung==
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APRSmap ist ein von '""OE5DXL
Christian'' entwickelter,
<u>kostenloser</u> APRS Client mit

+ .
arafischer Oberflache, welcher als
Basis das Kartenmaterial von
[http://www.osm.org OSM] benutzt.
* Taste "@" umgewidmet auf "on + [[Datei:Aprsmap.pngll
click" Reset
— *Taste ":" loscht beide Marker
* 30s lanager Retrv Mechanismus zum
Tiles Laden, sobald "aettiles"
aeloscht, ie Sekunde 1 Ladeversuch
— aller benodtiaten oder expandierter
Tiles und was fehlt oder "png error"
hat wird erneut im "gettiles"
angefordert.
+ ==Features==
7.1.2013 + *OpenSource und bereits fertig fir
Windows und Linux compiliert
+ *100%iae Einhaltuna der aktuellen
APRS Protokoll Vorgaben
+ *Keine Installation erforderlich, nur
kopieren und starten
+ *Keine uberfliissiaen Menius, Fokus

auf der Darstellung

*|P-basiert, somit out-of-the-box
+ netzwerkfahig im HAMNET sowie
Internet

*Bedienung idealerweise tuber
Shortcuts

*Lokale serielle Anbindunqg (TNC)
moglich - Betrieb als HF IGATE
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*Zur Darstelluna konnen mehrere
Mapsources verwendet werden. Stand

+
ardmagia ist dies OSM -
OpenStreetMap

+ *Trackfilter fur verzogert/verspatet

/wiederholte Pakete "f"

*Gelandeschnitt und
+ Funkausbreitungsberechnung (ab v0.3
6) IIRII

*Animation von Tracks mit Zeitleiste

*Animation der Temperaturverteilung
IIWII

+ *Messaging

* Tasten "<" und ">" entsprechend ==[[DXL - APRSmap Bedienung |
"Debua Track" raw+decoded Text der + Bedienung und Hilfell==
Wavpoints oder Baken durchsteppen

und setzt Marker 1

— * Backspace history size 20 statt 10

[[DXL - APRSmap Bedienunaq |
+ Bedienungsanleitungl]l - Die Hilfe
beim Umgang mit dem Programm

10. 1. 2013 [[Datei:Aprsmap-1st-start.jpg |
+ link=DXL -

APRSmap_Bedienung#Erste_Schritte]
1

* Tasten < > getauscht und Textinfo + ==[[DXL - APRSmap Download |

bleibt sichtbar Download]]l==

* Click to WxSvmbol neu und dort [IDXL - APRSmap Download |

dann entweder 1 nicht-Wetter APRSmap Download]] - Fiur Windows,

— Messwert oder beliebiq viele +  Linux und ARM (Raspberry Pi)

Wetterwerte zualeich ein/aus
schaltbar (Meniu bleibt offen)

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice Seite 132 von 197



BlueSpice 4l

APRSmap Release notes

14. 1. 2013

* Letzter Wettermesswert in der
Kopfzeile der Wettergrafik

* Wetterarafik passt sich der
Fensterbreite an (ab 320 Breite)

* Raw+Decoded Fenster bleibt trotz
"Marker to Klick" Messdaten Fenster
offen

16. 1. 2013

* Decodiert positionless WX Daten

* Decodiert negative NN im "/A="-
Format

* Zoom to Markers geht auch bei
Zoomlevel>14

* Fractional Map Zoom rechnet etwa
2x so schnell und richtiger

* Shift-Taste bei Map Move macht 1
/10 Schrittweite

[[Datei:Aprsmap-download.ipg |
link=DXL - APRSmap Download]]

==Referenz==

Das Proaramm APRSmap wurde flr
den OVSV Innovationspreis 2013
nominiert.

==Weitere Projekte==

Weiter passende Proiekte von
OE5DXL aus dieser Serie sind

*[[DXL - APRStrackerl] - Hard- und
Software fiir einen minimalistischen
APRS Tracker

*[[TCE Tinvcore Linux Proiektl] - Der
machtiage und innovative Digipeater
fur APRS, Packet Radio, Echolink, u.v.
m.

==Weblinks==

Kurzlink hier her: http://aprsmap.oevsv.a
t
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* Shift-Taste bei Zoom (derzeit nur
mit Maus) macht 1/10 Zoom Schritte

— 20.1.2013

* Klick auf Track mit Raw+Decoded
fur den Geklickten Wegpunkt

* Raw+Decoded mit Weapunkt
—  Nummer / Gesamtpunkte zur
Orientierung wo man ist

* Cut + Paste Puffer wird mit
angeklicktem Call gefiillt

— * Paste in Texteingabefelder

* leider aeht beides nicht nach
aussen weil die Fenster heute mit
"selections" miteinander telefonieren
und das ist etwa so aufwendiqg wie
das gesamte Interface zum X11 bis
jetzt

* (derzeit noch nicht ein
/ausschaltbares) Textfenster mit
Scrollbalken fiir lanae Texte. Zum
Test mit Rawdaten von tcp connect.

* nach 4 Taagen Suche noch nicht
gefunden wie man Kill des Fensters
abfanaen kann ohne dass dabei alles

— abschmiert. Da auch die aanzen Xlib
Aufrufe zum Text reinzeichnen keiner
auf Windoof/sontswas portieren wird,
wirds wieder abgeschafft.

- 26.1.2013

— * Textfenster mal wieder weg
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* rawloq File wird nun auch nach dem
Einlesen aeschlossen und wie bisher
beim Schreiben fiir jede Zeile neu
geoffnet

* Marker 1 zu klick misst, wenn gaenau
1 Obiekt mit klick erfasst wird mit
Einrasten auf dieses, wenn "on next
click set marker 2" immer ohne
Einrasten

3. 2.2013

* (minimierbare) fixe Toolbar (die
minimierte verdeckt noch manchmal
Text Messages)

* Popup Meniis ausaemistet, z.B
"Show All" nur wenns nicht schon ist

* Von den neuen Kommandos aus der
Toolbar aehen erst ein paar wirklich
(W V Q S) Messages, Listen, Config
noch nicht

6. 2. 2013

* Fahrtrichtunaspfeil + Windfahne bei
Wx Svmbol, 20kmh pro Strich beides
als Teil vom Symbol anklickbar und
abschaltbar

10. 2. 2013
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* Auswahl ob Toolbar oder Popup
Fenster, damit beim Start normale
Toolbar da ist. Muss noch optimiert
werden was in welchem Menii sein
soll und was offen bleibt oder
verschwindet. Histoaramme
verdecken die Pulldown Meniis aus
der Toolbar

* Hohenanagabe bei den Svymbolen,
noch nicht abschaltbar weil alle
Svmbol-Attribute ab einem
einstellbaren Wert (mindest meter,
km/h) konfigurierbar erscheinen
sollten.

- 13.2.2013

* Text Editor mit Scrollen fiir Config
und (wenn fertiq) Messaaqes,
Parameter werden erst einzelne
ausgewertet

— * Screenshot mit Filename

* rawloqg einlesen mit Filenamen
— (Datum Einaabe noch nicht
ausgewertet)

- 16. 2. 2013

* Watch Calls per Click suchen freien
— Platz in der Liste weil jetzt tastaturlos
auch wieder abschaltbar

— * Watch Calls mit * als Wildcard

* Setzen der Start Map Position auf
Bildmitte per Lokator, Long/Lat, oder
mit "?" im Confiag und dann Marker 1
setzen auf der Map
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* eigene Position im Confia auch mit
"?" mit Marker 1 ubertragbar.

* Confia File Speichern/Laden beim
— Start verwenden und automatisch bei
Quit Speichern

* fehlt noch Auswerten einiger Config
— Parameter zb Helligkeiten und "next
click to Wx"

- 15. 2. 2013

* Ausser laate/Network und
LoaDatum Configs sollten alle gehen
und gekoppelt sein mit den

— Schieberealern. Manche Werte, die
beim teilweise eingeaeben sein Unfug
machen, werden erst bei "Save"
"Reload" oder Start ausgewertet

— 28.2.2013

+ Bei Click auf Pixel das zu mehr als 1
— Objekt aehoert, werden die
gefundenen Objekte

bei iedem weiteren Click der Reihe
nach an die 1. Stelle cykliert

+ Lodfile Import mit Datum + ganze
Stunde

+ Netbeacon aus Confiaparametern
— damit per Modem empfangenes ein
Symbol fuer MH hat

- (noch nicht per tcp gesendet)
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- 3.3.2013

— + Objekte Loeschen

+ Filtern von Call, laate, Obiekt/Item-
Absender (erst mal ohne Wildcards)

- 7.3.2013

+ transparente Menues oder
schwarzer oder grauer Hintergrund

- (Config Transparency 2..100, 1, 0)

+ Confia Baken Symbol mit
Auswahlmenu ("My Symbol" clicken)

— + Objekt loeschen mit DEL-Taste

- 17.4. 2013

+ Nach wochenlanaem Kampf mit den
— Windoof Compilern ist nun etwa
Gleichstand bei der

Win32 Version und es kann wieder
— am agemeinsamen Teil weiter gebaut
werden.

Die innere Struktur ist etwas
— umaekrempelt zwecks minimiertem
systemabhaengigen
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Teil. Leider hat sich die "Tile"
— Filestruktur (mit schnell mal 3500
Files in einem

Verzeichnis) am Win als Bremse
— erwiesen und daher ist noch eine
Unterverzeichnis-

Ebene dazu aekommen und die
— Struktur nun gleich wie auf den
Servern und "Marble".

Zum Konvertieren der vorhandenen
— Maps ist das "rentile" script dabei das
man

noch anpassen muss und mit der
— Kommandozeile, die drin angegeben
ist, Aufrufen.

Es wird nix geloescht nur kopiert.
"gm.sh" ist auch darauf angepasst.

+ Neu sind nur ein paar Filter im
— Confia und fuer Besitzer eines
Mausrades damit Zoomen

und Pull der Map mit der mittleren
— Maustaste. Fuer Touchpad-
geschaedigte muss man sich

noch eine Alternative mit Shift/Alt
— oder Klick auf die leere Map
ausdenken.

Screenshot aeht nun auch als "bmp"
wenns File .bmp heisst.

- 17.4. 2013

+ Pull Map auch mit linker Maustaste
auf leere Map (configurierbar ?)
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+ Shift + Click to Map: Set Marker
— 1 (confiaurierbare andere
kommandos ?)

+ On next Click to Wxsvymbol:
— Raw+Decoded zu den Wettergrafiken
dazu einschaltbar

— 20.4. 2013

+ tcp Connect zum Server mit neuer
— Svntax, -a <ip>:<port>[#<filter>] -g
44.143.100.1:14580#m/300

MYCALL und PASSWORT jetzt schon
aus dem Config statt -s -p

+ Netzbake: "File" > "Confiqg" ->
— Myvcall, MyPos, Net Beacontext, My
Symbol,

Netbeacontime mit Enable,
PassCode mit Enable

My Symbol Anklicken fuer
Auswahl

My Position "?" an 1. Stelle
und dann Marker 1 Setzen

- 29.4.2013

+ tcp Connect nun probisorisch im
— File>Confia, wenn man editiert gruen
ausschalten und wenn

- fertig wieder ein.
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+ auf Wunsch Massstab auf der Karte
(noch nicht schaltbar) und auch
problematisch wegen

nicht entfernunastreuer Merkator
Karten bei kleinem Zoom

4.5. 2013

+ Vorschlaa von dI8rdl einaebaut,
Maps Download im Hinterarund
komplett fuer das sichtbare

Fenster von Zoom 1 bis
einstellbarem maximalen Zoom mit
Vorkalkulation der Datenmenge,

abbrechen, weitertun, und
Fortschrittsanzeige.

+ Messages empfangen (derzeit erst
von tcp)

6. 5. 2013

+ "DAO"-Erweiteruna in Frame-
Decoder einaebaut zum Position auf
etwa 20cm genau uebertragen

und auch aenauere Auswertunag vom
GPS-raw-Format und Anpassung der
Rundung auf Feldmitte

(leider ist die fliesskomma
Genauigkeit nur etwa 1-2m)

8. 5. 2013
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+ Mehr Status Meldunagen von "on
— Joff" Schaltern und (Shortcut)
Funktionen

+ <Make Video> leat "map.v4m" auch
— auf Linux neu an wenn nicht (zB. als
named-pipe) vorhanden,

meldet Schreibvoraana, refresht alle
1s den Bildschirm und ist abbrechbar.

+ Buttons mit noch nicht
implementierter Funktion melden das.

+ Im Screenshot Filenamen wird "%t"
— durch Datum-Uhrzeit und %n durch
"000" bis "999"

- ersetzt bis der Filename neu ist.

— + Shortcut Tasten Liste im <Help>

— 10.5. 2013

+ 4 direkt waehlbare Map Positionen
— + Zooms im Zoom-Menue oder per "1..
4" Tasten.

Dabei kann entweder der Zoomlevel
— oder die Position oder beides
abgerufen werden.

Der Eintraa dieser "Views" kann
— manuell im File>Config>View durch
"Zoomfaktor Position"

(wobei Position auch ein QTH-
— Lokator sein kann), oder eines von
beiden, oder viel
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schneller durch "Shift" + Click auf
— einen der 3 "Views" im Zoom Menue
erfolgen.

Dabei wird die aktuelle Karten-
Position mit Zoom gespeichert.

Shortcuts anders: "1" (one user) nun

—_— II2II +rf nun ll=ll

"On next click" neu einstellen
erforderlich

- 12.5.2013

+ Tooltipps mit Text aus externem
— File "hints.txt" und schon etlichen
Texten drin.

Darf natuerlich verbessert oder
— uebersetzt werden wobei das
Ergebnis der Arbeit

sofort aktiv ist sobald das hints.txt
gespeichert ist.

- |Buttonnummer Text

die fehlenden Texte werden als
"<Buttonnummer> hint text" gezeigt

die Struktur des File>Confia wird
— noch umaebaut daher mit den hints
dafuer abwarten

— 15.5.2013
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+ "Zitter"-Toleranz fuer Mausposition
— innerhalb der die Hints sichtbar
bleiben

+ Zeiat aktuelle "Mbytes written" des
Video Files

— + List>Internals zeigt System Zustand

+ "L" Shortcut nun "toaale Labels on
/off" Labels=Text bei den Symbolen

— + Fine Zoom Steps im Config

- 17.5. 2013

+ "L" und "O" bzw "Labels off"
— "Obiects off" wird nun nimmer in
Form von 0% Helligkeit

- im Config verewigt

+ In Vorbereituna auf ein Text-
— Fenster kommt nun mal
List>Messages und List>Bulletins

auf das Start Terminal Fenster raus,
wobei die Bulletins noch nach

Absender/Eintreffzeit sortiert sind
und nicht nach der BLN<nummer>

+ Angeklickte Obiekte kann man in
— Infos>List Raw oder Infos>+Decoded
auf das Textfenster

auflisten lassen (ohne farbige
Fehlermeldungen)
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18. 5. 2013

+ Confia>Show Incomina "n" Zeiat
TCP-Frames auf dem Textfenster,
"n+" Dekodiert

fuer die Radio Ports entsprechend 1
23...und 1+ 2+ ... Dekodiert

21. 5. 2013

+ Raw+Decoded Sprechblase
aktualisiert sich mit ankommenden
Daten falls sie den letzten

Wegpunkt anzeigt

+ Delete Wavpoint, wenn mit Debua
oder Raw+Decoded markiert. Mit DEL-
Taste zum entfernen

von (falschen) Weapunkten. Marker
1 sprinat dann zum naechsten
(vermutlichen) Fehler weiter.

(Wann alles loeschen oder nur
Wavpoint muss noch besser
definiertbar sein)

+ Hoehe wird auch bei Svmbolen
ohne km/h Daten anqgezeiat falls
Hoehendaten vorhanden und

eingeschaltet.
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23. 5. 2013

+ UDP-Port im Config (erst mal 1
Stueck)

+ Fenstergroesse veraendern
schneller

+ Trackfilter Fehlererkennung
verbessert

+ Bei Debuqg Funktionen
Verzoedaerunaszeit von doppelten
Waypoints in Sekunden sichtbar

29. 5. 2013

+ Zwecks schnellem Tracks Debuagen
mit "E" oder File>Infos>Waypoints-
Button toggelt

alle, oder nur die als verdaechtiq
markierte Wavpoints anzeigen mit
den "<"">" Tasten

oder den Buttons daneben.

+ rawloa mit lesbarem Datum
/Zeitstempel, das alte Format wird
lesend auch akzeptiert.

+ axudp-kiss (usb)seriell Interface
(udpflex) erweitert, sodass nebst an
/abstecken von

usb-Seriellen auch ein resetteter
TNC2 an empfangenen (nun nicht
mehr kiss) Daten
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erkannt und wieder auf kiss
— aeschaltet wird. Geht mit init File
auch fuer andere TNC

- wie in THD7x oder TMD7x.

- udpflex (linux), udpflex.exe (win32)

- 8.6.2013

+ Confiaurierbare default Speed fuer
Animation

+ Parkplatzzittern-Erkennungqg fuer
Animation Startzeit verbessert

+ Source Code Entruempelung zum
— einfacheren Compilieren fuer
verschiedene Prozessoren

— 15. 6. 2013

+ km/h und/oder Hoehe in Animation
— und Video wobei Lesbarkeit bei
schneller Aenderung

- noch verbessert werden kann.

+ Uhrzeit beim Loa schreiben laeuft
— nun auch waehrend Animation in
Echtzeit.

+ +-24h Zeitversatz Systemzeit
/angezeigte Zeit einstellbar

- 5.7.2013
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+ Objekte mit extra "keep in memory
— time" zB um den schon nach 5 bis 6h
recycelten

Blitz-Obiect-Namen keinen Track
erzeugen zu lassen.

+ Lodfile browsen aeht dleichzeitia
— mit online Betrieb. Dazu wurde eine
zZweite

Uhrzeit gdeschaffen die den Loadaten
— folat und die Echtzeit Daten werden
unabhaengig

von den Loadaten (wie sonst auch)
im RAM und writelog gepspeichert.

Es kann jederzeit zwischen Log und
— Echtzeit gschalten werden und in den
Logdaten

an Anfana, Ende, und in "Fullbright"
— Zeitspruenaen vor und zurueck
gegangen werden

womit immer alle Daten einmal
sichtbar sind.

+ Status Bar zeiat Betriebszustand,
— erst mal experimentell zum sehen
was man braucht

mit Buchstaben bis Svmbole
— entworfen sind. Bei TCP (Internet)
und und UDP (Funk)

wandert die Farbe von aruen nach
— rot binnen 1 Min. solang keine Daten
ankommen.

Messaae soll mal anstatt dem Popup
— Fenster vorhandene Messages
anzeigen und erst bei

- draufklicken Inhalt zeigen.
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- 16.7.2013

+ Hoehen Diaaramm ueber
— Weastrecke, mit Trackfiler on "F"
wird versucht die manchmal

unagenaue Hoehenmessung etwas
glatt zu buegeln.

+ Beim Track anklicken wird der
— Weapunkt ausaewaehlt der der
Klickpunkt am naechten

- liegt.

+ Popup Meldunagen, die Befehle
— bestaetigen, werden nach ein paar
Sekunden wieder

entfernt. Da, um CPU Zeit zu sparen,
— der Bildschirm nur aktualisiert wird
wenn neue

Daten kommn, aeschieht das
Loeschen nur im Zuge einem Updates.

- 19.7.2013

+ "On Next Click To Track" mit Speed
— oder Altitude aktiviert, setzt eine
Marke auf

dem Diagramm, die der angeklicken
Stelle am Track entspricht.
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+ "On Next Click To Track" kann mit 1
— Click Wegpunkt loeschen aktivert
werden.

+ Ein angewaehltes Obiekt kann mit
— "Save" als Logfile mit dem Filenamen
des Objekts

agespeichert werden (derzeit nur im
— Startverzeichnis). Existiert das File,
wird

hinten dran geschrieben. Es werden
— alle Daten aus dem RAM geschrieben
auch wenn

mit Trackfilter oder Fullbright Time
ausgeblendet.

Manuell geloeschte Baken
/Wegpunkte sind weg.

- 22.7.2013

+ Video/Animation Speed
— Einstellbereich erweitert von 1:1
(Echtzeit) bis 200s/Frame

womit die Speed-Zahl statt (Echt-)
— Sekunden zu Frames jetzt
multiplikator fuer

- Echtzeit ist.

+ Start Delav fuer beschleuniqgte
— Darstelluna (wenn sich nichts
bewegt) einstellbar

+ Loa Import fuer ein Call wobei
— immer auf eine Zeitspanne gesucht
wird in der das

- Call aktiv war (keine wildcards)
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— 25.7.2013

+ "On Next Click" mit mehreren
— Optionen gleichzeitig (wo es Sinn
macht).

- 9.8.2013

+ Durch erweitern der Menue-
— Darstellunag auf Tabellen mit Farben
und verbessern des

Zeilen-Editors (Maus kann Cursor
— setzen ...) ist Messages erstellen und
verwalten

moealich aeworden. Empfangene
Messages sind noch ohne Tabelle.

- 2.9.2013

+ Nach komplettem Umbau des
— Konfiagurations-Tools mit dynamischer
Anzahl der

Eintraeae aeht nun Messaqges
— senden, mehrere Aprs-Server-urls die
abgeklappert

werden bis einer antwortet, beliebig
— viele Watchcalls, Filtereintraege,
Baken...

Der Texteditor kann Insert/Overtype
und Cursor setzen mit der Maus.
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Mit Shift-Linksklick auf die Karte
wird die Position in die Editorzeile

kopiert (ietzt einfach wiederholbar
bis man "getroffen" hat)

(Die eigene Position und die Zoom>"
— Views" muessen neu eingegeben
werden)

+ Die aktuelle Fensteraroesse wird im
Konfigfile mit gespeichert.

"View 1" wird beim Programmstart
dargestellt.

(speichern der aktuellen Ansicht mit
Shift-Linksklick im Zoom-Menue)

+ Nach der Frage "was brauch ich
— alles um online zu gehn" ist dies nun
in

einem Menue. Dabei kann man
— abaestuft von ganz ohne Call bis Call
und eigene

Position nur dem Server saagen
— (zwecks funktionieren der m/... Filter)
bis

Bake und Messages ins Netz senden
konfigurieren.

+ laate-Funktion ist nur in der Linux
— Version vorhanden da das Win-tcp-
System

keine Info ueber bestaetiate Daten
— hat und dann einen als "haengend"
erkannten

Link nicht terminieren kann, ohne
— die veralteten Daten noch
rauszuweinen.
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Das waere im aktuellen Aprsis-Netz
— ohne Timestamps nicht mehr
akzeptabel.

Auch die Linux laate-Funktion sollte
— auf keinen Fall fuer einen Digi
verwendet

werden da zB. beim Lodfiles
— durchsuchen die Durchlaufzeit
erheblich werden kann.

Fuer Igate gibts ohnhin ein eigenes
Tool.

+ UDP-Ports fuer Funk rx/tx mit
— Soundmodem oder mittels "udpflex"
(USB)seriellen

TNC aibts derzeit 4. Eine
— dvnamische Anzahl braucht noch
Aufwand bei den

- Schaltknopfen in den Menues.

Der Funk-Baken/Obiekt/Items-Editor
— ist noch in Entwicklung, dort dann
auch

wieder die verschwundene
"Rfbeacomtime" fuer jede Bake extra.

(bis da hin 1 Bake manuell ins
aprsmap.cfg)

- 4.9.2013

+ Baken senden mit Macros fuer
— Uhrzeit und File einfueaen
(Wetterbake). Jede Bake
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mit Port und Intervall Angabe und
— Zielport aeht auch Net. Mit Beacons
Shift Time

wird die Startzeit ieder weiteren
— Bake so verschoben, dass sie nicht
innerhalb der

"dupe delete" zeit (meinst 57s) der
Igates landen.

Svntax: intervall(s):port:rawformat
600:1:NOCALL>CQ:>test

- \\z tag+zeit, \\h zeit, \\:filename:, \\\ \\

- 8.9.2013

+ Maus Hint Texte verbessert und
deren Erscheinen an der Status Bar.

+ User Infos erweitert, aefahrene km,
— Zaehler fuer Baken, Messages, Acks,
Rejects

- 9.9.2013

+ "Show Obiects of Sender" zeiat alle
— (anderen) Objekte und Items von dem
Absender

des Ausaewaehlten Obiekts auf
— einer dafuer aezoomten Karte unter
"Info>Objects of.."

+ Shift-Click auf die Status-Bar (die
— bunten Laempchen) oeffnet direkt
das zugehoerige
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- Config-Menue soweit Sinnvoll.

- 11.9. 2013

+ Menue Positionierung korrigiert
— und Menues nimmer schliessen bei
Shift-Click

auf Map zum Position in Editor Zeile
kopieren

- 13.9.2013

+ Statusbar Netzwerk-Buttons Mouse-
Over wenn nicht online normale Hints,

wenn online, Status Info. X/N zeiat
— offline/online (sollten mal Symbole
werden)

+ "w" Temperatur-Karte wie bisher,
-  "W" (w mit Shift) Regen-Karte mit
blau fuer

24h und rot fuer aktuellen Reaen
— (noch ohne Fehlerfilter, luegende
Stationen

- anklicken und mit DEL entsorgen).

— 16.9. 2013

+ Lodfile lesen mitn Binaersuche fuer
— den Anfang ab wo ins RAM eingelesen
wird
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mit dem Vorteil, dass auch lange
— Loas beim Programmstart und Log
Import schnell

nach Datum durchsucht sind, aber
— das Logfile muss nach Datum sortiert
sein.

- Derzeit max 4GB Logfile.

— 19.9.2013

+ Messadge (Queryv)
— Kommandowoerter + Antworten in
Config > Rf-Ports.

Standard Querys (?APRSP) als auch
beliebige Woerter koennen definiert

werden und in der Antwort Macros
wie \\h Uhrzeit, \\p Path, \\l Position,

\\V Proaramm Version, \\<filename>
File senden, \\>filename> schreiben,

letzteres zum aktivieren von einem
— Proaramm zum was Steuern oder
Sprachausgabe

"TALK:\\>/tmp/talk.txt>Text um \\h
Gesprochen!"

- "?HELP:?APRSP, ?VER, TALK"

- 22.9.2013

+ Windfahne und Temperatur beim
Symbol mit Timeout.

+ 1 Kommastelle mehr bei
— Koordinaten-Ausgabe und bei Maus-
Koordinaten
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Grad/Minuten/Sekunden-
Schreibweise zuaetzlich.

+ Win32: bei der (oder mehr) Start-
— Fenstergroesse die der Bildschirm
kann,

- "Maximized" Fenster.

- 7.10. 2013

+ Filesvstem auf "Londfiles"
— umagestellt damit sollte Logfile >2GB
geschrieben

und dank Binaersuche auch flott
importiert werden koennen.

+ Proaramm Starter fuer Maps-
— Downloader bei Bedarf (gm.sh bzw
gm.bat)

der kann sich nach agetaner Arbeit
beenden. Status in der Status-Bar

mit "D" statt "E" fuer Downloader
laeuft erkennbar.

+ Beliebiage Map-Tvpen confiqurierbar
mit korrektur der Basis-Helligkeit,

die ersten 3 wie aewohnt mit
— Shortcut "7" "8" "9", die 1. beim Start
aktiv.

Sat-Maps erst wenn ein |JPEG-
— Dekoder vorhanden ist (ausser man
wandelt

sie beim Download in PNG). Neu
(voreingestellt): cyclemap
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— 11.10. 2013

+ Weastrecken Summe (ohne Track)
auf der Map (shift-click, click, click...)

+ Log Import (bis auf Suche
— rueckwaerts nach Call) bei
unsortiertem File

- versucht etwas zu verbessern

— 13.10. 2013

+ Schriftaroesse einstellbar (Config >
Map Paramter > Font Size)

— 15.10. 2013

+ Screenshot auch als ".png" (vorerst
nur Linux Version)

und osm-Verzeichnispfad wieder
configurierbar

+ "On next click to Track" bei
— mehrfacher Auswahl mit "Zoom to"
wird erst gezoomt

und dann im 1 Track Mode die
anderen Funktionen aktiv.

— 31.10. 2013
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+ Beep-Sounds mit beliebiger
— Freauenz und Dauer wenn Message
oder Ack eintrifft,

wenn sich wer in den Warnradius
— beweat mit steigender Frequenz und
/oder Dauer

ie naeher er zum Zentrum kommt
— und wenn ein Call aus der Watch Liste
aktiv wird.

Alle getrennt schaltbar und limitiert
auf maximal alle 5s.

Windoof 7 oder 8 aeschaediate
— koennten evtl. keinen Piepser haben
dann gibts als

Ersatz 3 Svstem-Sounds (mit Oms
— einschalten, bis 500, bis 1000, ab
1000Hz

- jeweils ein anderer Gong).

- Config > Map Moving > Bell/Sound

- 6.11. 2013

+ In Animation und gedimmten nicht-
— movern wird die schrift der "mover"
im

- nun Vordergrund gehalten

+ Einfaches Hvperlink Hilfetext
System mit File "help.txt" unter "Help"

erreichbar mit ein bisschen Text als
Beispiel
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- 18.11. 2013

+ Einstellbarer Timer zum Verzoedern
— vom Mapdownload Start waehrend
Karte

verschieben, wer so vermeiden will,
— dass in hohem Zoom der Streifen an
Karten

entlana der Beweauna durch die
Botanik geladen wird. Config / Timers

— + Index Taste im Help Fenster

+ Schutz vor ewia loopenden
— Mapdownloads wenn durch zB volle
Platte oder nicht

identischem Schreib/Lese-Pfad
— immer die aleichen Karten
angefordert werden.

Kommt ein Kartenteil immer wieder,
— wird nach ein paar Versuchen 1. nur
mehr

1 Karte anaefordert, 2. die Pause
— zwischen Anforderungen immer
Verdoppelt

und 3. poppt eine Fehlermeldung
auf.

+ Copyv/Paste hinein ins Proaram
— (rechte Maustaste im Textfeld oder
ctrl-v)

(bei linux jetzt mit dem aktuellen
— '"keiner verstehts..." selection-
Verfahren)
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- 22.11. 2013

+ "Ok" im config-Zeileneditor
— schliesst das Fenster nach dem
Speichern.

+ Map download Timina (im
— Fehlerfall) optimiert, dass mit dem in
entwicklung

befindlichen hochaeschwindiakeits-
Downloader von oe5krn bei falscher

Einstelluna oder voller Platte keine
— "Giagabvte" ins Nirvana geladen
werden.

— 28.11. 2013

+ "B" und "M" (aross) fuer
Bakeneditor und Message senden

— + Index bei Helptext

+ Umfanareicher Baken/Objekt/Item
Editor mit verschiebbarem Fenster,

Import von vorhandenen Objekten
auf der Karte durch anklicken.

- Testen lokal vorm Senden.
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Einmal senden oder mit Timer und
— Verschiebung der Sendezeiten, dass
die

Duplikatloeschuna in den laates
Sendungen mit gleichen Inhalt aber

verschiedener Frequenz (oder direkt
per tcp) im Netz sichtbar laesst.

Einfaches Fernloeschen von Items
und Objects.

Normal/Mic-E/Compressed mit DAO
Erweiterung fuer 20cm Genauigkeit

(die aber ie nach
— Fliesskommaarithmetik nur etwa 1m
schafft)

mit Bvtezaehler der Gesamtlaenae
— beim editieren der Kommentarzeile
zum

- optimieren der Kompressionsart.

Macros zum Einfuegen von Files zB
fuer Wetterbake

+ Query standard Antworten (?APRST
...) vorkonfiguriert mit opt-out wers

nicht will. Config > Rf Ports > Query
Keywords

+ Fehler behoben, Decodieren von
Items mit kurzem Label.

Unsichtbare User weaen keinem
— oder falschem Symbol (die aber
trotzdem
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watch/approxyv-piepsen) haben nun
Label und Track

+ Listinas im "Show 1 Modus" zeigen
nun nur was zu dem User gehoert

- 4.12.2013

+ Confia > Rf-Ports > Monitor
Headline

Damit kann man 0 bis 20 Calls +
Tempertur oder km/h als "Ticker"

von aktuellen Frames auf der
— Fenster-Ueberschrift durchlaufen
lassen.

Bei minimiertem Fenster ist das
aktuellste Call in der Taskleiste.

N> kommt von, N< get ans Netz, 1>
2> Funkports, N- heisst der Frame

ist entweder in den Callfiltern oder
ohne verwertbarem Inhalt.

+ (arosses) "F" Shortcut Find (Call,
Locator, Breite/Laenge)

+ Bakeneditor "Draw" schreibt
nimmer ins rawlog

— 10.12. 2013
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+ Calls + Temp,km/h,Hoehe der
— ankommenden und abgehenden
Daten in der

Fenster-Kopfzeile. Anzahl der Calls
Config>Rf-Ports>Monitor Headline.

Updaterate auf (Mittelwert) 1s
limitiert.

+ Maus-Verhalten umagestelit
(aehnlich anderen Programmen).

Linksklick wartet auf Maus-
— Bewedaung (mit ein bisschen Zitter
Toleranz)

und zieht Karte (auch wenn ein
— Svmbol getroffen) oder, am oberen
Rand

angefasst, konnen einiage Menues
— und die Status-Bar positioniert
werden

mit "ankleben" an den Fensterrand
und gespeichert in aprsmap.cfg.

Beim auslassen der Maustaste,
— wenn nicht bewegt, wird der normale
Klick

- ausgeloest.

Mittlere Maustaste zieht alles was
ziehbar ist und an beliebiger Stelle

- angefasst.

Rechte Maustaste wie bisher Back-in-
zoom-History oder in einer

Texteinadabe "Paste" (falls was im
copy/paste Puffer ist)
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— 15.12. 2013

+ Messade Senden nun bis 67
— Zeichen wie im Protokoll vorgesehen
statt 57.

+ Umlautwandler auf "Ae Oe Ue ss"
— (bis mal ein 8 Bit Zeichensatz
definiert ist).

+ Messadqe Einaabezeile geleert wenn
— die vorherige Message abgeschickt
wurde oder

an ein anderes Call als zuvor
gesendet werden soll.

+ Schnelles Zoomen mit Shift-
— Linksklick und Rahmen um den
gewuenschten Inhalt

- aufziehen.

+ (nur Linux) ipea-Dekoder fuer Maps
wobei erst .png versucht wird dann

inea in .pna Filenamen und zuletzt
jpeg als .jpg (gm.sh modifizieren).

- 16.1. 2014

+ Config / Online / Serverfilter
— Aenderungen werden bei "Ok" sofort
zum
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Server geschickt. (sofern der die "#
filter ..." Syntax versteht)

+ mit "<" ">" durch einen Track
— wandern aeht mit gleichzeitig
geoeffneter

Altitude- und Speed-Statistik und
zeigt dort die Stelle am Track und die

- Messwerte numerisch.

+ Tools / List neu mit verschieb-
maximier-, ikonisierbarem Textfenster

mit Scrollbalken (und Cursortasten
und Mausrad) und nach Zeit und

- alfabetisch sortierbarem Inhalit.

Es kann Rohdaten und dekodiert
— listen. Text kann man markieren und
mit

"Paste" in andere Anwendungen
— kopieren (auch auf Win ohne
umstaendlichen

Dialoq). Gibt man in Tools / Find ("F"-
Taste) ein Wort ein, werden alle

aleichnamiagen Stellen farblich
— hervorgehoben zB. "APLMO1" oder ein
Call.

Klickt man auf eine Zeile, wird auf
der Landkarte die Herkunft gezeigt,

sofern die Zeile eine Position
enthaelt und wenn nicht, die letzte

bekannte Position vom Absender der
Zeile.
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Das Live-Monitor-Fenster fuer
— empfanaene und gesendete Daten
hat anstatt

sortieren "CIr" fuer Inhalt loeschen,
es stoppt raufscrollen wenn man

mindesten 1 Zeile herunter
— daeschoben hat, und kann mit "u"-
Taste an und aus

aeschaltet werden. (Beachten: bei
Batteriebetrieb durch den laufenden

Bild-Update evtl mehr CPU
/Akkuverbrauch)

Das Aktivieren des Monitors ist, bis
— eine selbsterklaerende Menue-
Struktur

erfunden ist, noch wie zuvor unter
Config / Rf-Ports / Monitor Frames.

+ Linux: F1l1l-Taste (bei "seltsamen"
— Fenstermachern die selber kein
Maximieren

oder dann wieder kleiner machen
koennen) toggelt Fullscreen/Normal.

+ Win: Kein extra Textfenster mehr
da Listings eingebaut.

— 20.1.2014 (Ver 0.32)

+ Funkport (Soundmodem / udpfilex)
Kommandozeile in Config / Rf Ports /

- Serial Interface

- Task wird automatisch gestartet.
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+ Monitor Ports off/raw/decoded
— einzeln mit Klick schaltbar Tools/List
/Monitor.

— 3.2.2014 (Ver 0.32)

+ Message Rx: Schalter fuer Pop-up
Fenster

Schalter fuer zeigen von
Messages an andere SSID

Schalter fuer Messades an
sich selber weg filtern (default on)

— 6.6.2014 (Ver 0.34-testversion)

+ Hohendaten (soweit in einem
Datenfile vorhanden)

bei "show Location of Mouse" "on"
werden m ueber NN angezeigt

ebenfalls neu, Distanz und Winkel
zum Marker 1 wird angezeigt

- Files zum selber besorgen:

- osm/srtm3/N48E012.hgt

- N48E013.hgt
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(90m aufloesung, 1x1 grad 2.8
MByte pro File

http://dds.cr.usas.aov/srtm
/version2_1/SRTM3/Eurasia/)

- osm/srtm30/W020N90.DEM

(900m aufloesuna, 20W..20E, 40
bis 90N 57Byte, deckt den Rest ab

http://dds.cr.usas.gov/srtm
/version2_1/SRTM30/)

osm/eudem/ (noch nicht
implementiert)

30m Aufloesuna, 640MByvte fuer
— 5x5 arad, braucht aber erst
konvertierprogramm

vom (unbrauchbaren) "eu-geotiff"
in lesbares Format

http://www.eea.europa.eu/data-
and-maps/data/eu-dem#eeaEsriMap

+ Radiolink Berechnuna zwischen
— Marker 1 und 2 nach Eingabe von
Antennenhoehen

und Wellenlaenge. Vorerst mal
— Darstelluna auf der Map als farbige
Fresnelzone

"blau" frei, "aelb" bis "rot" von
— angekratzter 1. Fresnelzone bis voll
verdeckt.

+ Radiolink mit 2 Klicks oder fuer
tastaturlose Bedienung

"On next click to Map" mit "Set
— Marker 1" beim 1. Klick und Marker 2
bei weiteren
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Klicks nach "Clear Markers" wird
wieder erst Marker 1 gesetzt.

+ "d" Shortcut fuer Map downlod on
/off

+ Map download auch wenn auf "off"
— wenn "Reload" oder die Download
funktion

- betaetigt wird.

+ Testweise "High Resolution Track"
— Dekodierung als Protokollerweiterung
eingebaut.

Dabei werden mit einer Bake 2 bis
— 30 Positionen gepackt als
Abweichung von einer

Geraden 2 oder 3 dimensional +
— Timestamp uebertragen. Wird die
Erweiterung nicht

erkannt bleibt die normale Position
pro Bake.

Die Optionen sind erweiterbar,
— Positionsaufloesung, End-zu-End
Pruefsumme,

"QRV"-Frequenz, direktaehoert von
— laate, Climb-Rate und fuer Wanderer
hoehere

Geschwindigkeitsaufloesunaq sind
— mal voraesehen. Traegt sich der
direkthoerende

lgate ein, wird vom Aprsis-Service
— eine veraenderte Kommentarzeile
erkannt und

damit ALLE laates ersichtlich, die
— direkt gehoert haben und nicht nur
der mit
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der schnellsten Glasfaser
— Anbinduna. Dekodiert wird dabei eine
in vom Empfangsmodem

in Klartext umgesetzte Darstelluna
— fuer Aprsis. Am Funkweg wird binaer
und wesentlich

- kleiner gepackt uibertragen.

— 13. 6. 2014 (Ver 0.35-testversion)

* osm/srtm1/N48E012.hgt mit 30m
horizontaler Auflésuna aus den EU-
DEM Daten umformatiert in das srtml-
Format wird bevorzugt verwendet.

* UDP-Ports restarten sich wenn beim
Editieren was verandert wurde.

* Map Loader startet beim enabeln
ohne nochmal herumzoomen.

* Speed/Altitude/Gelaendeschnitt-
Diagramm updatet sich mit

— ankommenden Daten wenn mit
letztem Weapunkt oder Symbol
anklicken geoffnet.

* laate (Rf to Net, nur Linux) jeder
— UDP Port kann einzeln freigeschaltet
werden

* Gelandeschnitt, Darstellungs-
Versuch mit zusatzlichem Freiraum-
Diaaramm auf der Landkarte.
Praktisch zum Zoomen aber evtl.
missverstandlich da nur die Fresnel-
Zone zur Karte passt und folalich die
Punktreihe, die die Bodenhohe
darstellen soll, nicht.

— 17. 6. 2014 (Ver 0.35-testversion)
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* Sichtweiten Farbkarte, mit Marker 1
oder 2 oder beiden gesetzt, wird mit
"R"-Taste die optische Sichtweite
daragestellt. Antennenhoehen am
Marker ist 1. Wert in "Tools
/Radiolink" am andern Ende gilt Wert
2. Die Wellenlaenage wird hier auf 0
agesetzt und damit ist ab halber
Fresnelzone "Sicht". Farbhelligkeit in
"Confia/Map Parameter/Brightness
Rfpath"” Die Berechnungq ist noch
experimentell und sollte nach
optimierung deutlich schneller
werden und damit man die Landkarte
noch lesen kann brauchts noch
Darstellungs-ideen.

— 28. 6. 2014 (Ver 0.37-testversion)

* Marker setzen mit Einrasten auf die
aenaue Position eines anaeklicktes
Obijekts (More Infos> ) und ohne
Einrasten im Zoom Menue. Dort auch
Marker einzeln Ioschbar. Marker 1 als
"hart (agelb)" oder "weich (blau)",
letzerer entsteht durch einfaches
Anklicken, beweat sich mit fahrenden
Obiekten bzw. huepft auf neu
anaeklickte Obijekte oder Weapunke
und hat ein Timeout. Harter Marker
bleibt bis loschen.

* Netz/Funkport Status-Laempchen
zeigen nun letzte Senduna (aelb) und
letzten Empfang (griin) seit 60s als
Sanduhr.
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* Mausrad (oder Zoom-Menue +/- mit
Shift) Zoom Stufen (Confia/Map
Moveina/Fine Zoom Steps) rastern

— nun die automatischen
Zoomvoraaenage auf die einagestellten
Werte insbesondere auf "1" also
original Osm-Stufen.

* Ausaeschaltete Tracks (Helliakeit
auf 0) machen nun auch Funkwege
und Zoom auf das was man noch
sieht.

— 1.7.2014 (Ver 0.38-testversion)

* Watchliste neu mit Schalter fuer
Pieps / Landkarte mitbeweagen /
Loafile zB. mit OE* getrennte Lodfiles
fuer jedes Call mit OE vorn schreiben.

* Shift-Click auf Rf-Port-Knopf geht
direkt in Config-Editor.

* Portname nach dem Port-URL zeiqgt
in "i"-Liste und beim "Hovern" auf den
aktiven Portknopf Namen und ip
Nummer.

* On Next Click to Track mit "Zoom
to" schaltet erst in den 1 User Modus
und tut dann (nun hoffentlich) die
anderen aktivierten Dinge.

— 3.7.2014 (Ver 0.38-testversion)

* Baken sollten sichn nun auch mit
den "\\" Macros wieder in den Editor
— laden lassen ohne dass diese
expandiert werden. (Vorhandene
Objekt-Baken neu eingeben)
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* Messadge Routing verbessert mit
automatischer "NOGATE"-Option
wenn nur Funkports verwendet
werden

* Messade und Baken Sende-Meldung
und Rueckfrage wenn man (meist
versehentlich) Leerzeilen Msg senden
will.

— 4.7.2014 (Ver 0.38-testversion)

* Lodfile loeschen bzw. Filegroesse
anzeigen

* Etwas mehr "On Next Click"-
Optionen kombinierbar

— 8.7.2014 (Ver 0.39-testversion)

* WX arafik zeiaen auch wenn WX
Baken ohne WX Daten dabei sind

* Schalter fuer nur WX-Stationen auf
der Karte zeigen

— 17.7. 2014 (Ver 0.40-testversion)

* Nur WX Stationen auf der Karte
Zeigen

* Relief Karten rechnen mit
Fortschrittsanzeiae und nach 4s
Abfraae auf Abbruch (mit srtm(1)
Files (Netzwerk-Laufwerk zu langasam)
und noch ohne Antialiasina was ab
zoom 12 sichtbar wird) map
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parameter/brightness rfpath zB. "30
10050 100 80 20 0 100 100" (der 3.
Wert 0 fuer harten Kontrast
/Funkreichweite oder 500 fiir
aufpeppen von osm-Karten) tools
/radiolink "2000 0 0 200" marker 1
und evtl marker 2 setzen und "R"
"confia/brightness map" zum ein
/ausblenden der osm karte)

* Digipeater (abaespeckte udpbox
derzeit noch ohne klicker-Editor und

— nur arob agetestet) Confia/Rf-Ports
/Diagipeater, derweil Internes Format
mit Zeileneditor bearbeiten.

* Messadge Sendetaetigkeit-popup-
Meldungen verfeinert und korrigiert

— 18. 7. 2014 (Ver 0.40-testversion)

* der Lodfile-Pfad fuer das rawloa
— wird auch fuer die Watchcall-Logs
verwendet

— 19. 7. 2014 (Ver 0.40-testversion)

* Watchcall-Liste nach "longest-
match" durchsuchen. "OEOAAA"
passt bei * OE* OEQ0* OEOB* auf OEO*

— OE* +log / OE1X +log / OE1* nichts /
OE5A +beep schreibt loa von oe
ausser oel und oe5a aber schon oelx
und peept bei OE5A

* Call-Log FilegréBRe anzeigen und
Files l6schen
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— 20.7.2014 (Ver 0.40-testversion)

* Cursor Up/Down Tasten in
mehrzeiligen Textmenues

* Tasten Fokus Lock auf Eingabefeld
nach Anklicken oder Tastatureingabe

* 1. Klick auf eine Zeile verandert
nicht die Kursorposition

— 25.7.2014 (Ver 0.41-testversion)

* Digipeater, mit fein dosierbaren
— Standard (mach QRG voll) bis "sehr
beruhigt" Optionen

* Editor dazu Config / Rf-Ports /
Digipeater und "Hints"

— 28.7.2014 (Ver 0.41-testversion)

* Farbe fuer Schrift, Menues,
Hinterarund, Transparenz,
Radioranae, Reliefkarte mit

— Farbauswaehler (der noch 3eckia
werden soll damit umaekehrt auch
eingestellte Farbe drauf gezeigt
werden kann)

— 31.7.2014 (Ver 0.42-testversion)
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* Statusknopf zeiat durchgehend
wenn Wx/Temp./Reaen/Radiorange
oder sinale User Modus ist und kann
da ausgeschaltet werden.

— 24. 8. 2014 (Ver 0.42)

* "F"ind auf einen sonst unsichtbaren
Objekt-Sender zeigt dessen Objekte.

* "More Infos" zeigt Button "Objects
of Call" wenn Call Objekte sendet.

* Wx-onlv mit "L"abels off zeiat nur
— Temperatur und Windfahne beim
Symbol.

* Antennenwinkel bei Gelandeschnitt
Info.

* "DUPE" Melduna bei Weapunkt-Info
— nimmer "ewiq" bei einer Fixposition
nach einem Ausreisser.

— 26. 8. 2014 (Ver 0.42)

* ip-Nummer Schreiberei vereinfacht,
"127.0.0.1" kann weggelassen werden

* udpflex erweitert auf "net-kiss",
also kiss via tcp, damit es mit dem
dire-wolf-Soundmodem kann "udpflex.
exe -U :9002:9001 -T :" (http://home.
comcast.net/~wb2osz/site/ geht mit
default Einstelluna, Sampelrate sollte
man aber halbieren sonst ziehts
750MHz CPU)
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— 15. 10. 2014 (Ver 0.43)

* Input Filtern auf Stichwort im
ganzen Frame

* kleines "e" oder "d" im Map-
expansion-Lampchen zeiat
automatischer Map Download off
(toaale mit "d"), Manueller Map
Reload/Download geht aber auch in
dem Modus.

* Im "F"ind Feld aeht auch dezimal
Grad "48.2 13.31".

* bei den Confiag Zeilen geht "Enter-
Taste" als Ok oder Add.

* Textfarbe vom Items/Objects mit
— Farbauswahler unabhaania von
normalen Baken einstellbar.

* Fontaroesse Eingabe zeigt sofort
Ergebnis.

* jst ein Objekt im "show 1" modus,
kann man mit "Focus" Karte
mitziehen einschalten ohne
Watchlisten Eintrag.

* TAB-Taste schaltet zwischen 2
Kontexten hin und her, dazu zaehlt

— nebst Wetterkarten-Modi auch der
"Focus" Modus, womit 2 Objekte im
Bild gehalten werden kénnen.

* Baken/Messaae/Ack Senden
Warnmeldungen verbessert, wenn
der eingestellte Sendepfad

— vermutlich nicht zum Erfolag fuehrt.
(Port ausgeschaltet, nicht zum
Senden konfiquriert, kein Passcode
am Internet ....)

* Gelandeschnitt, Reichweiten-, Relief-
— Karten Parameter in ausfihrlicherem
Meni zusammengefasst.
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* Gelandeschnitt zeiat freie Meter
— zum Boden (Karte ziehen zum
Messmarke bewegen)

* Trackfilter beim Suchen auf
Duplikate mit Indexsvstem so
verschnellert, dass beim aus dem
Speicher Entfernen von Wedapunkten,
auch deren Folaefehler mit Entfernt
werden konnen.

— 11.11. 2014 (Ver 0.45)

* Gelandeschnitt und Reliefkarten mit
einstellbarem Hohendaten Cache
damit Plattenzugriff auf etwa 0.5%
verringert.

* Schalter "kleine/mittlere/volle
— Aufloesunag” entsprechend langsam
bis schnell.

* Interpolation der Hoehendaten und
damit brauchbare Bilder bis Zoom 14

* im "Find" Feld aeht Call / Sender of
Object / Locator / DDMM.MM / D.DDDD

* Marker 1 setzen Sendet DDMM.MM
— zum c/p Buffer, Marker 2 D.DDDDD
Format.

- 9.12. 2014 (Ver 0.46)

* Watchcall Popup-Fenster anklickbar
und zentriert Map auf das Objekt
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* Point-Of-Interest-File (osm/poi.txt)
mit Name/Position/(optional) Hoehe
— (als Beispiel ist ein File mit etwa
20000 mehr oder weniaer richtigen
Alpengipfeln vorhanden)

* mit "F" oder Tools->Find kann mit
Wildcards (ste?n*) auf die Namen
agesucht werden und die Karte

— zentriert auf die Position und setzt
Marker 1. Bei mehreren passenden
Namen mit Enter oder Klick auf Find
werden alle Positionen durchgesteppt.

* ist "p" oder Config->Map Parameter-
>Show Loc of Mouse auf ON, geht
beim Bewedaen der Maus eine
Sprechblase mit Zeiger zum
nachstaeleaenen Poi auf. Mit "c" kann
die Karte drauf zentriert werden.

— 30. 12. 2014 (Ver 0.46)

* Marker 1 und 2 setzen ("x" "v") geht
ohne vorher auf die Karte klicken
aleiches bei Zentrieren "c" mit dem
Unterschied wenn ein POl maximal 5
Pixel entfernt angezeiat wird, exakt
auf diesen zentriert wird.

— 26. 1. 2015 (Ver 0.47)

* nebst "poi.txt" wird noch "mvpoi.
txt" gelesen damit beim Update bei
— Bedarf die selber angelegten Punkte
erhalten bleiben. nun auch viele
SOTA-Standorte im poi.txt
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* Loa File (rawloa) durch Anhaengen
von %d zB. "loas/rawloq%d" auf
tageweise 1 File mit Datum
umstellbar. Ist auch kompatibel zu
den Loas am www-Server. (Loa
Filename jetzt im "File" Menue)

* Bei tageweisem Log einstellbar nach
wieviel Tagen automatisch (beim
Start oder Mitternacht) Logs
geloescht werden sollen.

* im Log suchen nach Datum und/oder
Call sollte auch dank "Load" (fur ab
eingeagebenen Datum) deutlich
zuverlassiger gehen.

* mehrfach eingetroffene selbe
Message wird nur 1x Angezeigt.

* Baken (Netzbake, Obiekte) konnen
Position aus File (auch in Grad mit
Komma) lesen fuer bewealiche
Objekte oder Mobilbetrieb.

* Baken konnen Text-Macro-File
loschen nach 1 mal Senden zum

— Zweck des automatischen
Verstummens der Bake wenn zB das
Wetterhauschen nimmer Updatet.

— 2. 3. 2015 (Ver 0.48)

* Nur Stationen mit einem

bestimmten Svmbol aufs Bild, Symbol-
Wahl in Tools / Select Data / Svmbol>.
On/Off mit "Svmbol" oder "s"-Taste.
Achtung: Screenshot Taste ist jetzt
"S",

* Overlay Symbole mit Mausklick
eingebbar
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6. 3. 2015 (Ver 0.48)

* Zoom-Lupe aufziehen mit rechter
Maustaste halten. Ohne Maus
beweden wie bisher Backspace in der
Zoom/Pan Historv oder (Copy/)Paste
in Texteingaben.

15.3. 2015 (Ver 0.49)

* Hover Info Popup (Tools/On Next
Click/Hover) auf den Svmbolen und
Glaendeschnitt zu Marker 1 wenn
Tools/Radiolink enabled.

24.3. 2015 (Ver 0.49)

* Linkstreckenberechnuna mit
einstellbarer Beuaunq (refraktion)
der Hf in der Atmosphaere.

15.6. 2015 (Ver 0.49)

* "H" fuer Hoehendaten
Farbdarstellung.

* Cache auch fuer nicht
vorhandensein von Hoehendaten
damits schneller mit Loechern im
Datenmaterial zurecht kommt.

* poi.txt ohne Neustart einlesen mit
"Reload Config".

* Wx Radioaktivitaet dekodieren und
(vorerst) als Text ausgeben.
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— 21.6. 2015 (Ver 0.50)

* Maidenhead Locator Ausaabe
— lanaes Format, Eingabe "Find" 6 8
oder 10 stellig.

* Treiber Aufruf fuer Soundmodems
und (USB-)serielle kiss/smack TNC
/Funkaeraete
betriebssvstemspezifisch
voreinagestellt (sofern noch kein
aprsmap.cfg vorhanden ist).

* Popup Fenster Ueberlappungen
etwas seltener.

* Radioaktivitaet (Sievert)
— Dekodierung in den Wx-Baken
(vorerst ohne Grafik)

* Getrennte Backspace/Rechte-Maus
History fuer beide TABs

— 27.6. 2015 (Ver 0.50)

* etwas verbesserte popup Fenster
Platzierung.

* Confia > Map Parameter > Reset to
Default oder kurz "D" stellt die
meisten Bildparameter und

— Klickverhalten auf Default. Die alten
Werte aehen zuvor in die Backspace
/rechte Maus-History zwecks Undo
der Funktion.

* Historv/TAB speichert die
— wichtiasten Bildparameter +
Kartentyp.
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— 6.7.2015 (Ver 0.52)

— * Parameter Reset "ctrl-L" statt "D"

* dekodieren und darstellen vom Area-
Obiects, Kreis, Ellvpse, Rechteck,

— Dreieck, Linie (ohne Corridor) gefuellt
oder leer in 8 Farben nach APRS101.
pdf.

* Baken Editor erstmal fuer
numerische Eingabe der Area Objects.

* dekodieren und darstellen von
Multiline-Obiects mit 3 Linientvpen
und 4 Farben nach AE5PL 1-23 Linien
pro Bake geschlossen oder offen.

* Anklicken aller Linien und Flaechen
am Rand und Verhalten wie normale
Obiekte aber ohne Track bei
Bewegung.

— 8.7.2015 (Ver 0.52)

— * Multiline-Objekt Editor

— 25. 8. 2015 (Ver 0.54)

* Mic-e-Telemetrie Dekoder, die
Herstellercodes aus den Mic-e Frames
— werden dazu vorher entfernt (soweit
es aeht) was auch sauberere
Kommentarzeilen ergibt.
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— 16.10. 2015 (Ver 0.56)

* Wetterbake (Netbeacon, Rf Beacon,
Query) aus .csv File

\\!wx'csvllltlllllhlblrlwldlllllq! im
— comment extrahiert die Werte aus
der letzten Zeile

im File wx.csv. Es kann noch ein
— Multiplikator anaegeben werden zb. ,
w3.6, statt ,w, zum

Umrechnen von m/s auf km/h. Werte
siehe Hints. Wx Symbol auswaehlen.

* Messadges/Queries bei 9-stelligem
— Mycall sollten nun bestaetigt
/beantwortet werden.

— 24.11. 2015 (Ver 0.58)

— * Wx Grafiken korrigiert

* Schaltknopf/Laempchen fuer
Objekte Ein/Aus

* Gate Net-to-Rf mit Radius und Bit/s
Limit und Option nur Messaae zu
(aehoerten) Usern (mit Standard-3rd-
party Protokoll und ohne speichern
/wiederholen von Messaages).
Einschalten mit Confia/Rf-Ports
/Digipeater, Rx auf "N", Bit/s in "N-n
Words" siehe Hints.

— 28.11. 2015 (Ver 0.58)
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* Starten ohne "terminal" und
— Abstellen sollte ohne X11
abschmieren gehen.

* UDP Ports an und abschalten auch
mit laufendem "serial interface".

- 29.11. 2015 (Ver 0.58)

* Historv bei der "Find" Zeile mit
Cursor up/down.

* Rf-Monitor mit Txdelay, Level und
— Quality, sofern vom Modem geliefert
(afskmodem linux).

* Fenster Kopfzeile "nur neue" Calls
— (Config/rf-ports/monitor headline 0)
und Zeit seit letztem mal gehort(1).

— 7.1.2016 (Ver 0.59)

* "Storm Data" Auswertung und
Flachen-Darstellung mit interpolierter
— Animation. (manaels Aktueller
Testdaten nach APRS101.pdf in
nautischen Meilen 1.609km)

* Area-, Multiline-, Sturm-Objekte mit
"<>" durchsteppen mit zum
Weapunkt aehérender
Flachendarstellung.

— 23.1.2016 (Ver 0.59)
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* ltem in Messaades, (B)akeneditor
(auf "Item") + (M)essaae Send
Fenster geoffnet kopiert den
Bakeninhalt in Message Text und
erzeuat dann beim Empfaenaqer der
Msa ein Svmbol auf der Karte.
(APRS1.2) Da sich die
Protokollerweiteruna Item-Message
und Multiline-Obiject geaenseitig
beissen ("{" svymbol), geht die
Kombination vermutlich nur mit
aprsmap + send with ack.

— 25.5.2016 (Ver 0.61)

* Obiekte ohne Richtuna und
— Geschwindigkeit zeichnen keinen
Track mehr.

* alle alternativ Symbole koennen
Overlay Zeichen haben (a..z A..Z 0..9)

— * Hamnet Symbol in symbols.png

— 15.3.2017 (Ver 0.64)

* Trackfilter aeht bei mehr als 15000
— Wedapunkten nimmer gegen
Rechenzeit unendlich.

* Trackfilter wird auch mit den
— kleinen Zappeleien bei
Verzoegerungen unter 1Min fertig.

* "Find Item Messadqe" zeiat auch bei
— mehreren solchen Msgs die dazu
passende Position.

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice Seite 187 von 197



B | ue S p|Ce 4 APRSmap Release notes

5.4.2017 (Ver 0.65)

* Rotes Fehlermelduna-Popupfenster
— daroesser und umfangreicher bei der
Baken Eingabe.

* mit [1-Tasten Zeit aendern wie lana
Dinge auf der Karte sichtbar bleiben.

— 25.5.2017 (Ver 0.66)

— * Kontrast der Symbole verbessert.

* Fenster zu klicken sollte bei vielen
— Linux-Fenstermachern wieder
geeordnet abstellen.

— ¥ Linux 64bit Version.

— 5.7.2017 (Ver 0.67)

* langen Locator suchen korrigiert
und Kleinfeld Darstellung

— *udpflex (linux) tcpkiss server

— 29.9.2017 (Ver 0.69)
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* Helligkeitskorrektur (Tools > Add
Maptvpes) als Gamma Werte statt +-
Helligkeit. Bei Bildschirm-Gamma
(Confia > Brightness) 2.2 entspricht
0.45 oriaginal und 0.3 etwa dem
bisherigen -128. Die Werte werden
nun bei Kontextumschaltung mit TAB
mit dem Kartentyp gespeichert.

— 01.12.2017 (Ver 0.70)

* Kartentvpen mit Gamma-Korrektur
statt Helligkeitskorrektur. (Tools >
Add Maptvpes) solang ein
Hellikeitswert konfiauriert ist, wird
default 0.25 anaewendet. (Sinn der
Sache: Sat Map von Sentinel2)

* Einaestellte Karten Helliakeiten
werden individuell fur Kartentyvpe
agespeichert. (Sat Maps sind bei 100%
ok, OSM karten eher bei 20 bis 40%)

* "6" schaltet alle aktiven
Kartentypen im kreisrum durch.

* Font von 7x6 bis 24x12 und
zoombare Svmbole 16 bis 32 aus

— svmbol file 16 bis 48 Track und
Weapunkte werden mit anaepasst.
(Zweck: hochaufloesende Bildschirme)

* Neue Fontfiles und Svmbolfile mit
teiltransparenten Symbolen (wird
noch verschonbessert ...) beim

— Svmbol Zoom wird erst versucht ein
zur Grosse passendes svymbolsXX.png
zu laden falls nicht vorhanden wird
"symbols.png" gezoomt.

* Weicher Alpha-Kanal (Transparenz)
— bei den Symbolen (win: neue "pngm.
di")
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— 09.12.2017 (Ver 0.71)

* win: ipeam.dll damit werden auch
— OSM Karten im ipea Format gelesen
(auch mit Filename *.png)

* win: getosm.exe (dank an oe5krn)
neu mit "getosm.orqg" start Datei im
— zip und ohne "agetosm.ini" damit bei
Proarammupdate OSM-urls nimmer
uberschrieben werden

* Urls mit .ipg hinten konnen
eingegeben werden

* Konvertierung auf png kann
— abageschaltet bleiben, spart
Plattenspeicher

— 12.02.2018 (Ver 0.72)

* Lodfile laden (besonders mit 270000
Baken Track drin) verschnellert.

* Symbole-Zoom verbessert und %
Einaabe als 3. Parameter bei
Confia>Font>Fontsize fir
Symbolgroesse/Texthoehe Verhaltnis

— 15.03.2018 (Ver 0.72)

* Linux 64bit Copv/Paste Absturz
behoben (hoffentlich)

* Refraction Parameter wirkt auch bei
Radiolink Ausleuchtung
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— 12.07.2018 (Ver 0.74)

* Neue-Version-Check Funktion mit
— shell/BAT script falls wer einen dazu
passenden www-server baut.

* Radiowellen
Ausbreitungasberechnuna um

— Streckendaempfuna und
Antennendiaaramme aus Hersteller-
Files erweitert.

— 07.10.2018 (Ver 0.75)

* Fehler beim Loafile importieren und
nach Uhrzeit sortieren behoben.

— 12.10.2018 (Ver 0.75)

* poi.txt aus Hamnet-db und Foto-
webcam Daten aktualisiert.

* "P" rechnet mit Refrac (0.13 Licht,
0.25 Funk)

— 17.11.2018 (Ver 0.76)

* Poi-Files mit beliebigen Namen in
osm/poi/
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* Darstellunag eines Info-Fensters bei
— Maus nahe einem Poi sofern Info
enthalten.

* Auswahlmenue "C" oder "Tools
/Select Data/Show POI" zum Zeichen
von einstellbaren Svmbolen eines
oder mehrere Poi Files. "I" (= kleines
"L") schaltet Labels ein/aus. Dazu
Text-Filter im Namen oder Infofeld
zum eingrenzen der Auswahl mit "*"
und "?"

* Marker setzen mit Fanaen der
— Position des nahen Poi mit "X" und
"Y", ohne Fangen "x" "y".

— h264 in mpeg4 Container:

Linux: 1 mal machen: mknod
map.ydm p

fuer jedes Video starten: x264 -o
— film.mp4 --muxer mp4 --crf 22 map.
ydm

- <Make Video>

win: File / Make Video qgibt
unkomprimiertes Videofile map.y4m

(.vdm sollten mplayer oder vic
abspielen koennen)

klein packen mit x264.exe "x264 -o
— film.mp4 --muxer mp4 --crf 22 map.
ydam"

(crf=22..27 qualitaet gut bis
sparsam)

vorher mit Animate und auf Map
— klicken passende Geschwindigkeit
einstellen
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— files/dirs:
- aprsmap programm
aprsmap.cfa beispiel confia, wenn

— nicht vorhanden werden default
werte erzeugt

hints.txt tinps beim verweilen
mit der maus auf buttons

help.txt Hvperlink-Hilfetext
unter Help > Helptext

am.sh shell script zum osm
karten holen

(aeht nun auch mit der
busybox am tinycore) ./gm.sh

(darf/soll verbessert
werden HI)

- symbols.png icons
- font.png buchstaben
aettiles vom aprsmap erzeugte

liste fehlender map tiles

rawloa timestamp+aprsis
— format wenn vorhanden beim start
eingelesen

bei connect zu aprs
server kommts neue dazu

dargestellt werden die
— eingestellten minuten vom ende des
logs

mit connect zu server
eingestellte minuten von jetzt

file darf editiert,
beschnitten, gefiltert werden

wird nach timestamp
sortiert eingelesen

(langes file einlesen geht
mit serverconnect schneller
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da erst ab "jetzt-
darstellzeit" decodiert wird)

- osm/tiles/ karten im osm format
- osm/tiles_sat/
- osm/tiles_topo/

udpflex axudp<->kiss/smack
/flexkiss interface fuer TNC, TMx7xX ...

kisson.txt kiss initialisierung
fuer TMD72 mit udpflex

agetosm.exe Win: Schneller
Maplader von OE5KRN

- poi.txt globales/privates
mypoi.txt Points-Of-Interest-
— File mit aktiviertem "p" zum zeigen
bei

Mauszeigernaehe oder
Suchen mit "F"

— oeb5dxl

[[DXL - APRSmap | << Zuriick zur DXL-
APRSmap Ubersicht]]

Aktuelle Version vom 9. April 2021, 09:08 Uhr

| For english version on this project >>click here<<
ish versi | :
S el "

> APRSmap Download

Aktuelle Programmversion v0.79

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice

Seite 194 von 197


https://wiki.oevsv.at/wiki/DXL_-_APRSmap_englisch
https://wiki.oevsv.at/wiki/DXL_-_APRSmap_englisch
https://wiki.oevsv.at/wiki/DXL_-_APRSmap_Download

B | ue S p|Ce 4 APRSmap Release notes

Inhaltsverzeichnis

B =1 T =Y 1] o [ PP PRTPRN 196
2 AU oottt ettt 196
o R == Yo [ T=Y o U Ta o U T Vo N = 11 S 197
B Lo 1T oY [ Y- To [P TP P 197
D R I ENZ ittt e 197
LAY L L= ST e o L1 <P 197
A LTE=] o] [ | S PP P PP 197

Ausgabe: 26.04.2024 Dieses Dokument wurde erzeugt mit BlueSpice Seite 195 von 197



B | ue S p'Ce 4 APRSmap Release notes

Einleitung

APRSmap ist ein von OE5DXL Christian entwickelter, kostenloser APRS Client mit grafischer
Oberflache, welcher als Basis das Kartenmaterial von OSM benutzt.
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Features

OpenSource und bereits fertig fur Windows und Linux compiliert
100%ige Einhaltung der aktuellen APRS Protokoll Vorgaben

Keine Installation erforderlich, nur kopieren und starten

Keine Uberflissigen MenuUs, Fokus auf der Darstellung

IP-basiert, somit out-of-the-box netzwerkfahig im HAMNET sowie Internet
Bedienung idealerweise tUber Shortcuts

Lokale serielle Anbindung (TNC) mdglich - Betrieb als HF IGATE

Zur Darstellung kénnen mehrere Mapsources verwendet werden. StandardmaRig ist dies OSM
- OpenStreetMap

Trackfilter fur verzégert/verspatet/wiederholte Pakete "f"

Gelandeschnitt und Funkausbreitungsberechnung (ab v0.36) "R"
Animation von Tracks mit Zeitleiste "a"

Animation der Temperaturverteilung "w"
Messaging
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Bedienung und Hilfe

Bedienungsanleitung - Die Hilfe beim Umgang mit dem Programm

© APRSmap 1st Start

Download

APRSmap Download - Fir Windows, Linux und ARM (Raspberry Pi)

> APRSmap Download

Referenz

Das Programm APRSmap wurde fiir den OVSV Innovationspreis 2013 nominiert.

Weitere Projekte

Weiter passende Projekte von OE5DXL aus dieser Serie sind

® DXL - APRStracker - Hard- und Software fir einen minimalistischen APRS Tracker
® TCE Tinycore Linux Projekt - Der machtige und innovative Digipeater flir APRS, Packet Radio,
Echolink, u.v.m.

Weblinks

Kurzlink hier her: http://aprsmap.oevsv.at
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